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BioMedware's BoundarySeer detects and analyzes geographic boundaries with state-
of-the-art techniques. BoundarySeer supports a range of data formats and types 
and, through common file formats, can easily be used in conjunction with your 
GIS. 

SySystem requirementsstem requirements  

• Windows 95 or Windows NT 4.0 or more recent operating system 

• screen resolution of 800 x 600 or finer for best viewing of the maps and 
graphics 

• 256 colors or better highly recommended for graphics 
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Manual overviewManual overview  

This manual outlines how to use BoundarySeer, BioMedware’s tool for detecting and 
analyzing geographic boundaries.  This information is also available in online help 
("BoundarySeer Help.chm"), accessible from the "Help" menu and "Help" 
buttons on dialogs in BoundarySeer.  The online help has hyperlinks which 
connect related topics.     

BioMedware also has a BoundarySeer Online page on its website, 
http://www.biomedware.com/files/documentation/boundaryseer/default.htm  
Please check this for updates and additional information. 

Chapters 1-4 describe the conceptual background, the interface, and how to 
prepare your data for analysis.  Chapter 1 outlines boundary detection and 
analysis.  Chapter 2 details the interface and data and boundary visualization tools 
available, like maps, tables, and charts.  Chapter 3 covers working with spatial data 
in BoundarySeer, describing data formats, types, import and export, and 
conventions for missing data.  Chapter 4 itemizes methods to prepare your data for 
boundary detection.  Possible preparations include creating and using variable sets, 
weighting variables, standardizing your data, editing spatial networks for point 
data, and classifying your data. 

Chapters 5-9 deal with the heart of BoundarySeer:  boundary detection methods.  
Chapter 5 introduces the concepts and features a boundary detection advisor,  
available in an online version as well.  The advisor should help you determine 
which method is best suited to your questions and your data.  Within the software, 
you may use the Boundary Detection Wizard to choose a method and find 
boundaries. Chapters 6-9 describe individual boundary detection methods. 

Chapter 10 summarizes boundary analysis methods in BoundarySeer: 
subboundary and overlap analysis.     

The manual also has a resources section that includes a glossary, troubleshooting, 
references, and an index.   

For easier differentiation of interface and description, this manual will use the 
following style conventions: 

 

TypefaceTypeface  MeaningMeaning  

serif type explanatory text 

sans serif type part of the BoundarySeer interface, such as 
menu items or dialogs 
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CCHAPTER HAPTER 11——IINTRODUCTIONNTRODUCTION  

BoundarySeer offers a number of methods for delineating and then analyzing 
boundaries.  This chapter provides an overview of the software and important 
concepts.  Essential concepts include definitions of the types of boundaries you can 
delineate using BoundarySeer and short descriptions of the methods to find them.  
This chapter also includes some background on the field of boundary analysis, 
such as guidelines for planning data collection and analysis and examples from the 
literature. 

What are boundaries?........................................................................... 12 

Types of boundaries.................................................................................... 12 
Characteristics of boundaries....................................................................... 12 

Boundary methods overview ................................................................ 13 

Boundary detection .................................................................................... 13 
Delineation of areal boundaries ........................................................................... 13 
Delineation of difference boundaries.................................................................... 13 

Fuzzy Classification ................................................................................... 14 
Boundary Analysis ..................................................................................... 14 

Subboundary statistics ........................................................................................ 14 
Overlap statistics................................................................................................ 14 

Boundary analysis guidelines................................................................ 15 

Scale of sampling........................................................................................ 15 
Choice of variables ..................................................................................... 15 
Making sense of boundary analysis .............................................................. 16 

Examples of boundary analysis............................................................. 17 

Epidemiological applications....................................................................... 17 
Ecological applications ............................................................................... 18 
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What are boundaries?What are boundaries?  

You might think of a boundary as a set of connected spatial locations that separate 
areas with different characteristics. For example, a boundary for a toxic waste site 
separates areas of high pollutant concentration from adjacent areas of low 
concentration. A boundary for a species' range delineates where the species is 
found and where it is not. An economic boundary distinguishes a poorer 
community from a wealthier one. 

Types of boundariesTypes of boundaries  

Boundaries may be formally defined as edges of homogeneous areas (areal edges of homogeneous areas (areal 
boundaries)boundaries) or as spatial zones of rapid change (difference boundaries)spatial zones of rapid change (difference boundaries). Areal 
boundaries are closed and fill the study area (Figure 1.1a). Examples of areal 
boundaries include the edges of agricultural fields, watersheds, political 
boundaries, and forest clear-cuts.     

However, the processes that give rise to boundaries are not always associated with 
homogeneous areas. Difference boundaries, zones of rapid change, describe this 
situation. A cliff edge illustrates a difference boundary—the edge marks a 
potentially dangerous difference in elevation.  For difference boundaries, the 
values of the variable immediately to one side of the boundary are very different 
from values immediately to the other side. Difference boundaries are often open, 
meaning that they appear as line segments that do not enclose an area (Figure 
1.1b).  

 ( a )
 

( b )
 

1 4 

3 2 

5 

 
Figure 1.1Figure 1.1  Examples of areal (a) and difference boundaries (b).   

 

Characteristics of boundariesCharacteristics of boundaries  

Boundaries may be further distinguished by other characteristics. Boundaries may 
be natural (such as a shoreline) or artificial (such as a road). Some boundaries, 
such as edges of forest clear-cuts, may not be easily classified as natural or 
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artificial. Boundaries may be crisp (well defined) or fuzzy (imprecise). Both areal 
and difference boundaries can be fuzzy. Fuzzy boundaries occur when the zone of 
change from one type to another is relatively wide. Additionally, boundaries may 
be generated by a single variable, such as the concentration of a toxin, or by a suite 
of related variables, such as ecotones defined by multiple species' densities. 

  

Boundary methods overviewBoundary methods overview  

You can use BoundarySeer to detect and then to analyze boundaries on your data.  

Boundary detectionBoundary detection  

The choice of a boundary delineation method depends on your research question 
and your data type. Boundary detection methods differ for areal and difference 
boundaries. Although the different techniques will likely yield boundaries in 
similar locations, they indicate different (but related) types of spatial patterns.  
Choose your method with their distinctions in mind. 

See also:See also: About boundary detection. 

Delineation of areal boundariesDelineation of areal boundaries  

Within BoundarySeer, you can use spatially constrained clustering to delineate 
areal boundaries.  First, it identifies homogeneous areas, then it draws boundaries 
separating these areas. BoundarySeer can use one of two clustering methods to 
assign locations to clusters based on the relative similarity of the values of variables 
and geographic adjacency.  The result is a partition of the data into relatively 
homogeneous clusters. 
See also:See also: About spatially constrained clustering 

Delineation of difference boundariesDelineation of difference boundaries  

Difference boundaries are zones of rapid change. You can use Wombling methods 
to delineate difference boundaries.  Wombling methods first estimate the average 
amount of change in the variable(s) across space (referred to as a Boundary 
Likelihood Value - BLV). The locations that have BLVs above a user-set threshold 
value are referred to as Boundary Elements (BEs). 

Adjacent crisp BEs that have similar amounts and directions of change are 
connected into subboundaries. Because fuzzy boundaries consist of BEs with 
varying boundary membership, BoundarySeer does not connect fuzzy BEs into 
subboundaries. The collection of subboundaries and singleton BEs together are the 
"boundary." 

See also: See also: About wombling, Crisp vs. fuzzy wombled boundaries, and About 
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wombling with location uncertainty. 

Fuzzy ClassificationFuzzy Classification  

Fuzzy classification can be used to reduce the dimensionality of a large data set. It 
can be used to find groups—classes—in the data based on values of the variables. 
Fuzzy classes are suitable for continuous data that do not fall out into discrete, 
crisp classes. 

In a crisp classification, each sampling location belongs fully to one class only. 
With fuzzy classification, membership in classes can be partial. In other words, a 
location may belong most strongly to one class, but have a lesser relationship with 
other classes; or, it may belong rather equally to all classes. Boundaries can then be 
detected on fuzzy classes using wombling, or boundaries can be described by 
locations with high class uncertainty, using the classification entropy or confusion 
indices. 
See also:See also: About fuzzy classification. 

Boundary AnalysisBoundary Analysis  

BoundarySeer offers two techniques to analyze boundaries once you have 
delineated them:  subboundary and boundary overlap statistics. 

Subboundary statisticsSubboundary statistics  

Subboundary statistics address the question, 'Are the boundaries significantly 
contiguous?' Subboundary statistics can also indicate boundary 'branchiness', a 
form of boundary complexity. 

See also:See also: About subboundary statistics. 

Overlap statisticsOverlap statistics  

Overlap statistics evaluate the spatial association between two sets of crisp 
boundaries, based on average minimum distances from BEs in one set to BEs in 
the other. 

See also:See also: About overlap statistics. 
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Boundary analysis guidelinesBoundary analysis guidelines  

Boundary analysis is appropriate in the exploratory stage and the hypothesis 
testing stage of research. During initial data exploration, boundary analysis can 
identify spatial patterns and generate testable hypotheses. Designing experiments 
for hypothesis testing requires more careful planning and a more thorough 
understanding of the analytical techniques to be used. Along those lines, we offer 
the following guidelines for hypothesis testing using BoundarySeer. 

Scale of samplingScale of sampling  

An important consideration in any spatial investigation is the scale of the sampling 
framework. By scale we mean both the size of the geographic area under study, 
and the spatial intervals at which observations are made. Ideally, the scale of the 
sampling regime reflects the scale of the processes under investigation. 
Determination of the appropriate scale may require a pilot study or other 
preliminary work. A sampling regime that is too broad or too narrow for the 
relationships under study will likely result in failure to detect boundaries or 
associations that may actually exist. In the event of non-significant findings, a 
logical first question is, 'Was the scale appropriate for this study?' 

Choice of variablesChoice of variables  

Within BoundarySeer, boundaries may be delineated based on one or many 
variables measured at a set of study locations. For example, in ecology, ecotones 
(boundaries between adjacent ecosystems) may be delineated based on changes 
across space in the abundance of one dominant plant species, or based on changes 
in many plant species. The corresponding data sets would consist of data 
representing the abundance of plants measured within some unit of area at each 
spatial location. The first example would have only one variable for the focal 
species, while the second would have a column for each species sampled. 

Selection of variables to include in a data set should start with existing knowledge 
of the system. Once a set of candidate variables has been constructed, a 
combination of techniques may be used to decide which variables are included in 
the boundary analysis. The first method is to look for boundaries for single 
variables, evaluating each variable independently. Then, select variables for a 
multivariate boundary delineation based on some predetermined criteria. For 
example, you may include only those variables that have significant boundaries 
themselves (determined using subboundary analysis), or you may include those 
variables that have high rates of change in the same vicinity.  

An alternative method is to use multivariate techniques such as principal 
components analysis (PCA) to determine which of several candidate variables 
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contribute significantly to the overall variation in the system. You might then 
decide to include variables that account for a certain proportion (e.g. 90%) of this 
variation. In any case, let the research question or process model, rather than 
models of data alone, guide selection of variables. 

Making sense of boundary analysisMaking sense of boundary analysis  

Boundary overlap statistics address the question, 'Are boundaries for two data sets 
significantly close to each other?' Implicit in this question is the assumption that 
boundaries exist for the two suites of variables. Thus, boundaries must first be 
evaluated before assessing overlap. 

For difference boundaries, we suggest you evaluate this assumption by first 
calculating subboundary statistics for each data set. Subboundary statistics will 
assess boundary contiguity. If contiguous boundaries exist, then the interpretation 
of boundary overlap is clear: discrete boundaries overlap. If clear boundaries do 
not exist within each data set, yet overlap is significant, then the two suites of 
variables have a more complex relationship. In this case, areas of high rate of 
change for each data set coincide. Further investigation may be needed to uncover 
the nature of the relationship. 
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Examples of boundary analysisExamples of boundary analysis  

Boundary locations reflect complex underlying physical, biomedical, and/or social 
processes. Boundary analysis allows investigation of complex and dynamic spatial 
processes. 

Boundary analysis has been used to study genetic hybrid zones in population 
biology (Endler 1977), where gene frequency boundaries exist at the interface 
between populations; zones of rapid change in species abundance in ecological 
communities (Fortin 1992); landscape boundaries in conservation biology (Hansen 
and di Castri 1992; Fortin 1994; Holland et al. 1991), which represent contact 
zones between distinct ecosystems; and retroviral molecular data (Bocquet-Appel 
unpublished manuscript), which may lead to new hypotheses regarding gene 
expression. 

EpidemioloEpidemiological applicationsgical applications  

Bocquet-Appel (unpublished manuscript) applied boundary analysis to the 
geographic distribution of retroviral mutations. He analyzed the env gene of 
HTLV-1 retroviruses sampled from human populations at 22 African locations. 
Boundary analysis revealed that zones of rapid change in the env gene overlaid the 
geographic edge of the tropical rain forest, leading to new hypotheses regarding 
env gene expression. He concluded that boundary analysis might be used to 
explore spatial relationships between geographic zones of pathogen (e.g. ribovirus, 
bacteria) molecular genetic variation and the spatial pattern of pathology in host 
populations. 

Another application is the identification of spatial boundaries demarcating zones 
of rapid change in cancer mortality. These boundaries define the geographic extent 
of areas with high mortality. Brown et al. (1995) conducted an etiologic study of 
bladder cancer that used mortality maps to identify the study population. Other 
areas of potential application include air pollution and respiratory illness (Bates 
and Sizto 1983; Buffler 1988; Bates et al. 1990; Dockery et al. 1993), 
environmental risk factors and cancers (Najem et al. 1985; Carpenter and 
Beresford 1986; Jacquez and Kheifets 1993), and agricultural and industrial 
exposures and cancer (Blot and Fraumeni 1977; Matanoski 1981; Stokes and Brace 
1988; Linos et al. 1991; Nuckols et al. 1996). 

Potential applications of boundary analysis within the relatively new field of 
spatial epidemiology are numerous and rich. Zones of rapid change in cancer 
outcomes can be caused by underlying differences in genetic composition, risk 
behavior and environmental exposures. Thus, boundary analysis provides a basis 
for formulating and testing spatio-epidemiologic hypotheses. Further, several 
boundary detection methods are multivariate, and data for multiple diseases, such 
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as cancers at different body sites, can be analyzed simultaneously against exposure 
data and genetic data from several loci. Boundary analysis has applications for 
defining zones of rapid change in cancer outcomes (e.g. mortality); for determining 
whether these zones are statistically unusual; and for testing them against 
population genetic boundaries in oncogene expression and against edges of areas 
with high carcinogen concentrations. However, to date applications in the analysis 
of health data are relatively few. This lack of examples is at least partly attributable 
to lack of familiarity with boundary analysis techniques. 

Ecological applicationsEcological applications  

In ecology, boundary detection is appropriate for finding vegetation zones (Fortin 
1994, Fortin et al. 1996, Fortin 1997), which is important in conservation and 
planning and in other hypothesis-driven research. Boundary analysis is also the 
ideal tool for investigating 'edge effects', which are differences in ecological 
processes that occur at or near ecosystem or habitat boundaries. For example, 
Kupfer et al. (1997) studied factors affecting woody species composition in forest 
gaps in western Ohio, and found that composition was influenced not only by 
commonly cited factors such as disturbance patterns and environmental measures, 
but also by proximity to forest edges. 

Forest fragmentation and population declines in Neotropical migrant birds 
motivate recent work on edge effects on avian nest success in fragmented 
landscapes. In a review of the accumulated research on the subject, Paton (1994) 
found that although some studies report inconclusive results, there is substantial 
evidence that nest success decreases in edge communities, due to increased brood 
parasitism by Brown-headed Cowbirds and increased nest predation. Robinson et 
al. (1995) monitored 5,000 nests in landscapes with varying levels of fragmentation 
across the U.S. Midwest, and found that nest predation and mortality rates were 
strongly and negatively correlated with percent forest cover. Donovan et al. (1997) 
investigated the causes of variation in edge-effect study results, and suggested that 
landscape context, host abundance, and predator assemblages can influence the 
strength of such edge effects. Paton (1994) also explained that some research has 
been compromised by relatively arbitrary edge detection techniques, highlighting 
the need for more widespread use of appropriate boundary detection methods. 

As an analytical tool, boundary analysis complements existing spatial techniques, 
such as clustering and spatial autocorrelation analysis. Boundary overlap (Jacquez 
1995) may be a more appropriate measure of spatial association than models such 
as correlation and regression, which are built on the assumptions of linearity 
and/or normality. Furthermore, boundary coincidence can be conducted for data 
sets that do not use the same sampling regime, an advantage over other 
techniques. For many research questions, boundaries and boundary overlap are 
the logical objects of study. 



 19 

CCHAPTER HAPTER 22——MMANAGING AND ANAGING AND VVIEWING IEWING DDATA ATA   

BoundarySeer organizes data and analysis into projects, which consist of the data 
sets, boundaries, maps, tables, charts, and statistical results you generated.  You 
may save the project for work in another session. 

BoundarySeer offers two work styles: a traditional approach using actions selected 
from menus and an icon-oriented approach using the project window.  In the icon-
oriented approach you can click on a data set and choose actions for BoundarySeer 
to perform.  This chapter describes the structure of projects in BoundarySeer and 
its data and boundary visualization tools. 

Projects overview................................................................................. 22 

Project components .................................................................................... 22 
Working with projects .......................................................................... 23 

Creating a new BoundarySeer project .......................................................... 23 
Viewing and modifying project properties .................................................... 23 

Selection color ................................................................................................... 23 
Saving projects ........................................................................................... 23 

The project window ............................................................................. 24 

Data .......................................................................................................... 24 
Boundaries................................................................................................. 24 
Results....................................................................................................... 24 

About the project log............................................................................ 25 

Working with the project log ................................................................ 25 

Editing....................................................................................................... 25 
Hiding or showing...................................................................................... 26 
Printing ..................................................................................................... 26 
Exporting................................................................................................... 26 

MMAPSAPS  
Maps overview .................................................................................... 27 

The left panel: the map layers ...................................................................... 27 
The center panel: the map itself ................................................................... 28 
The right panel: the legend .......................................................................... 28 
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Working with maps.............................................................................. 29 
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Adding layers to a map ............................................................................... 29 
Changing the order of data layers................................................................. 29 
Deleting map layers .................................................................................... 29 
Removing maps.......................................................................................... 29 

The map toolbar .................................................................................. 30 

Querying maps .................................................................................... 31 

Interpreting color composite maps ........................................................ 32 

Red plus Green plus Blue = White ............................................................... 32 

FFORMATTING MAPSORMATTING MAPS  
Formatting maps.................................................................................. 33 

Line layer properties ............................................................................ 33 
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Point layer properties ........................................................................... 34 
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Polygon layer properties ....................................................................... 35 
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Raster layer properties.......................................................................... 36 
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TTABLESABLES  
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Selecting data in the table ............................................................................ 37 
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Querying tables.................................................................................... 38 
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Projects overviewProjects overview  

BoundarySeer organizes your work into projects, comprising multiple data sets, 
boundaries, and results. When you save a project, BoundarySeer creates a *.bsr 
file that contains all project components except spatial features. Spatial feature 
information is saved in a file with a *.pip extension. 

BoundarySeer uses projects for three reasons: 
1. Projects simplify calculations that cross data sets, such as boundary 

overlap. 
2. Because BoundarySeer retains and stores information calculated from 

data sets, the software avoids recalculating information such as spatial 
networks and boundary likelihood values each time you delineate 
boundaries or compute statistics, thereby improving efficiency. 

3. Projects help organize and maintain data sets associated with your 
analysis.  

BoundarySeer project componentsBoundarySeer project components  

The following are components of BoundarySeer projects; all of these components 
are saved into the project file (*.bsr) except spatial features. So, once you have 
imported a data set into the project, you need not reimport it each time you open 
the project in BoundarySeer.  
Components: 
� Data 
� Cluster data 
� Fuzzy class data 

� Boundaries 
� Spatial features 
� Log 
� Maps 
� Charts 
� Tables 
� Results 
 

Note: All project data sets should be associated with the same spatial location, 
although each may contain different types of observations or different variables. 
For example, you may wish to create a project comprised of two data sets for the 
same study area, one with measurements on soil variables and another with 
measurements on vegetation. 
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Working with projectsWorking with projects  

The basic functions related to working with and modifying projects are described 
below. 

Creating a new BoundarySeer projectCreating a new BoundarySeer project  

When BoundarySeer first starts up, you have the option of starting a new project 
or continuing work on an existing one. To start a new project, select that option, 
and then you will need to import data. You may also create a new project at any 
time by choosing New Project from the File menu. 

Viewing and modifying project propertiesViewing and modifying project properties  

To view the project properties window, go to the Project file, and then choose 
Project Properties. The main "Properties" window provides space for you to 
type in information about the creator of the project, and automatically provides the 
creation date and the work directory. There is also space for adding notes in the 
"Comments" box. 

Selection colorSelection color  

The selection color is used in maps when you select items for map queries or links 
for spatial network editing. You may change the selection color by clicking 
"Change Color" and choosing another. 

Saving projectsSaving projects  

You can save projects directly from the File menu "Save Project" or "Save 
Project As," or you can choose to save when you close a BoundarySeer session. 
BoundarySeer project files (*.bsr) store the settings, data, boundaries, and results 
created in a BoundarySeer session. When you reopen a saved project, you do not 
have to reimport the source data. 
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The project windowThe project window  

The BoundarySeer project window provides an alternative to the pull-down 
menus, an icon interface where you can simply right-click on data, boundaries, or 
results to perform further analyses. 

DatDataa  

All data sets in the project are available on the "Data" tab of the project window. 
Right-clicking on a data set brings up the menu list of data procedures. Some menu 
choices are not available until preliminary steps have been completed. For 
example, "Merge Clusters" and "Remove Clusters" are not available until 
clusters have been established in constrained clustering. The selected data set is the 
default for subsequent dialogs, although you may choose another from the pull-
down menus within the dialog boxes. 

New icons will appear in the project window as new data sets are imported or 
created through standardization or boundary detection procedures. Different icons 
represent different data formats: 

    
point data polygon data raster data spatial features 

BoundariesBoundaries  

Boundaries are displayed on the "Boundaries" tab. Right-clicking on a boundary 
brings up a menu list of further actions, such as creating a histogram of BLVs, 
changing boundary thresholds, or performing subboundary analysis. As new 
boundaries are created, their icons appear in the project window. 

Difference boundaries Areal boundaries 

    

point data polygon data raster data all data formats 

ResultsResults  

Results are generated by subboundary or overlap analysis. You may view a table of 
results or export them from the project window. 
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About the project logAbout the project log  

As you work in BoundarySeer, the data you import, the methods you use, and the 
settings you chose for the methods are all recorded on the project log. This feature 
provides a detailed record of the analysis, so that you can recreate it or fine-tune it 
in later BoundarySeer sessions, and so that you can interpret the results with full 
knowledge of the sequence of analysis. 

You may edit the log, print it, and/or export it to another application. Once 
exported, the log can be opened with any text editor or word processor that reads 
Microsoft Windows® rich text format. 

Working with the project logWorking with the project log  

Your statistical output and a session log of BoundarySeer operations (e.g., 
boundary delineation, overlap analysis) are recorded on the Project Log, the memo 
screen within the main window. The log text is stored within BoundarySeer in 
Microsoft® Windows® rich text format. Throughout the course of your analysis, 
you may find it useful to edit or print the text on this page. You can export the log 
for opening in other applications. 

EditingEditing  

1. Click on the Project Log window to activate it. 

2. Select "Edit" from the main menu. 
3. From here you can: 
� Cut selected text to the clipboard (Cut), not active if no text selected 

� Copy selected text to the clipboard (Copy) 

� Paste text from the clipboard (Paste) not active if no text in clipboard 
� Delete the selected text (Delete) 

� Select all text on the page (Select All) 
� Use a shortcut for adding the time and date to the log: Position the 

cursor where you want the time and date to appear, then choose 
"Time/Date" 

� Mark selected text as a comment, /* like this */ (Comment) 
4. You may also add references or notes directly to the session log page by 

                                                        
 Microsoft® and Windows® are registered trademarks of Microsoft Corporation in 
the United States and/or other countries. 
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positioning the cursor and typing. 

Hiding or showing Hiding or showing   

Under the "Window" menu, you can choose to hide the project log. Later, when 
you want to read the log, choose "show." 

Printing Printing   

1. With the Project log active, select "File", then "Print" from the menu. 

2. Click OK when the dialog box appears. 

Exporting Exporting   

The log is automatically saved within the *.bsr project file. If you wish to read it 
in another application, such as a word processor or a text file reader, you can 
export it as a text file (*.txt). 

1. With the Project log active, select "File", then "Export" from the menu. 
2. In the "Export" dialog, choose to export the Log. 
3. As there is only one log in any BoundarySeer project, the list of all items 

of that type will be blank. Select "Save" to continue saving the log. 
4. Then, choose a name for the file and a location. BoundarySeer will save it 

as a text file (*.txt). 
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MAPSMAPS  

Maps overview Maps overview   

Maps are visual representations of data, of the spatial distribution of values 
constructed from the data (e.g., spatial networks, boundary elements), or of the 
results of analyses. 

BoundarySeer maps are displayed in a three-pane window. The left-hand window 
lists the active layers in the map. The center window contains the map itself. The 
right-hand window shows the map legend, including the symbols used and the 
key.  

The left panel: the map layersThe left panel: the map layers  

The map layers panel lists all the map layers in the project. To expand the frame 
and view the full layer names, drag the line between the layer names and the map 
itself. 

You may show or hide a map layer by checking or clearing its associated box using 
the mouse. Displayed layers have a red check in the box next to their name. 

The active layer, the one that is queried with the query tool, is highlighted on the 
layers list. You can change the active layer by clicking on its name in the layer list. 

To change the order of layers on a map, drag layers up or down the list. 

Map 

Layer Pane 
This pane lists all 
the layers in the 
map, with red 
checks next to 
layers that are 
shown, empty 
boxes next to 
hidden layers.  The 
highlighted layer is  
the active one. 

Legend Pane 
This pane displays 
names and 
symbols for all 
shown map layers.  

Map 

Figure 2.1.  Map layout.  This diagram is a cartoon version of the three-pane 
BoundarySeer map window. 



 28 

The center panel: the map itselfThe center panel: the map itself   

The maps are drawn sequentially, with layers higher on the list overtopping those 
lower on the list. For instance, if you have a polygon layer it may obscure a line 
layer underneath it. To fix this, change the order of layers in the layer list. 

The right panel: the legendThe right panel: the legend  

The legend identifies the symbols for active map layers. 
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Working with mapsWorking with maps  

Maps display sample locations, spatial networks, boundaries, and subboundaries. 
Maps are not simply visual displays—they provide opportunities for querying the 
underlying data.  See alsoSee also:  Exporting maps or charts p. 61. 

Creating mapsCreating maps  

There are many opportunities to create maps when performing other actions in 
BoundarySeer. To create (or re-create) a map outside of another action, choose 
"Add to map" from the "Project" menu. First, select which component you will 
add to the map. Then, choose "New Map" from the pull down list of all maps in 
the project. 

Adding layers to a maAdding layers to a mapp  

There are many opportunities to add layers to existing maps when performing 
other actions in BoundarySeer.  You may also add data or boundaries to a map by 
right-clicking on the object in the project window and choosing "Add to map" 
from the pop-up window. 

Changing the order of data layersChanging the order of data layers  

The left map pane lists the map layers. For a layer to be visible in the map 
window, its associated box must be checked. Click on the box to check or clear it. 
The data layers appear in the order that they are listed, with the top layer in the list 
appearing "above" other layers in the view. To change the order of layers, click on 
a layer in the list and drag it to where you want it. 

Deleting map layersDeleting map layers  

If you want to completely remove a data layer from a map (not just deactivate it), 
highlight the name of the layer, and then hit "Delete" on your keyboard. You 
may also remove a layer by right clicking on the map and choosing to "Remove 
this layer from the map." This method removes the active (highlighted) layer. 

Removing Removing mapsmaps  

If you want to remove a map from a project, click on the "close" button  in the 
map's upper right corner. This permanently removes the map. If you removed a 
map in error, you may re-create it (assuming you have not also removed map 
source information such as data or boundary layers). 
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The map toolbarThe map toolbar  

 

The map visualization toolbar appears when the map window is active. To 
activate the map, click on it. 

The "selection" tool is the default tool. In the map layer pane, it can be used 
for changing the order of map layers, and activating and deactivating map layers. 
In the central map pane, it can be used to select items on the map. Using this tool 
you can click directly on a single item to select it, or you can click and drag open a 
rectangle to select all items that intersect the rectangle. 

If you move the arrow to a the map pane and right-click, you will have the option 
of querying the point, changing the properties (color, size of elements) of the data 
layer, or removing the active (highlighted) layer from the map. 

Use the "zoom" tool to focus on a section of the data set. Move the tool to 
where you want to zoom, and click to zoom in. 

Use the "zoom out" tool to enlarge the field of view. Move the tool to where 
you want the enlargement to be centered and click to zoom out. BoundarySeer will 
not zoom past the spatial extent of the data. 

The "zoom to fit" tool returns the visual display to the full spatial extent of 
the data set. 

The "pan" tool can be used instead of the scrollbars to move the field of view 
across the map. This tool only works when the map is zoomed in from the full 
spatial extent of the data. Click on the button to activate the tool and then use it to 
pan the map across the viewing window. For example, to expose a section to the 
right of the viewing window, drag the map to the left. 

Finally, the "query" button is a method for querying the map; clicking a point 
with this tool brings up a table of information about the selected location. 
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Querying mapsQuerying maps  

Querying calls up information about items on the map. 

Click on the query tool and then click on the map. This brings up a table of 
information on the selected map layer (the highlighted layer). The selected layer is 
queried even if it is not currently displayed on the map (checked in red). To change 
the map layer queried, select a new layer in the map layers pane. 

Once you've queried a layer, its table will pop up. This table lists information 
about the point you've selected. For example, if you query a boundary layer, you 
will get information on the location queried (queried x and y), the coordinates of 
the closest Boundary Element (BE) to the queried point (point x and y), the 
Boundary Membership Value for that BE, the average gradient magnitude (or 
Boundary Likelihood Value - BLV) for all variables in the data set at that location, 
and then BLVs and gradient angles for each individual variable in the data set at 
that location. 

If you have trouble understanding the information presented in a boundary query, 
see the appropriate method description.  
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Interpreting color composite mapsInterpreting color composite maps  

Color composite maps display the values of up to three variables at one time.  You 
can make color composite polygon and raster map layers in BoundarySeer.  In 
color composites, each variable is displayed as gradations of a single color, red, 
green, or blue.  Interpreting these maps is straightforward, once you realize the 
basic principles of combining colors of light.   

Red pluRed plus Green plus Blue = s Green plus Blue = 
WhiteWhite  

Recall your high school physics 
unit on light wavelengths.  White 
light consists of all wavelengths of 
light together, while the absence of 
light is darkness, black.  Thus, 
gradations of color in color 
composite maps go from dark (low 
values of all three variables) to light 
(high values of all three variables).  

Areas in a "pure" color (red, green, 
or blue) have high values of only 
one variable and low values of the 
other two, while white areas have 
high values of all variables, and 
black areas are low in all.   

Fuschia is a mixture of red and blue, with low values of the green variable; yellow 
is high green and red, with low values of blue; and cyan is high green, high blue, 
low red.  Query the map to view the values of each variable.   

 
  

  

 
  

red   

green   blue   
cy an   

yellow   fuschia   

white   

 

Figure 2.2.  Light/color blending 
diagram.  See this topic in the online help 
for a full-color diagram. 
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FFORMATTING ORMATTING MMAPSAPS  

Formatting mapsFormatting maps  

To format a map layer, select it on the map layer pane (the selected layer is 
highlighted). 

Then, call up the properties dialog by right-clicking on the map with the 
selector and choosing "Properties" from the pull-down menu. Because formatting 
options change with the layer type, read up on individual layers.  

Line layer propertiesLine layer properties  

You may change the thickness and color of line layers on maps. Single value and 
single color are the defaults, though graduated thickness and graduated color are 
available for data sets that have more complexity. You may use line thickness and 
color to represent two different variables. Many BoundarySeer line layers, 
however, will be spatial features without associated data. 

ThicknessThickness  

You can choose to have all lines the same width (choose "Single thickness" and 
the size in pixels from the drop-down box). Or, you may use the thickness of the 
lines to indicate the value of a variable (choose "Graduated using single 
variable"). If you choose graduated thickness, you need to choose a variable from 
the drop-down list and choose the minimum and maximum thickness in pixels 
from the lists. 

ColorColor  

You can choose to color all lines the same (choose "Single color" and the color 
using the "Change Color" button). You may also show the values for a single 
numeric variable using graduated color. For graduated color, you choose the 
variable and the minimum and maximum colors. The default is to grade from gray 
to black, but you could choose any combination of minimum and maximum 
colors, such as white to gray: 

 
The last alternative is to color lines using the values of a categorical variable. Once 
you choose the variable to represent, BoundarySeer will choose the colors. 
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Point layer propertiesPoint layer properties  

You may change the width of points, their color, and whether to display missing 
values on the map. You may use point width and color to represent the values of 
two different variables. 

WidthWidth  

You can choose to have all points the same width (choose "Single width" and 
the size in pixels from the drop-down box). Or, you may use the size of the points 
to indicate the value of a variable (choose "Graduated width using single 
variable"). If you choose graduated width, you need to choose a variable from the 
drop-down list and choose the minimum and maximum point sizes from the lists. 

ColorColor  

You can choose to color all points the same (choose "Single color" and the color 
using the "Change Color" button). You may also show the values for a single 
numeric variable using graduated color. For graduated color, you choose the 
variable and the minimum and maximum colors. The default is to grade from gray 
to black, but you could choose any combination of minimum and maximum 
colors, such as white to gray: 

 
The last alternative is to color points using the values of a categorical variable. 
Once you choose the variable to represent, BoundarySeer will choose the colors. 

Missing valuesMissing values  

Missing values are indicated with a special symbol on the map (the default symbol 
is an empty circle with a red outline). You may choose not to show missing values 
on the map, if so, clear the box at the bottom of the dialog. 
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PolygonPolygon layer properties layer properties  

You may change the outline style and the fill colors of polygon layers. 

Line styleLine style  

You can choose the width of the lines and their color. Choose the width from the 
drop-down box and the color using the "Change Color" button. 

ColorColor  

You can choose to color all polygons the same (choose "Single color" and the 
color using the "Change Color" button). You can also color them all 
"transparent," this shows only the outlines and lets information from underlying 
map layers come through. 

You may color polygons using the values of a categorical variable. Once you 
choose the variable to represent, BoundarySeer will choose the colors. 

Alternatively, you may show the values for a single numeric variable using 
graduated color. For graduated color, you choose the variable and the minimum 
and maximum colors. The default is to grade from gray to black, but you could 
choose any combination of minimum and maximum colors, such as white to gray: 

 
You may choose to represent the values of up to three numeric variables using red, 
green, and blue. You specify the value associated with each color. 
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Raster layer propertiesRaster layer properties  

Numeric rasters and categorical rasters have different properties. For categorical categorical 
rastersrasters, you only have one format choice: you can select which variable to display 
in the map. BoundarySeer chooses the colors automatically. 

NumericNumeric rasters rasters  

Single color rastersSingle color rasters  

Two features of monochrome raster layers can be changed in the dialog box: the 
direction of the graduated color and the base color itself. 

The raster will grade from a minimum to a maximum color value, with the 
maximum value represented by the darkest color as a default (Maximum value: 
Black). You may reverse it to have the lightest color as the maximum (Maximum 
value: White) in this dialog. 

You may also change the base color by clicking on "Change Color" and selecting 
a new one from the spectrum. 

Color composite rasters: R,G,BColor composite rasters: R,G,B  

Composite color rasters can display up to three variables or bands of remotely 
sensed data on one map. The variables are represented by red, green, and blue. 
These types of rasters are also called false color composites, as the colors on the 
map do not necessarily correspond with those perceived by the human eye. 

You may change the variables represented by each color in the raster properties 
dialog box. You can choose the variables represented by each color (red, green, 
blue) from pull-down lists in the raster properties dialog. 
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TTABLESABLES  

Working with tablesWorking with tables  

To view a table, go to the Project menu and choose "Table" to bring up the 
"View Table" dialog. Choose the table you wish to view. Because of the 
complexity and size of many raster data sets, BoundarySeer does not currently 
display entire raster data or raster boundary tables. You may query raster map 
layers to display small tables. To view the entire raster table, you will need to use 
another application. 

The "Table" menu only appears at the top of the window when a table has been 
activated. To activate the window, click on it. Possible table actions include: 
changing the appearance of table columns, sorting data, selecting, promoting rows, 
querying tables, and exporting them.   

BoundarySeer data tables are not editable. Instead, edit the table in the source 
application. 

Changing the appearance of table columnsChanging the appearance of table columns  

You can stretch or shrink the appearance of table columns by positioning the 
pointer at the right edge of a particular column. When you get the double-arrow 
symbol, you can drag the column to the right and increase the column width, 
which can make it easier to read the column headings. 

Sorting the data in tablesSorting the data in tables  

To sort the data set by any of the variables that it contains, click on the column 
heading. You can toggle back and forth between ascending and descending order 
by clicking again on the column heading. 

Selecting data in the tableSelecting data in the table  

You can select data in a table by clicking on a row (to select one row), or clicking 
on a row and then dragging the cursor down to select many rows. To clear your 
selection, simply click on another location in the table, or, from the Table menu, 
select "Clear selection". To reverse your selection (e.g., select all data that were 
not previously selected), choose "Switch selection" from the "Table" menu. 

Promoting data in the tablePromoting data in the table  

To promote rows of data to the top, select a row or rows, and then choose 
"Promote" from the "Table" menu. 
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ExportiExporting tablesng tables  

Export methods are specific to each table type.  See exporting data, boundaries, 
and results for more information. 

Querying tablesQuerying tables  

To query a table, first activate the table by clicking the pointer within the table 
window. Then, follow the steps below to perform the query. 

1. From the "Table" menu, choose "Query". The "Query Table" dialog 
will appear. 

2. At the top of the box, use the pull down menu to show the possible 
variables that you can query, and highlight one variable name. 

3. Pull down the "Operator" list in the next box, and choose the description 
that fits the query you would like to do (e.g. "equal to," "less than or 
equal to," "greater than"). 

4. Select whether the variable you are going to query on is a number or a 
string (character variable) by clicking on the appropriate dot. Then type 
the value or string in the box below. If you choose a string, you will need 
to enter the value in double quotes (e.g., "A"). 

5. Next, you need to decide what to do with the results of the query. If you 
haven't already selected any rows of data, choose "New Set." If you want 
the rows that are the results of your query to be added to an existing 
selected set, choose "Add to set." If you want the query to only look 
within a selected set when choosing rows (leaving only the results of the 
query highlighted), choose "Select from set." The rows are 
immediately selected (highlighted) in the table. 

6. When you have completed your selection, choose "Close." The values 
that meet your query will be highlighted. If you have a large data set and 
multiple rows meet your criteria, you may want to promote selected rows 
to view them all at the same time. 
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CCHARTSHARTS  

Working with histogramsWorking with histograms  

You can create, format, and remove histograms of data in BoundarySeer. 
BoundarySeer may also generate histograms to display the output from some 
analyses. BoundarySeer generates histograms for numeric but not categorical data. 

Creating a histogramCreating a histogram  

1. Choose "Histogram" from the "Data" menu found at the top of the 
BoundarySeer application window, or found by right-clicking on a data 
set in the project window. 

2. Choose the data set and the variables you wish to view from the pull-
down boxes in the dialog. Hit "OK" to view the histogram. 

Formatting and editing axis labelsFormatting and editing axis labels  

You can format and edit axis labels by double-clicking on the axis.  Double-
clicking will call up a window where you can rename the axis and specify a new 
font for the label. 

Formatting a histogramFormatting a histogram  

You can format the bars and axes of a histogram by right clicking in the histogram 
window and choosing "Properties." This brings up the histogram properties 
dialog that allows you to change the attributes of the axes and the bars on separate 
tabs. 

AxesAxes  

To change the scaling on the axes, set the minimum and maximum value shown 
for the X and the Y axes.  You may also specify the number of tick marks for each 
axis of the histogram, or BoundarySeer can set the tick marks automatically.  To 
change the thickness of the axes, choose a line thickness from the pull-down box 
next to "Line thickness:". 

BarsBars  

You may also change the color of the bars. Up to three colors of bars may be 
displayed on one histogram and these can be changed separately (change primary 
color, secondary color, or tertiary color). Most histograms will have only one 
color, though histograms of Boundary Likelihood Values for fuzzy wombled 
boundaries can have all three. You can also change the number of bins into which 
BoundarySeer divides the data. 
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Removing a histogramRemoving a histogram  

If you want to remove a histogram from a project, click on the "close" icon  in 
the upper right corner. This permanently removes the histogram. If you remove a 
histogram accidentally, you may re-create it (assuming you haven't also removed 
other important files such as data or boundary layers). 
 

Working with scatterplotsWorking with scatterplots  

You can create, format, and remove scatterplots in BoundarySeer. BoundarySeer 
may generate a scatterplot to display the output from some analyses. 
BoundarySeer generates scatterplots for numeric but not categorical data. 

Creating a scatterplotCreating a scatterplot  

1. Choose "Scatterplot" from the "Data" menu, found at the top of the 
BoundarySeer application window or found by right-clicking on a data set 
in the project window. 

2. Choose the data set, the x, and the y variables from the pull-down boxes 
on the dialog. Hit "OK" to view the plot. 

Formatting a scatterplotFormatting a scatterplot  

AxesAxes  

You may change the scaling on the axes by setting the minimum and maximum 
value shown as well as the number of tick marks for the x and y axes of the 
scatterplot. 

PointsPoints  

You may also change the color and size of the points. BoundarySeer will display 
an example of the new point format for your inspection. To accept the choice and 
return to the chart, click "OK." 

Removing a scatterplotRemoving a scatterplot  

If you want to remove a scatterplot from a project, click on the "close" icon  
in the upper right corner. This permanently removes the scatterplot. If you remove 
a scatterplot accidentally, you may re-create it (assuming you haven't also removed 
other important files such as data or boundary layers). 
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CCHAPTER HAPTER 33——WWORKING WITH ORKING WITH SSPATIAL PATIAL DDATAATA  

BoundarySeer projects begin with one or several spatial data sets. You can add 
new data sets at any time by importing new data files into the project. 

BoundarySeer supports two formats and two types of data. They are: 

• Data formats: raster, vector (point or polygon) 

• Data types: numeric, categorical 

You also can generate additional data sets within the project by standardizing your 
imported data sets, or through procedures such as fuzzy classification and spatially 
constrained clustering. 

This chapter describes how BoundarySeer handles data, data types and formats, 
missing data, adding or removing data, and importing data.  It also describes how 
to export data, boundaries, tables, maps, or charts from BoundarySeer. 

Adding or removing data from projects ................................................. 44 

Adding data ............................................................................................... 44 
Removing data ........................................................................................... 44 

Data sets created in BoundarySeer ........................................................ 44 

Cluster data sets ......................................................................................... 44 
Fuzzy class data sets ................................................................................... 44 

Data formats - raster, vector, and transect ............................................. 45 

Raster ........................................................................................................ 45 
Vector........................................................................................................ 45 

Data types - numeric, categorical, label ................................................. 46 

Numeric data ............................................................................................. 46 
Categorical data ......................................................................................... 46 
Binary data ................................................................................................ 46 
Label/Other............................................................................................... 46 

Spatial features .................................................................................... 47 

Associated data .......................................................................................... 47 
Applications............................................................................................... 47 
Saving spatial features................................................................................. 47 

Missing data ........................................................................................ 48 
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Choosing a missing value code .................................................................... 48 
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Coordinate systems.............................................................................. 48 

Data set properties ............................................................................... 49 
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IIMPORTING DATAMPORTING DATA  
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Adding or removing data from projectsAdding or removing data from projects  

Adding dataAdding data  

When you first open a project, you will be asked to import some data for analysis. 
Additional data can be imported into the project at any time. To add data, choose 
"Import" from the "Data" menu, choose the type of data you want to add and 
then follow the import dialogs. 

For two different data sets to be analyzed together in BoundarySeer (i.e., used for 
overlap analysis) they need to cover the same spatial area and be imported in the 
same projection. 

Removing dataRemoving data  

You can remove data from a project by choosing "Project" from the main menu, 
and then choosing "Remove". This will produce a list of the data sets in the 
project that you could potentially remove. 

We do not recommend removing data once you have used it for boundary 
detection or analysis. In order to generate random boundaries for evaluation of 
difference boundaries, BoundarySeer requires access to the original data set. The 
original data are not needed for randomization of cluster boundaries, but to 
preserve future flexibility in analyses we recommend keeping data in the project. 

Data sets created in BoundarySeerData sets created in BoundarySeer  

Cluster data setsCluster data sets  

During spatially constrained clustering, BoundarySeer creates a cluster data set 
associated with the original data set . The cluster data set is essentially a 
categorical data set, where the categories are clusters. 

Fuzzy class data setsFuzzy class data sets  

These types of files are created during fuzzy classification. They include the same 
spatial information as the source file, but the variables represent class membership. 
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Data formats Data formats -- raster, vector, and transect raster, vector, and transect  

BoundarySeer accepts raster, point, and polygon data sets. For all data formats, 
the measured variables can be numeric, categorical, or label/other. 

RasterRaster  

 Raster data are sampled on a regular grid; that is, sample locations are 
spaced at regular intervals in two spatial dimensions. Each data record is 
comprised of X, Y, and values of the variable(s), where X and Y can correspond to 
displacement or pixel numbers. Raster data are often generated from satellite 
images or other remote sensing techniques. 

VectorVector  

BoundarySeer can detect boundaries for variables associated with points and 
polygons. 

 PointPoint data consist of X, Y, and values of variable(s). 

PolygonPolygon data consists of vertices and associated data. Polygon files typically 
come from a GIS, although users can create polygon text files in text editors for 
importing into BoundarySeer.  

BoundarySeer requires that the user import valid polygons, valid polygons in 
BoundarySeer are non-overlapping and border each other (like the polygon icon to 
the upper left).  Polygons that do not share edges will not be recognized as 
adjacent for boundary detection procedures like constrained clustering and 
wombling.  Polygons that overlap may not share a common edge, and may not 
appear to neighbor each other.  Also overlapping polygons may cause problems in 
analyses like location uncertainty, for which points must be contained in only one 
polygon. 

LineLine data consists of vertices and associated data. Lines with associated data 
cannot be used for boundary analysis, but they can be used as spatial features and 
associated data can be viewed by querying the line layer on the map. 

Similarly, point or polygon files without associated data cannot be used for 
boundary analysis, but they can be viewed in the map and used as spatial features 
for tasks like spatial network editing. 
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Data types Data types -- numeric, categorical, label numeric, categorical, label  

BoundarySeer supports three types of variables: numeric, categorical, and label. 
All variables within a data set must be of the same type. If you try to import a file 
with variables of different types, BoundarySeer will separate them into different 
data sets, each containing only one variable type. 

Numeric dataNumeric data  

Numeric data are expressed as real numbers where the difference between two 
numbers is mathematically meaningful. Examples include numbers of disease 
cases, temperature, and salinity. Numeric data may be standardized so that each 
variable is weighted equally in the boundary delineation process. 

Categorical dataCategorical data  

Values for a categorical variable represent membership of the sample in one of a 
mutually exclusive set of categories. In BoundarySeer, categories must be 
expressed as integers; however, the mathematical difference between two 
categories represented by integers is not meaningful. That is, the difference 
between 4 and 1 is the same as that between 2 and 1: both pairs are mismatched. 
Examples of categorical data include blood type or soil classifications. 

Binary dataBinary data  

Binary data are categorical data with only two categories. In BoundarySeer, 
membership in binary categories must be expressed as either a "0" or "1". As with 
categorical data, differences between values at different locations are described in 
terms of matches or mismatches. Examples include species presence/absence, 
survival, and status as a smoker or non-smoker. 

Label/OtherLabel/Other  

You may have label variables that describe unique sampling locations, such as 
your name for an area. You may wish to import these labels for your own use, 
such as querying the map, even though they cannot be used in boundary analysis.  
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Spatial featuresSpatial features  

Spatial features are vector files that contain locations or spatial information 
but may not have associated data, such as USGS DLG files. Typically, spatial 
features provide locations of various natural or artificial boundaries or shapes to 
help visualize spatial data and aid in network editing. They also can be used in 
boundary overlap analysis. 

Associated dataAssociated data  

Lines with or without associated data are always treated as spatial features. Points 
and polygons with or without associated data can be used as spatial features. 

When you import spatial features, you can choose whether to import the 
associated data. Even when the data will not be used for boundary analysis, you 
still may want to visualize the data in the map. If you imported the data, you can 
view it by querying the spatial feature map layer. 

ApplicationsApplications  

Spatial features can quicken spatial network editing by automating the removal of 
inappropriate spatial network links. An outline of the study area, such as a 
meandering stream, can be imported into the project. Then, this outline can be 
used as a tool for selecting all links that occur outside of the study area, preventing 
these locations from being included in later analyses. 

Saving spatial featuresSaving spatial features  

Because spatial information without associated data cannot be used for boundary 
analysis, BoundarySeer does not save spatial features with the rest of the project 
file (*.bsr). Spatial feature information is saved in a *.pip file that needs to be 
retained with the project file. The name of the spatial feature file will be the source 
file name (e.g., "outline.dlg") with a *.pip extension (e.g., "outline.dlg.pip"). 

If you plan to use the information for network editing and not data visualization, 
then you may wish to remove the spatial feature from the project once you have 
edited the network. This way, you do not have to keep track of the *.pip file. 
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Missing dataMissing data  

With many remotely sensed files, pixels and/or entire regions can be recorded as 
'no data' using a no-data or missing value code. In other data sets, such a code 
might be used to indicate that the variable was not measurable at a location.  

Choosing a missing value codeChoosing a missing value code  

The missing value code should be a value that could not possibly show up as a true 
data value in the data set. Often, codes such as "-9999" are used so that the code is 
easy to recognize when you scan a column of data. Any integer value can be used, 
including negative numbers. Currently, decimal values and text strings (such as 
"no data") cannot be used. 

Missing data in boundary detection Missing data in boundary detection   

With multivariate data sets, BoundarySeer calculates gradients and distance 
metrics using only those variables that have no missing values for all locations 
involved. If a gradient or metric cannot be calculated because all variables have at 
least one missing value for the locations involved, BoundarySeer will report the 
missing value code as the metric (e.g. "-9999"). Further, when randomizing for 
Monte Carlo procedures, BoundarySeer will not include those locations with every 
variable coded as missing or 'no data'.   

Coordinate systemsCoordinate systems  

BoundarySeer can import data in planar coordinates, which includes all map 
projections, and geographic (latitude-longitude) coordinates. All data sets in one 
project need to be imported in the same projection, otherwise they will not register 
properly for use in BoundarySeer. 

1. Planar/ProjectionPlanar/Projection. This category comprises user-coordinates, UTM 
(Universal Transverse Mercator), and other projection systems. You may 
add the projection name when you import the data for your use, but 
BoundarySeer does not distinguish between projections, nor does it 
reproject anything other than geographic data. For this reason, you need 
to import all project data sets in the same projection. 

2. Geographic (latitudeGeographic (latitude--longitude)longitude). If your data are in geographic 
coordinates, this information is recorded as part of the data set description 
in BoundarySeer. Within BoundarySeer, data in geographic coordinates 
are transformed to UTM for calculation and mapping purposes, but can 
be transformed back for export (e.g. of data, boundaries, etc.) to other 
programs. 
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Data set propertiesData set properties  

To view data set properties, either choose "Properties" from the "Data" menu 
and then choose the data set from the pull-down list. Alternatively, right-click on a 
data set in the BoundarySeer project window and choose "Properties." 

OverviewOverview  

This section contains the name of the data set, its source file, date of modification, 
and its coordinate system. Please note that BoundarySeer converts geographic 
(latitude-longitude) data to UTM for calculation purposes. 

You can change the data set's name by clicking on "Rename." 

ContentsContents  

The lower left box varies for vector and raster data. For vector data, it lists the 
form of the data (points or polygons) and the number of points or polygons 
(features) in the data set. For raster data, you will see information on the height 
and width of the raster in pixels. 

For all data, BoundarySeer lists the number of variables and their labels. You may 
rename variables by selecting the one you wish to change and then clicking 
"Rename selected variable." 

SpecificsSpecifics  

The lower right box summarizes the data type (numeric or categorical), the 
missing value code (if you entered one), whether the data set has been 
standardized, whether the network has been edited (applies to vector point files 
only), and whether it is a cluster or fuzzy class data set. If the data set contains 
cluster or fuzzy class data, this box will also contain details about the clustering or 
classification process. The "Standardized" box will be checked if you save 
standardized variables into the original data set, or if you create a new 
standardized data file. 
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Boundary propertiesBoundary properties  

The boundary properties window provides detailed information about a specific 
boundary. To access this information, you can either choose "Boundary" from 
the menu and then choose "Properties", or right-click on a boundary in the 
project window and choose "Properties." 

OverviewOverview  

This section, contains the boundary name and the parent data set. You may 
rename the boundary by clicking on "Rename." 

ContentsContents  

This section, lower left, displays information about the boundary itself: the type of 
spatial feature (polygons for cluster data, for wombling data these may be 
Delaunay triangles, polygon edges, or a number of other feature types depending 
on the wombling method used). 

Next, it lists the number of candidate boundary elements (cBEs), followed by the 
number of Boundary Elements (BEs) found in the data set. For rasters, it also lists 
the size of the raster (height x width). 

Finally, the last item is the set of parent variables used to create the boundary. If 
the variable is followed by "STD," it was standardized before analysis. 

Detection InformationDetection Information  

This section, bottom right, contains details of the boundary analysis procedure. 
Besides the type (crisp or fuzzy), the specific method will be presented, as well as a 
listing of all of the parameters. 

For a review of the steps in creating boundaries, see individual boundary detection 
methods, such as wombling, location uncertainty, and spatially constrained 
clustering. 
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IIMPORTINMPORTING G DDATAATA  
When you first create a BoundarySeer project, a dialog pops up to ask what type of 
data you would like to import—raster or vector. Then, depending on whether the 
data file has a header describing the file's contents, additional dialog boxes may 
appear that request information about the data, or whether you would like to 
georeference the data (raster file). 

When creating a new project in BoundarySeer, you will not be able to import 
multiple Grid ASCII files. To import multiple Grid ASCII files with the same 
spatial coordinates, choose "Import" then "Custom" from the "Data" menu.  

Importing dataImporting data  

Once you have chosen a data set to import, BoundarySeer prompts you to specify 
the name, coordinate system, and the data delimiter in the file type. 

Data nameData name  

You can name the data set, or BoundarySeer will use the file name (without the 
file extension) as the default. 

Coordinate systemCoordinate system  

Choose the coordinate system of your data. BoundarySeer can import data in 
planar coordinates (includes but does not differentiate between many projections) 
and geographic coordinates (latitude-longitude). Because BoundarySeer works in 
planar coordinates, it transforms data in geographic coordinates to UTM for 
analysis. All data sets in one project need to be imported in the same projection, 
otherwise they will not register properly for use in BoundarySeer. 

Data delimiterData delimiter  

For text data, you need to choose the data delimiter (whether it is delimited by 
tabs, spaces, or any whitespace, which can also include carriage returns). 
Also, BoundarySeer needs to know whether to lump successive delimiters (e.g. a 
series of tabs) or to interpret them as delimiting missing values. If you tell it not to 
lump delimiters, it places the missing value code in the empty cells. 

Missing value codeMissing value code  

If you have or want missing values in your data set identified with a particular 
code, enter that code here. Currently, decimal values and text strings cannot be 
used as missing value codes. 



 52 

Custom imports: multiple GRID filesCustom imports: multiple GRID files  

The GRID format is a proprietary ESRI® format for raster data that contains only 
one variable. You may combine several GRID files into one BoundarySeer data 
set. To do so, each file must contain numeric data, have the same header, and 
cover the same spatial coordinates. At this time, categorical GRID files cannot be 
imported and combined into one data set. 

You cannot import multiple GRID files from the "Quick Start" dialog on 
creating a new project in BoundarySeer. Cancel out of the "Quick Start" dialog if 
you do not want any other data sets in your project. 

1. To import multiple GRID files, choose "Import" and then "Custom: 
multiple ARC/INFO® GRID" from the "Data" menu. 

2. After you choose to import multiple GRID files, the "Import Raster 
Data" dialog will appear. Choose the file type. Next, select the files to 
import using the shift or control keys to select multiple files. Hit 
"Import." 

3. On the "Import Data" dialog 

a. Choose a data set name (BoundarySeer chooses a name of one of the 
files as the default). 

b. Verify the coordinate system. 

c. As GRID files are tab-delimited, the data delimiter section of the 
dialog will be grayed out. 

d. If a missing value code is specified in the header, then the missing 
value section of the dialog will be blank. If not, choose a missing 
value code. 

e. Hit "Next" 
4. Choose whether to view the data in a map (either a new or existing map). 
 

ESRI® and ARC/INFO® are registered trademarks of the Environmental Systems 
Research Institute, Inc. 
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Import formats for vector dataImport formats for vector data  

The import data option appears whenever you create a new project. You can 
choose to import additional vector data sets at any time by choosing "Data" from 
the main menu, and then choosing "Import Data", and then "Vector". 

BoundarySeer can import vector files containing points, lines, and/or polygons. 
BoundarySeer uses data associated with points and polygons for boundary 
analysis. Lines and point and polygon files without associated data cannot be used 
for boundary analysis, but they can be viewed in the map and used as spatial 
features for tasks like spatial network editing.   

BoundarySeer does not clean or verify polygon files on import.  BoundarySeer 
requires that the user import valid polygons, valid polygons in BoundarySeer are 
non-overlapping and border each other (like the polygon icon to the upper left).  
Polygons that do not share edges will not be recognized as adjacent for boundary 
detection procedures like constrained clustering and wombling.  Polygons that 
overlap may not share a common edge, and may not appear to neighbor each 
other.  Also overlapping polygons may cause problems in analyses like location 
uncertainty, for which points must be contained in only one polygon. 

Available vector file types include: ArcView® shapefiles, text files of point data, 
BNA files, digital line graph files, and MapInfo® interchange files. When these files 
are imported, BoundarySeer will ask you to identify which variables to include, 
and their type (numeric, categorical, or label/other). 

Importing ArcViewImporting ArcView®® shapefiles (points or polygons) shapefiles (points or polygons)  

ArcView® shapefiles (extensions *.shp, *.shx, and *.dbf) can be imported 
without modification. 

Importing text files of point dataImporting text files of point data  

To import text files of point data, the files must consist of columns of data, with 
each set of observations separated by a carriage return. 

When BoundarySeer  reads the file, it looks for information in a header (see 
example below). You can add this header when creating the file, or BoundarySeer 
will prompt you for the information during the import process. The header 
information is not case-sensitive. 

In the first line of the header, list the data type - this can be numeric or categorical. 
On the next line, report the coordinate system. Currently, BoundarySeer 
recognizes two coordinate systems: "planar" and "geographic" (latitude-
longitude). On the next line, list the missing value code. On the last line of the 
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header, list the variable names in the order that they appear in the data file. These 
names can be descriptive, e.g., canopy cover, contaminant concentration, etc., but 
must be separated by commas. 

The file itself consists of a list of observations for each location in the data set. 
Each observation begins with the x coordinate, then the y coordinate. Next are the 
values for each of the variables (separated by delimiters). 

Data type: Numeric 
Coordinate system: planar 
Missing value: -99 
Variable names:  z1, z2, z3, z4 
1 1 0.03 72 1200 2.1 
1 2 0.05 85 1650 1.8 
1 3 0.06 89 1650 2.2 
1 4 0.08 -99 1750 2.5 

 

Importing BNA filesImporting BNA files  

BNA files (*.bna), which are typically associated with Atlas GIS® systems, can be 
imported without modification. Often, these files are geographic (latitude-
longitude) coordinates, although they may also be in UTM units. 

Typically, these files do not contain variable names, and they have a maximum of 
three variables.  When the file is imported, BoundarySeer creates field labels for 
each variable (e.g., "field 1", "field 2", up to "field 3").  When you import the file, 
you will need to know how many variables to select, and the data type (numeric or 
categorical) for each one. You can rename the variables in the data set properties 
dialog. 

If you need to examine the file to determine the number of variables and the 
projection, these files can typically be opened in a text file reader. 

Importing digital line graph files (DLG)Importing digital line graph files (DLG)  

Digital line graph files (*.dlg) are digitized topographic or planimetric maps 
available from the United States Geological Survey. These files contain images of 
spatial features, such as topography, hydrography, and some political boundaries, 
without associated data, so they cannot be used for boundary detection. DLG files 
can be useful as a spatial feature for editing the spatial network of a related point 
data set in BoundarySeer. The format is described in detail at the USGS website. 

DLG files can be imported directly into BoundarySeer. At this time, BoundarySeer 
supports import of "optional format" DLG files but not "spatial data transfer 
standard" (SDTS) files. 
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Importing MapInfoImporting MapInfo®® interchange files  interchange files   

MapInfo® interchange files (*.mif, *.mid) can be imported directly. MapInfo® 
interchange format consists of two files—the MIF file contains the graphics, while 
the MID file contains the textual data. The MIF file header contains the details of 
the coordinate system and bounds of the data set. BoundarySeer reads the 
coordinate system information directly from the MIF file. 

ArcView® and Atlas GIS® are registered trademarks of the Environmental Systems 
Research Institute, Inc. 

MapInfo® is a registered trademark of the MapInfo Corporation. 
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Import formats for raster dataImport formats for raster data  

The import data option appears whenever you open a new project. You can 
choose to import additional raster data sets at any time by choosing "Data" from 
the main menu, and then choosing "Import", and then "Raster". BoundarySeer 
can import a number of raster data types, including ENVI® files (*.bil, *.bip, and 
*.bsq), image files (*.tif, *.jpg), georeferenced images (GeoTiff and *.drg), 
digital elevation models (*.dem), and GRID ASCII. 

Importing ENVIImporting ENVI®® files files  

ENVI® rasters can be saved in one of three different file formats, band sequential 
(*.bsq), band interleaved by line (*.bil) and band interleaved by pixel (*.bip). 
BoundarySeer can import any of these files directly, as it reads in the 
georeferencing information in the header. 

Importing image file formats Importing image file formats   

TIFF (*.tif) and JPEG (*.jpg) image files can be imported into BoundarySeer as 
rasters. These files contain no georeferencing information, and so they must be 
georeferenced on import or by using the georeferencing dialogs found from the 
"Data" menu.  

Importing georeferenced image filesImporting georeferenced image files  

GeoTIFF and digital raster graphics (*.drg) files are, essentially, georeferenced 
TIFF files. These files are imported directly into BoundarySeer unless the file 
contains insufficient georeferencing information. 

Importing digital elevation model filesImporting digital elevation model files  

DEM files (*.dem) are USGS digital elevation model files that contain 
georeferencing information. BoundarySeer can import these files directly.  

Importing GRID ASCII filesImporting GRID ASCII files  

The GRID format is a proprietary ESRI® format for raster data. GRID files 
contain only one variable, although you may import several GRID files with the 
same spatial coordinates. 

To import GRID ASCII files, the file must begin with a header - the first 5 lines in 
the header are required, while the sixth (listing a value assigned to missing data) is 
optional. The first 5 lines should appear automatically when the file is generated 
from ARC/INFO®, but if you are having trouble importing files, this may be the 
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source of the problem. 

ncols 28 
nrows 28 
xllcorner 307420 
yllcorner 5396980 
cellsize 30 
NODATA_value -9999 

 
In the example file fragment above, the first two header lines describe the number 
of rows and columns in the file, and the next lines provide the coordinates for the 
raster that represents the lower left corner of the data set. Some files present 
"xllcenter" instead of corner - this is an acceptable format as well. The next 
header line provides the cell (pixel) size, and the optional sixth line is for the 
missing value code. After the header, the string of data for each cell appears, 
starting in the upper left corner of the grid, with each value separated by a space 
(space delimited) and each row separated by a carriage return. 

See also:  See also:  Georeferencing raster data, Data set properties, Missing data 
 

ESRI® and ARC/INFO® are registered trademarks of the Environmental Systems 
Research Institute, Inc. 

ENVI® is a registered trademark of Better Solutions Consulting LLC.  
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Georeferencing raster dataGeoreferencing raster data  

Georeferencing means connecting the data to spatial coordinates. When you have 
imported raster data, BoundarySeer requires the size of the pixels and the 
coordinates of the raster. This information fixes the raster within the coordinate 
system specified on import. Once the raster is georeferenced, then BoundarySeer 
can overlay it with other files in the same coordinate space. 

GRID ASCII files, *.dem, *.drg, and geoTIFF files include georeferencing 
information in the data or in the header file. Other raster data files, such as *.bil, 
*.bip, *.bsq, *.bmp, and *.jpg, do not always contain this information. For 
these data files, the raster must be georeferenced. 

To georeference your dataTo georeference your data  

1. You may encounter the Georeferencing dialog in the data import process, 
or you can access it from the "Data" menu or by right clicking in the 
"Data" tab on the BoundarySeer project window. 

2. Choose the data set to be georeferenced from the pull-down menu. 
3. Choose which type of georeferencing information you will enter. Either is 

sufficient to georeference the data. 
a. Origin and cell size. You can georeference either by entering the 

coordinates of the origin of the raster (the minimum x and y 
coordinates of the grid edge) and the grid cell size. BoundarySeer 
georeferences the entire data set from this information. 

b. Raster data boundaries. You need to enter the coordinates for the 
northern, eastern, southern, and western edge of the data set. This 
data is essentially the minimum and maximum x coordinates and the 
minimum and maximum y coordinates. BoundarySeer calculates cell 
size from this information, based on the number of columns in your 
data. 
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Selecting variables to importSelecting variables to import  

In this dialog, you can choose to import all, some, or none of the variables in the 
source file. Some data files may contain many more variables than you actually 
wish to analyze, particularly if you intend to use the data for spatial network 
editing. 

Selecting no variablesSelecting no variables  

In the case of spatial features, you may want to import only the spatial information 
without other data. In that case choose "Do not import variables" and then 
click "Next." BoundarySeer will import the spatial information without associated 
data. 

Selecting variablesSelecting variables  

1. Choose "Import variables" (the default choice). 
2. Select variables to import by clicking on them and then move them from 

the "Data source variables" box to "Variables to import" using the 
"Add" button. Add the source variables to one of the three categories 
(numeric, categorical, label/other). 
a. If the header of your file has already identified the data type, 

inappropriate data types will be grayed out. 
b. If you move a variable into the wrong category, use the back arrow to 

take it out again. 
3. Once you have finished adding variables, click "Next" to continue the 

import process. 
Please note:Please note: 
BoundarySeer is not yet able to work with variables of different types in the same 
data set. If you import some variables of each type, BoundarySeer will create two 
different data files, one for the categorical data and one for the numeric data. 
Labels will be included in each file. 
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EEXPORTINGXPORTING  

Exporting data setsExporting data sets  

Data sets imported into or created within BoundarySeer can be exported for use in 
a GIS. 

 

1. To export a data set, go to the "File" menu and select "Export" to bring 
up the "Export" dialog box. Alternatively, right click on a data set in the 
data tab of the project window and choose "Export" from the pop-up 
menu. 

2. From the pull-down list, choose to export data. 
3. A list will appear of all of the data sets in your project. Choose the data set 

you would like to export. 

4. The coordinate system of your data is presented in the "Coordinate 
system" box. If your data were automatically converted to UTM 
coordinates from geographic coordinates (latitude-longitude), you have 
the option of changing them back when you export. 

5. Select "Save As." 
6. A new window will appear that allows you to choose where to save the 

file and its name.  
7. The export format appropriate for your data will appear in the "Save as 

type" box. Once you have selected a location and a file name, select 
"Save".  

Source data Source data 
format format   

Export file typeExport file type  

point data 
 

text (*.txt) OR shapefiles (*.shp, *.shx, and *.dbf) 

polygon 
data 

shapefiles (*.shp, *.shx, and *.dbf) 

raster data Grid ASCII files (*.txt).  
Grid ASCII files only hold one variable, so BoundarySeer generates a 
*.txt file for each one. The base name for the set of files is chosen in 
the "Save As" dialog. 
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Exporting cluster statisticsExporting cluster statistics  

Files of cluster statistics include the cluster label, the number of elements within 
the cluster, and the mean and variance of the variables used in clustering (if you 
standardized the data before clustering, those variables will have STD after their 
name).  There is also a clusters data set, which can be exported like any other data 
set. 

Cluster statistics are exported as text files (*.txt).  There are two ways to export 
cluster statistics, one using the menu and the other using the project window.   

1. Menu 
a. To export cluster statistics go to the File menu on the application 

window and choose "Export." 
b. Choose the type of item to export (Cluster statistics) from the 

list. 
c. Skip to step 3. 

2. Project window 
a. Right click on the Clusters icon in the Data tab. 

b. Choose "Export" and then "Cluster Statistics." 
c. Skip to step 3. 

3. End of both methods 
a. When you select the type, a list will appear of all of the items of 

that type that are in your project.  Highlight the set of cluster 
statistics you want, and select "Save As." 

b. A new window will appear that allows you to choose where to 
save the file and its name.  

c. Once you have selected a location and a file name, select "Save." 
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Exporting boundaries and subboundariesExporting boundaries and subboundaries  

Boundaries created in BoundarySeer can be exported for use in a GIS. 
1. To export a boundary, go to the File menu or right-click on the boundary 

in the project window and chose "Export".   
2. In the "Export" dialog, choose to export a boundary on the pull-down 

menu. 
3. When you select boundary, BoundarySeer will list all boundaries in your 

project. Select the boundary you want to export. 
4. The export file format varies with the boundary type (see table below).  
5. The coordinate system of the boundary is presented in the "Coordinate 

system" box. If BoundarySeer converted your data from geographic 
(latitude-longitude) data to UTM on import, you have the option of 
changing them back when you export. 

6. Select "Save As." 
7. A new window will appear that allows you to choose where to save the 

file and its name.  For export types consisting of multiple files, the name 
you choose will serve as the base name for the file set, with individual files 
differentiated by what they contain.  (e.g. for BLV, "basename 
BLV.txt"). 

8. The export format appropriate for your data will appear in the "Save as 
type" box. Once you have selected a location and a file name, select 
"Save". 
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Source data format or procedureSource data format or procedure  Export file typeExport file type  

clustering on any data format shapefiles (*.shp, *.shx, and *.dbf) 

point data text (*.txt) OR shapefiles (*.shp, 
*.shx, and *.dbf) 

polygon data shapefiles (*.shp, *.shx, and *.dbf) 

raster data 

 

Arc/Info Grid ASCII files (*.txt):  one 
for each boundary descriptor (BLV, 
BMV, gradient angle for each variable, 
gradient magnitudes for each variable in a 
multivariate data set).   

For those with subboundaries:  
subboundary connections exported in 
shapefile format (*.shp, *.shx, and 
*.dbf). 

wombling  

wombling with 
location 
uncertainty on any 
data format 

Grid ASCII file containing BMV values 
(*.txt) 

point or polygon 
data 

shapefiles (*.shp, *.shx, and *.dbf) fuzzy 
classification 
using CI or CE  

raster data Arc/Info Grid ASCII files (*.txt) for 
BLV and BMV. 
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Exporting maps or chartsExporting maps or charts  

Maps and charts created in BoundarySeer can be exported as bitmaps (*.bmp) for 
use in a variety of word processing and drawing programs. BoundarySeer will 
export the map and the legend, but not the layer list. 

To export a chart or map, go to the File menu, and chose "Export." 

1. In the "Export" dialog, choose the type of item to export (either a map or 
a chart). 

2. When you select the type, a list will appear of all of the items of that type 
that are in your project. Highlight the chart or map that you want, and 
select "Save As". 

3. A new window will appear that allows you to choose where to save the 
bitmap and its name. 

Once you have selected a location and a file name, select "Save". 

Exporting resultsExporting results  

To export results, you can right-click on the set you want to export in the results 
tab of the project window and choose "Export." Alternatively, go to the "File" 
menu and select "Export" to bring up the "Export" dialog. 

1. From the pull-down list, choose to export "Results." 
2. A list will appear of all of the results in your project. Choose the results set 

you would like to export. 
3. Choose whether you want to standardize the output. 

4. Select "Save As." 
5. A new window will appear that allows you to choose where to save the 

file and its name. Name the file and then select "Save." Results are 
exported as text files (*.txt). 
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CCHAPTER HAPTER 44——PPREPARING REPARING DDATA FOR ATA FOR AANALYSISNALYSIS  

After you have imported your data into BoundarySeer, and before you conduct 
boundary analysis, you should consider preparing your data for analysis.  This 
chapter details methods to prepare your data within BoundarySeer, including 
creating variable sets, weighting variables, standardizing data, editing spatial 
networks for point data, classification, and dissimilarity methods used in boundary 
detection. 

Creating and using variable sets ............................................................ 67 

Steps to create a variable set ........................................................................ 67 
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Creating and using variable setsCreating and using variable sets  

BoundarySeer allows you to perform thorough investigations of multivariate data 
sets by defining suites of variables for analyses. That is, you can select one or more 
variables for boundary detection from a data set containing many variables. One 
way that you might consider using this flexibility is for viewing boundaries based 
on individual variables before combining them in a suite for multivariate boundary 
analysis. 

Steps to create a variable setSteps to create a variable set  

1. From the main menu, choose "Data", and then select "Variable Sets". 
2. When the dialog box first opens, it shows the default variable set, which 

includes all of the variables in a given data set. You cannot modify this 
default set, but you may create a new set with different variables and/or 
weights. 

3. Choose the source data set for the variable set from the pull-down menu. 
Remember, for a data set to appear in this window, you must have already 
imported it into the project. 

4. To create a new set, hit the "Create New Set" button. Enter a name for 
the variable set or accept the default. 

5. Then click the "Create New Set" button, and this name will be 
displayed in the "Variable Set" window. 

6. The new variable set begins with no variables (note that the "in set" 
column in the table is empty). To add all of the variables, click the "Add 
All" button. To add variables individually, click on the "in set" column, 
which will put an "X" in the box. See Also:See Also: choice of variables. 

7. To change the weight of an individual variable, type a new value in the 
weight cell. 

8. If you want to delete a variable set, select it from the pull down list, and 
then click "Delete Set". 

9. When you have created a variable set that you want to save, click 
"Apply", and then close. 

Editing variable setsEditing variable sets  

You can edit variable sets using the methods described above for creating variable 
sets. Remember, you cannot edit the "All variables, equal weights" variable 
set. You can change any variable set you have created by selecting it from the 
drop-down list on the 'Variable Sets' dialog, and then changing which variables 
are included or their weights. Remember to click "Apply" to save changes, and 
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then "Close." 

You can also edit variable sets from within the Boundary Detection dialogs. 

Using variable setsUsing variable sets  

When you want to conduct boundary analyses, these new variable sets will be 
available for you to use. You will have the option to use or create variable sets 
when you begin any BoundarySeer boundary detection method. Additionally, you 
may select to use a single variable in any boundary detection method by filling in 
the circle next to "Variable" (rather than Variable set) and then selecting your 
variable. 

Weighting variablesWeighting variables  

In BoundarySeer, you have the ability to give variables different weights prior to 
the calculation of Boundary Likelihood Values. You can do this when you create 
variable sets.  

You may want to consider giving variables weights greater than one if you have a 
reason for expecting that one or more of the variables contributes more strongly to 
the boundary-generating process in a particular system than the other factors. 
Another situation where you may want to weight variables is if you think two or 
more variables are highly correlated, and you want to reduce their influence on the 
analysis. In this case, you would probably give the variables weights that are less 
than one. 
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Why standardize variables?Why standardize variables?  

Many researchers have noted the importance of standardizing variables for 
multivariate analysis. Otherwise, variables measured at different scales do not 
contribute equally to the analysis. For example, in boundary detection, a variable 
that ranges between 0 and 100 will outweigh a variable that ranges between 0 and 
1. Using these variables without standardization in effect gives the variable with 
the larger range a weight of 100 in the analysis. Transforming the data to 
comparable scales can prevent this problem. Typical data standardization 
procedures equalize the range and/or data variability. 

How to standardize your dataHow to standardize your data  

1. Go to the "Data" menu choose "Standardize," or choose 
"Standardize" from the menu that appears when you right click on a 
data set in the project window. 

2. Select a standardization method. 
3. The standardized variables can be saved over the original set or into a new 

data set. 
a. If you choose to overwrite the data set, it overwrites the 

BoundarySeer data set, not the source file. 
b. If you choose to overwrite the data set, the data cannot be 

transformed back to their original state. In that case, if you wanted to 
use the original data set again, you would need to reimport it. 

c. If you choose to save the standardized variables in a new set, enter a 
name or accept the default choice. The default name begins with the 
data set name plus "Std" for standardized. 

4. Hit "OK" to standardize the data. 
After standardization, all variables will have the same weight during analyses (i.e., 
all variables are treated as equally important contributors to the boundary). In 
addition, you may decide to weight the data based on your knowledge of the 
relative importance of the variables. 

Please note:Please note: when you standardize your data and save the data over the original 
data set, BoundarySeer will not update the maps, charts and tables referencing the 
data set in your project. Thus, if you query a map, it will show the pre-
standardized information, which may be misleading. To view an updated map, 
chart, or table, delete the old one and create a new one using the standardized data 
set. 
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Methods for data standardizationMethods for data standardization  

The appropriate standardization method depends on your data set and the 
conventions of your particular field of study. Examples of papers that discuss 
standardization include Gower (1985), Johnson and Wichern (1992), Everitt 
(1993), and van Tongeren (1995). In addition, Milligan and Cooper (1988) present 
an in-depth examination of standardization of variables when using Euclidean 
Distance as the dissimilarity metric. 

Remember, if you choose to use the Steinhaus Coefficient of Similarity 
(recommended for count data, such as the number of trees of different species at 
sampled locations), this measure is self-normalizing and data should not be 
standardized. 

Standardization techniques in BoundarySeer include:Standardization techniques in BoundarySeer include:  

• 00--1 scaling1 scaling: each variable in the data set is recalculated as  
(V - min V)/(max V - min V), where V represents the value of the variable 
in the original data set. This method allows variables to have differing 
means and standard deviations but equal ranges. In this case, there is at 
least one observed value at the 0 and 1 endpoints. 

• Dividing each value by the rarangenge: recalculates each variable as  
V /(max V - min V). In this case, the means, variances, and ranges of the 
variables are still different, but at least the ranges are likely to be more 
similar. 

• ZZ--score scalingscore scaling: variables recalculated as (V - mean of V)/s, where "s" is 
the standard deviation. As a result, all variables in the data set have equal 
means (0) and standard deviations (1) but different ranges. 

• Dividing each value by the standard deviationstandard deviation. This method produces a 
set of transformed variables with variances of 1, but different means and 
ranges. 

Please note:Please note: when you standardize your data and save the data over the original 
data set, BoundarySeer will not update the maps, charts and tables referencing the 
data set in your project. Thus, if you query a map, it will show the pre-
standardized information, which may be misleading. To view an updated map, 
chart, or table, delete the old one and create a new one using the standardized data 
set. 
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SSPATIAL PATIAL NNETWORKSETWORKS  

About spatial networksAbout spatial networks  

Boundary delineation techniques for point data require that the sample locations 
be connected using a nearest-neighbor algorithm (see Figure 4.1 below). 
BoundarySeer automatically generates a Delaunay network for each point data set 
before boundaries are detected. 

Why edit spatial networks?Why edit spatial networks?  

Often spatial networks contain links between points that are actually located 
outside of the study area, or the links connect points you would not consider 
adjacent for some other reason. These links are problematic because boundaries 
might inadvertently be detected in areas that are not meaningful within the context 
of your study. For instance, in Figure 4.1, an illustration of stream samples, some 
of the Delaunay triangles may have centroids that are on land. Since the centroid 
is where the wombling Boundary Likelihood Value is calculated, this location 

Figure 4.1.  A close-up of a spatial network drawn between stream sample 
locations.  The darker gray lines indicate spatial network connections 
automatically deactivated by BoundarySeer.  The lighter gray lines indicate 
active network connections.  As the samples are in a stream, connections that 
cross land do not connect neighboring points.  You should edit out these 
inappropriate connections.  
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would not make sense as a boundary in the data. You can remove these 
inappropriate links between points by editing the spatial network. 

In addition, the Delaunay network often connects widely spaced locations near the 
periphery of the data set. In most cases it does not make sense to compare two 
distant points. BoundarySeer automatically deactivates some of these links (note 
the gray links in the figure above). Even if you do not think that you have edits to 
make, you should view and edit the network to verify BoundarySeer's decisions 
about which links to automatically deactivate. 
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Editing spatial netEditing spatial networksworks  

Once you have generated a spatial network, a prompt recommends that you edit 
the network (see why edit spatial networks? for more background). 

If you decide to edit, BoundarySeer enters an "edit mode." The spatial network 
toolbar becomes activated. 

Editing modesEditing modes  

• using the mouse 

• using minimum length 
• using a spatial feature, such as an outline of the study area 

• using the spatial network toolbar 

Deactivating links using the mouseDeactivating links using the mouse  

You can select individual links in the spatial network by clicking on them with the 
mouse. When you select a link, it changes color to indicate that it has been 
successfully selected. The default colors for spatial networks are: green for active 
links, gray for inactive links, and orange for selected links. You can change the 
selection color in the project properties dialog and the other link colors in the map 
layer properties dialog. 

To select more than one link, hold down the "shift" button while you are making 
selections. Also, clicking on the map with the mouse and holding the button down 
while you drag creates a rectangle or square on the map. All links that intersect the 
rectangle will be selected. 

• To unselect a selected link, click on it again or click elsewhere in the map. 

• Double click on links to change their activation status. 
• You can also deactivate or reactivate using the menus. To deactivate 

selected links, go back to the Spatial Network menu and choose 
"Deactivate". If you want to re-activate links, select them and then go 
back to the Spatial Network menu and choose "Activate." 

To stop editing, choose "Stop editing" from the "Spatial Network" menu 
or from the toolbar to turn off the edit mode. You can also stop editing by deleting 
the network layer from the map. If you do not save your changes before stopping, 
BoundarySeer will prompt you to save them. 
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DeactivatinDeactivating links using the minimum length optiong links using the minimum length option  

Sometimes, the inappropriate links created in initial spatial networks are very long. 
This can occur when the network links areas on the edge of the study area to other 
edges, when the intervening area was not actually a part of the study. To select all 
"long" links at once, you can use the "Minimum Length" option. Steps for this 
process are listed below. 

1. When you choose to edit the network, BoundarySeer automatically goes 
into edit mode.  First, select a link that you want to represent the 
minimum length for all of the links that will be selected (and eventually 
deactivated). 

2. From the Spatial Network menu, choose "Minimum Length". Or, 
hit the minimum length toolbar button.  

3. All of the links longer than the chosen link will change color. The default 
colors for spatial networks is green for active links, gray for inactive links, 
and orange for selected links. These colors can be changed by the user. 

4.  Next, from the Spatial Network menu, choose "Deactivate". Or, hit 
the deactivate button. The links that were orange turn to gray, and are 
excluded from later analyses.  

5. If you want to add some of these links back into the active set, either 
double click them, or select them with a left mouse click, and then choose 
"Activate" from the Spatial Network menu or hit the activate button.  

6. Choose "Save Changes" from the Spatial Network menu, hit the 
"Save changes" button, (or wait for the prompt at the next step).  

7. Then choose "Stop editing" from the menu or from the toolbar, 
which will turn off the edit mode. You can also stop editing by deleting 
the network layer from the map. BoundarySeer will prompt you to save 
your changes. 
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Deactivating links using a spatial featureDeactivating links using a spatial feature  

Spatial features can ease network editing when the study area is irregularly shaped 
and a number of inappropriate links have been created.  

For example, in the spatial network for stream data in Figure 4.1, a number of 
Delaunay network connections and triangle centroids, where Boundary Likelihood 
Values (BLVs) are calculated, are on the land. These connections are inappropriate 
because the data contain no information about the land. 

Instead of deactivating individual links by hand, you may exclude links using a 
spatial feature. The spatial feature can be imported into the project from another 
source, such as a digital USGS map. The imported outline can be used as a tool for 
intersecting (and selecting) all links that occur outside of the study area. Figure 4.2 
shows the spatial network and the outline of the stream bed (in black), after the 
stream outline was used to deactivate links that intersected it. 

 

Figure 4.2.  An illustration of inappropriate spatial network links deactivated 
using a spatial feature file, in this case the shoreline of a stream.   



 76 

Steps in deactivatinSteps in deactivating links with a spatial feature:g links with a spatial feature:  

1. When you choose to edit the network, BoundarySeer automatically goes 
into edit mode.  

2. Under "Spatial Network" on the main menu, choose "Select 
Links Using", and then select "Line Intersection." Or, hit the line 
intersection button on the toolbar  (not active unless another data set has 
been imported into the project). 

3. This will bring up the Line Intersection dialog box. Choose the data 
you wish to use as a spatial feature from the pull-down list (you must have 
already imported it into the project). 

4. The links that intersect the "cookie cutter" spatial feature will change 
color. Next, from the Spatial Network menu, choose "Deactivate" or 
hit the deactivate button,. The links that were the "selection" color turn to 
the deactivated color (usually gray), and are not included in later analyses. 

5. Save your changes, by choosing "Save Changes" from the "Spatial 
Network" menu or hit the save button. 

6. Choose "Stop editing" from the Spatial Network menu or from 
the toolbar to turn off the edit mode. You can also stop editing by deleting 
the network layer from the map. BoundarySeer will prompt you to save 
your changes if you did not already save them. 
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The spatial network toolbarThe spatial network toolbar  

 

Some elements of the toolbar won't be available until you have selected a link (like 
activate or deactivate) or until you have imported additional data (such as line 
intersection). 

The "activate" button allows you to include selected links in the spatial 
network. 

The "deactivate" button allows you to exclude selected links from the spatial 
network. 

The "select minimum length" button allows you to exclude links by size. The 
selected link and any longer links will be selected. Then, you can choose to 
deactivate the group by hitting the "deactivate" button. 

The "select using intersection" button allows you to exclude links that cross 
the outline of the study area. For this method, you need to import a spatial feature 
or another data set to use as the outline. This method is described in full in 
Deactivating links using a spatial feature. 

The "save network" button saves changes to the spatial network but allows you 
to continue editing. 

The "stop editing" button ends the editing session. BoundarySeer will prompt 
you to save the changes if you have made any changes since the last save. 
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DDISSIMILARITYISSIMILARITY  

About dissimilarity metricsAbout dissimilarity metrics  

Dissimilarity metrics evaluate differences in a set of variables between spatial 
locations. They are required in all boundary delineation methods except numeric 
wombling. That is, they are required in polygon wombling, categorical wombling, 
moving split window analysis, and spatially constrained clustering. For each pair 
of locations, the chosen dissimilarity metric is calculated, and that value forms the 
basis of multivariate analyses within BoundarySeer. 

What are dissimilarity metrics?What are dissimilarity metrics?  

To understand dissimilarity metrics, first think about proximity metrics. Proximity 
metrics can be used to quantify how close different locations are in physical space, 
and are calculated from the x and y coordinates of each location. Examples of 
proximity metrics include Euclidean distance, which is the straight line distance 
between observations, and Manhattan distance, which is a "stair stepping" way to 
measure distance which can be calculated by taking the sum of the absolute value 
of the differences between values of the x and y variables. 

Dissimilarity metrics address how close two sets of observations are in variable 
space—in other words, you can think of the variables for each location being 
plotted in a many-dimensional space, and then imagine estimating "distances" 
between these points. Both Euclidean distance and Manhattan distance can be 
used as metrics of dissimilarity as well as proximity, as can many other metrics. 
Dissimilarity metrics are closely related to similarity metrics; the range of values 
for both is often between 0 and 1. In many cases, you can convert between a 
measure of similarity and one of dissimilarity by subtracting the first metric from 1 
to get the other (e.g., S = 1-D; D = 1-S). 

Dissimilarity in BoundarySeerDissimilarity in BoundarySeer  

There are many ways of quantifying distance or dissimilarity, and we include only 
the most common ones in this release of BoundarySeer. Subsequent versions of 
BoundarySeer will have more metrics available, including a highly flexible 
equation editor that will allow you to specify almost any metric and to design new 
ones as the need arises. 

Often, different distance and dissimilarity metrics are used in different scientific 
fields; population genetics uses genetic distance, ecology employs ecological 
distance, and so on. Thus, when choosing an appropriate metric you should survey 
the literature to identify those commonly used in your field. 
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Choosing a dissimilarity metricChoosing a dissimilarity metric  

For numeric data, BoundarySeer includes four possible measures of dissimilarity: 
Euclidean distance, squared Euclidean distance, Manhattan distance, and the 
Steinhaus Coefficient of Similarity. Mismatch value is the only choice for 
categorical data in this version of BoundarySeer. 

In the equations below, p represents the number of variables, '
iz is the value of 

variable i at the first location, and "
iz  is the value of the variable i at the second 

location. 

Numeric dataNumeric data  

1. Euclidean DistanceEuclidean Distance. This metric represents the straight-line distance 
between observations in variable space, and is the most commonly used 
metric in many disciplines. 
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2. Squared EuclideSquared Euclidean Distancean Distance. This metric is simply the Euclidean Distance 
squared, and will give you the same results in terms of boundary 
delineation as the Euclidean Distance. We include this metric because if 
you have very large data sets, the processing time can be lower if the 
program does not have to calculate the square root for Euclidean 
Distance. 

3. Manhattan DistanceManhattan Distance. This metric, which is also called the city block 
metric or taxicab metric, estimates distance as the sum of the differences 
between values of each variable at two locations. 
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4. SteinhausSteinhaus (also referred to as Bray and CurtisBray and Curtis - below, we present the 
equation typically attributed to Bray and Curtis). This metric is designed 
and recommended for use with count data, and is a self-normalizing 
metric. Since the metric is self-normalizing (e.g., it accounts for 
differences in the range of count values), data need not be standardized 
prior to its use. 
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Categorical dataCategorical data  

Mismatch valueMismatch value is the only available metric for categorical data. The mismatch 
value is calculated simply as the number of variables for which the two locations 
have different values (mismatches), divided by the total number of variables. 
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FFUZZY UZZY CCLASSIFICATIONLASSIFICATION  

About fuzzy classificaAbout fuzzy classificationtion  

In general, classification methods allow you to reduce the dimensionality of a 
complex data set by grouping the data into a set number of classes. 

With traditional (crisp) classification methods, each sample/location is placed into 
one class or another. In crisp classification, class membership is binary, a sample is 
a member of a class or not. Crisp class membership values can be either "1" when 
that class is the best fit, or "0" (for all other classes). 

In fuzzy classification, a sample can have membership in many different classes to 
different degrees. Typically, the membership values are constrained so that all of 
the membership values for a particular sample sum to 1. 

Why use fuzzy classes?Why use fuzzy classes?  

Fuzzy classes are appropriate for continuous data that does not fall neatly into 
discrete classes, such as climatic data (McBratney and Moore 1985), vegetation 
type (Lowell 1994, Brown 1998a) soil classification (McBratney and deGruijter 
1992), and many other engineering, geological, and medical applications (reviewed 
in Bezdek 1987). Fuzzy classes can better represent transitional areas than hard 
classification (Brown 1998a), as class membership is not binary (yes/no) but 
instead one location can belong to a few classes. 

Brown (1998) identifies fuzzy classification as appropriate for data with 1) 
"attribute ambiguity" and 2) "spatial vagueness." Attribute ambiguity occurs when 
class membership is partial or unclear. Ambiguity is particularly a problem for 
some remotely-sensed data, such as aerial photography, which is not interpreted 
consistently (Edwards and Lowell 1994, cited in Lowell 1994). Spatial vagueness 
emerges when the sampling resolution is not fine enough to catch boundary 
locations, when gradual transitions occur between classes, or when there is some 
location uncertainty in the data. 

Fuzzy classes depict the spatial and attribute uncertainty present in most data sets 
more accurately than hard classification. 

See also:  See also:  Detecting boundaries on fuzzy classes 
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The fuzzy classification processThe fuzzy classification process  

Fuzzy classification can reduce the dimensionality of multivariate data sets, by 
assigning the objects in the data set to k fuzzy classes. You, the user, choose the 
number of classes, k (see choosing k). 

BoundarySeer uses a k-means technique to create fuzzy classes. First, it assigns the 
locations randomly to classes.  It then refines the class membership, reducing the 
variation within a class and maximizing the between-class variation. This process 
results in a new data set where the original spatial locations are described only by 
membership in the k classes. 

StepsSteps  

1. InitializationInitialization. 
a. An initial partition of k clusters is established. Cluster membership is 

initially random. 
b. Select a value for the fuzziness exponent ϕ, phi (values can be 

between 1 and ˜, 2 is a good initial value).  
c. Select a value for the stopping criterion ε, epsilon.  It determines the 

level of convergence necessary before quitting (McBratney and de 
Gruijter 1992 recommend ε = 0.001). 

2. RefinementRefinement. BoundarySeer compares dissimilarity between classes using 
Euclidean distance. BoundarySeer rearranges class memberships 
iteratively to minimize the within-class least squared-error function, J. 

3. FinalizationFinalization. 
a. The procedure terminates when the largest proportional difference 

between the matrices is ≤ ε , the stopping criteria. 
b. Once the final partition has been selected, it is saved as a new data set 

with the same X-Y values as the original data set, and variable(s) 
denoting class membership. Unless renamed by the user, the data set 
has a "Classes" suffix. 

Please note:Please note: the location of samples is not taken into account in the classification 
process. Each sample location is assigned classification values regardless of the 
values of adjacent locations. 

See also:  See also:  How to detect boundaries for fuzzy classes 
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Choosing fuzzy classification parametersChoosing fuzzy classification parameters  

To perform a fuzzy classification, you must choose values for the number of 
classes (k), the fuzziness of the classification (phi), and the stopping criterion 
(epsilon). BoundarySeer provides some preset defaults for these settings, so you 
may classify your data without entering any values. You may wish to test the 
influence of these parameters on the classification by repeating the analysis and 
varying the parameters. 

How many classes? Choosing a value for kHow many classes? Choosing a value for k  

Choosing an appropriate number of classes is the eternal classification problem. 
Classification techniques will produce the number of clusters specified, regardless 
of whether they are meaningful distinctions. The k-means technique for fuzzy 
classification maximizes between-cluster variation for a set number of clusters (k). 
You may wish to check on how the chosen value of k influences the clustering by 
comparing the outcomes for a range of k values. 

If you have a sense of the number of clusters that is appropriate for your data, use 
that. For a first pass, you might try a "rule-of-thumb" from hard clustering: k = n½ 
(McBratney and Moore 1985) where n = the number of objects in the data set. 

How fuzzy? Choosing a value for How fuzzy? Choosing a value for ϕϕ   

ϕ, phi, determines the fuzziness of the classification. When phi is set to one (not 
possible in BoundarySeer), the clustering is hard clustering, with binary class 
membership (yes/no). Phi values for fuzzy clustering can range from just above 1 
to infinity. Yet, at very high phi values, the classification may be so fuzzy as to not 
distinguish any classes at all. The choice of phi will balance the need for structure 
(distinguishable classes) from continuity (fuzziness). A common starting place is 
phi = 2 (McBratney and deGruijter 1992). As phi approaches one, clustering 
becomes more difficult (McBratney and Moore 1985), so values lower than 1.1 
may not produce good results. 

How optimal? Choosing a value for How optimal? Choosing a value for εε  

BoundarySeer will continually reallocate class membership values between the 
classes until it arrives at an optimal arrangement. The cutoff for the optimization is 
ε, epsilon. BoundarySeer minimizes the within-class least-squared error term. 
Once BoundarySeer is changing the matrix of membership values by very small 
amounts, it is time to stop optimization. BoundarySeer compares matrices of 
membership values by the largest proportional difference between membership 
values (i.e. if a membership value is 0.75 and it changes by 0.03, then the 
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proportional difference is 0.03/0.75 = 0.04). McBratney and deGruijter (1992) 
recommend epsilon = 0.001. That would be a change of 0.00075 in a membership 
value of 0.75. All proportionate differences for each class membership value for 
each location are calculated, and the largest must be less than epsilon. 

See also:  See also:  Interpreting fuzzy classification output 
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About kAbout k--means clusteringmeans clustering  

K-means clustering is an algorithm that is used in two different BoundarySeer 
techniques, spatially-constrained clustering and fuzzy classification. 
Both techniques require grouping the data into classes, or clusters. In fuzzy 
classification, the classes are based on variable values, irrespective of spatial 
location. In spatially-constrained clustering, as the name suggests, group 
membership is constrained by the spatial location, i.e. distant locations with 
similar values will not be grouped together. 
For both methods, k-means clustering begins and ends with a fixed number of 
classes (or clusters). Memberships in classes are rearranged through an iterative 
process in order to optimize the classification, using the following criteria:  
  
Where, M M = (mic) is a matrix of class memberships, 
 R R = (rcv) is a matrix of class means, rcv, denoting the mean of class c for variable v, 
 xi = (xi1,...,xip)T is the vector representing values of the p variables at location i, 
 rc = (rc1,...,rcp)T is the vector representing the center of class c in terms of means of 
the p variables, 
 d2(xi,rc) is the square distance between xi and rc, also expressed as dic

2. 
ϕ is the fuzziness criterion (ϕ = 1 gives hard clusters and is required for spatially 
constrained clustering; ϕ = 2 is a good minimum value for fuzzy clustering 
McBratney and de Gruijter 1993). 
ε is the stopping criterion, which determines the level of convergence necessary 
before quitting (McBratney and de Gruijter 1993 recommend ε = 0.001). 
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MethodMethod Spatially constrained clusteringSpatially constrained clustering Fuzzy classificationFuzzy classification 

# group# groupss k clusters k classes 

spatial spatial 
constraintconstraint 

spatial contiguity none 

dissimilarity dissimilarity 
metricmetric 

squared Euclidean distance squared Euclidean distance 

refinement refinement 
criterioncriterion 

minimize within-cluster variation 
using the sum of squares error 
term (SSE) 
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1984) 
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At each iteration, all locations that 
can change cluster membership are 
identified.  To qualify for a change 
of membership to a new cluster, a 
location must be adjacent to a 
member of the new cluster, and its 
removal from its former cluster 
cannot cause the former cluster to 
become discontinuous.  The 
membership change that causes 
the greatest decrease in the total 
within-cluster SSE is then made.  
The process repeats until no 
allowable membership relocation 
improves the SSE. 

When ϕ > 1, J can be minimized 
by Picard iteration of the following 
equations: 
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How to create fuzzy classesHow to create fuzzy classes  

Go to "Detect Boundary" on the "Data" menu, or right click on the data set 
you wish to classify in the project window and choose "Detect Boundary." 
Select "Fuzzy classification." 

The fuzzy classification dialog consists of four tabs. To create classes, you will just 
need to complete the first two tabs. Once you have fuzzy classes, you may detect 
boundaries on it. 

To learn how to detect boundaries using wombling, classification entropy or 
confusion index directly when you classify the data, refer to How to detect 
boundaries on fuzzy classes instead (p. 138). 

To detect boundaries with spatially constrained clustering or wombling with 
location uncertainty, get fuzzy classes and then follow instructions for these 
procedures using the fuzzy class data set. 

StepsSteps  

1. "General" tab 
a. Select the data set to classify from the pull down list. 
b. BoundarySeer will produce a new data set of the spatial locations with 

their fuzzy class memberships. You can name the data set or accept 
the default, note that the default name contains the word "Class". 

c. There will be a place to specify a name for the new boundary, but as 
you won't create a new boundary this feature does not apply. 

d. Select the number of classes (k). 
e. Select whether to perform the analysis on one variable, the entire data 

set, or another variable set. 
f. The default is to standardize the variables before analysis. Unselect 

this option if you decide not to standardize. 

2. "Method" tab 
a. Select a fuzziness exponent (phi or ϕ). 

b. Select a stopping criterion (epsilon or ε). 

c. Clear the "Detect boundaries using:" checkbox. 
3. BoundarySeer will create a new data set in the project of the fuzzy classes. 

You may then use the boundary detection method of your choice on the 
fuzzy class data set. 
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CCHAPTER HAPTER 55——DDETECTING ETECTING BBOUNDARIESOUNDARIES  

BoundarySeer delineates areal boundaries using spatially constrained clustering 
and difference boundaries by wombling methods, including wombling with 
location uncertainty and wombling on fuzzy classes. BoundarySeer also can 
produce difference boundaries using the classification entropy and confusion index 
from fuzzy classification. 

This chapter defines the types of boundaries you can delineate in BoundarySeer 
and methods to use.  It also describes two tools in BoundarySeer you may use to 
choose a method, the Advisor and the Wizard. 

About difference boundaries ................................................................. 89 

About areal boundaries ........................................................................ 90 

About boundary detection .................................................................... 91 

Boundary Detection Advisor Diagram .................................................. 92 

Boundary Detection Wizard................................................................. 93 

The Steps ................................................................................................... 93 
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About difference boundariesAbout difference boundaries  

Difference boundaries are zones of rapid change. BoundarySeer delineates 
difference boundaries through wombling methods, including wombling with 
location uncertainty and wombling on fuzzy classes, as well as using classification 
entropy and confusion index as Boundary Likelihood Values for fuzzy classes. 

The following icons represent difference boundaries in the project window: 

   

point data polygon data raster data 

 

For difference boundaries, boundary information can include (1) Boundary 
Likelihood Values; (2) gradient angle values; (3) Boundary Element (BE) 
designations; (4) Boundary Membership Values; and (5) subboundaries (connected 
boundary elements). To view these values, you can right-click on the boundary 
icon in the project window and choose "View Table." 

1. BounBoundary Likelihood Valuesdary Likelihood Values (BLVs) measure the degree of change in 
raster or point data, or calculated distance metrics in transect or polygon 
data. For categorical data, BLVs are based on mismatch values. 

2. Gradient anglesGradient angles are the direction of the maximum change in the BLV at a 
specific location. The angle is calculated relative to a horizontal vector 
pointing east from the candidate BE. Two adjacent boundary elements are 
connected to form a subboundary only if the average differences in their 
aspects and their connection angle with the subboundary (see diagram) are 
within thresholds set by the user. Gradient angles are calculated in 
wombling on numeric point or raster data. 

3. Boundary elementsBoundary elements (BEs) compose a difference boundary. BEs are a set of 
locations associated with large amounts of change in the underlying 
variables (high BLVs).   

4. The Boundary Membership ValueBoundary Membership Value (BMV) describes the status of candidate 
BEs. For crisp boundaries, locations are either a member of the boundary 
set (BMV = 1), or not (BMV = 0). Fuzzy wombled boundaries can have 
values of 0 or 1, or any value in between. For fuzzy boundaries, any 
location with a value above 0 is considered a BE. See also:See also: Crisp vs. fuzzy 
wombled boundaries. 

5. A subboundarysubboundary is a group of connected boundary elements; one or several 
subboundaries may comprise an entire boundary. 
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About areal boundariesAbout areal boundaries  

Areal boundaries are polygons enclosing homogeneous areas. BoundarySeer 
defines areal boundaries through spatially constrained clustering. In this process, 
BoundarySeer delineates the target number of clusters set by the user. As the 
central problem in clustering is how many clusters to specify, you may wish to 
perform a goodness of fit analysis to optimize the target cluster number. 

The clustering process creates two new data sets: a clusters data set and descriptive 
statistics. The clusters data set has the same spatial coordinates but all other data 
are replaced by cluster assignments. The descriptive statistics summarize 
information about each cluster (number of elements, averages for each variable 
within the cluster). Boundaries are created around the clusters. 

The map shows the new clusters data set and the areal boundary, the edges of the 
clusters. Viewing a table of the boundary brings up a list of the polygons and which 
cluster they describe. Most of the important information about clustering is 
contained in the cluster data set and the descriptive statistics. 

See also:  See also:  Interpreting clustering output 



 91 

AboutAbout boundary detection boundary detection  

After data preprocessing, boundary detection is the next step in the exploratory 
analysis of geographic boundaries. The detection and placement of artificial and 
natural boundaries are well described in the cartographic literature (reviewed in 
Coleman 1980, Burrough 1986). BoundarySeer allows you to use a variety of 
methods for finding boundaries of different types (areal or difference, open or 
closed, crisp or fuzzy) from spatial data sets comprising one or more variables. 
These are: 

1. Wombling 
a. Raster wombling 
b. Irregular (point) wombling 
c. Categorical wombling 
d. Polygon wombling 
e. Wombling with location uncertainty 

2. Spatially constrained clustering 
3. Fuzzy classification 

Wombling methods are designed to locate difference boundaries; they require 
some estimate of the amount of change in the variables over space. The second 
method, spatially constrained clustering, detects areal boundaries by locating areas 
of relative homogeneity and then drawing boundaries between adjacent areas. The 
third approach, fuzzy classification, is fairly new to the field of spatial analysis. 
Technically, fuzzy classification is not a boundary detection method. Boundaries 
can be delineated, however, from fuzzy classes through other methods, such as 
wombling. 

HintHint:  You may wish to use the Boundary Detection AdvisorBoundary Detection Advisor to choose the 
appropriate method or the Boundary Detection WizardBoundary Detection Wizard to choose a method and 
detect a boundary. 
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Boundary Detection Advisor DiagramBoundary Detection Advisor Diagram  

This advisor is available within BoundarySeer.  It allows you to answer a series of 
questions  to find a method.  Below is a schematic of the Boundary Detection 
Advisor that you may use to find the appropriate method.  Start at the top with 
Question 1. After the question, follow the table down from your choice (i.e. if you 
choose areal boundaries, start with question (2) under areal boundaries rather than 
going to the beginning of the row).   

 

(1) What type of boundary would you like to detect? 
Difference boundariesDifference boundaries 
 

Areal boundariesAreal boundaries 
 

(2) What data would you like to use to detect 
boundaries? 

(2) What data would you 
like to use to detect 
boundaries? 

Original data.Original data.  Classified data.Classified data. 
Classification groups your 
data, allowing you to 
reduce the dimensionality 
of a complex data set  

Original Original 
ddata.ata.  

Classified Classified 
data. data.   

(3) Would you like to 
account for location 
uncertainty during 
boundary detection? 

(3) Would you like to 
account for location 
uncertainty during 
boundary detection? 

Method: 
constrained constrained 
clustering clustering 
on original on original 
data. data.  

Method: 
constraineconstrained d 
clustering clustering 
on on 
classified classified 
data.data. 

No Yes No Yes 
Method: 
Wombling Wombling 
on on 
classified classified 
data, no data, no 
location location 
uncertainty. uncertainty.  

Method: 
Wombling Wombling 
on on 
clclassified assified 
data, with data, with 
location location 
uncertainty.uncertainty.  

Method: 
Wombling Wombling 
on original on original 
data, no data, no 
location location 
uncertainty.uncertainty. 

Method: 
Wombling Wombling 
on original on original 
data, with data, with 
location location 
uncertainty.uncertainty. 

You may also use CE or 
CI if fuzzy classes find 
areas that do not fit nicely 
into a class. 
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Boundary Detection WizardBoundary Detection Wizard  

You may use the Boundary Detection Wizard to choose and to perform a 
boundary detection method.  It presents a series of dialogs to guide you through 
the process.   

The StepsThe Steps  

1. Import the data for boundary detection. 

2. Choose "Detect Boundaries" from the "Data" menu and then choose 
"Wizard." 

3. Follow the directions on each screen to choose the method, settings, and 
to perform the detection. 

4. To interpret the results, see sections on individual methods, such as 
interpreting wombling maps and tables, spatially constrained clustering, 
location uncertainty, and boundaries on fuzzy classes. 
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CCHAPTER HAPTER 66——SSPATIALPATIALLY CONSTRAINED CLUSTLY CONSTRAINED CLUSTERINGERING  

Spatially constrained clustering identifies homogeneous areas and then draws 
boundaries along their edges.  It delineates closed, areal boundaries.  
BoundarySeer assigns locations to clusters based on the relative similarity of the 
values of variables for each location. The clustering is spatially constrained in that 
two locations can be assigned to the same cluster only if they are adjacent in 
geographic space. The result is a partition of the data into relatively homogeneous 
clusters.   

This chapter describes spatially constrained clustering methods in BoundarySeer, 
how to conduct a clustering analysis, and how to interpret clustering boundaries, 
data sets, maps, and tables.   

About spatially constrained clustering ................................................... 95 

Constrained agglomerative clustering ........................................................... 95 
Refining clusters using K-means clustering ................................................... 95 
Applications of spatially constrained clustering ............................................. 95 

Choosing cluster number...................................................................... 96 

How to assess goodness of fit ....................................................................... 96 

How to find boundaries using clustering................................................ 98 

Interpreting clustering output...............................................................100 

Understanding the maps of cluster output................................................... 100 
Understanding the tables of cluster output .................................................. 100 

Clustering methods: centroid versus linkage .........................................101 

Setting the connectedness parameter for linkage clustering:.......................... 101 

Subsampling during linkage clustering .................................................102 

Merging clusters..................................................................................103 

To merge two clusters: .............................................................................. 103 

Removing clusters...............................................................................104 

How to remove clusters............................................................................. 104 
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About spatially constrained clusteringAbout spatially constrained clustering  

Spatially constrained clustering delineates closed areal boundaries around the 
edges of homogeneous regions (see Figure 1.1).  

BoundarySeer implements an adaptation of multivariate clustering that groups 
locations that are both similar and spatially adjacent. Adjacency is determined by 
whether locations share an edge (for raster and polygon data) or by Delaunay 
triangulation (for point data in vector format). Similarity is determined by the 
selection of an appropriate dissimilarity metric. 

Constrained agglomerativConstrained agglomerative clusteringe clustering  

Based on the adjacency and similarity values, clusters are generated using the 
chosen algorithm (here either centroid or linkage clustering), but formation is 
constrained so that clusters form contiguous areas. With agglomerative clustering, 
each location begins as its own cluster, and then an iterative procedure 
'agglomerates' the clusters. At each step, the most similar of all spatially adjacent 
clusters are merged, and coalescing continues until the stopping criterion is met. In 
BoundarySeer, the stopping criterion is a user-defined number of clusters. Finally, 
borders of the clusters are drawn as crisp, closed boundaries. 

Refining clusters using KRefining clusters using K--means clusteringmeans clustering  

Clusters created with agglomerative techniques can be refined through k-means 
clustering. With k-means clustering, cluster membership is refined through shifting 
individual locations into spatially adjacent clusters in order to minimize the 
within-cluster sum of squares error. Finally, borders of the clusters are drawn as 
boundaries. Areal boundaries defined in this fashion are crisp and closed. 

Applications of spatially constrained clusteringApplications of spatially constrained clustering  

Applications include the identification of boundaries between tree community 
types (Legendre and Fortin 1989, Fortin and Drapeau 1995), and soil zone 
classification to determine agricultural land suitability (Burrough 1989), among 
others.  
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Choosing cluster numberChoosing cluster number  

In spatially constrained clustering, BoundarySeer agglomerates clusters until it 
reaches the target cluster number set by the user. It proceeds to this target cluster 
number without evaluating whether fewer or more clusters would improve the 
model. To assess the implications of cluster number, use the goodness-of-fit option 
on the constrained clustering dialog. 

BoundarySeer evaluates goodness of fit for clustering through an index contrasting 
the variability between clusters to that within clusters, using Sum of Squares Error 
(SSE) terms. 

Goodness of fit index = [B/(kGoodness of fit index = [B/(k--1)] / [W/(n1)] / [W/(n--k)]k)] (Gordon 1999) 
Where B is the between-cluster SSE, W is the within-cluster SSE, k is the number 
of clusters, and n is the number of objects (e.g. points) in the model. To maximize 
the goodness of fit, choose the highest value of the index, where the differences 
between clusters are greater than those within. 

How to assess goodness of fitHow to assess goodness of fit  

1. Begin constrained clustering by clicking on "Detect Boundary" in the 
"Data" menu. 

2. Choose the data set to assess goodness-of-fit from the pull-down list of 
open data sets. 

3. Check the box for "Measure goodness-of-fit for multiple 
partitions" to assess goodness of fit for a range of cluster numbers. 

4. The "New cluster data name:" and the "New boundary name" 
boxes will be grayed out, as this method does not create new data or 
boundaries. Instead, it produces a scatterplot of goodness-of-fit values for 
the range of cluster numbers. 

5. Provide the range of cluster numbers to evaluate. The "Minimum 
number of clusters" has to be greater than 1, and the "Maximum 
number of clusters" cannot be higher than the number of features (e.g. 
points) in the data set. 

6. Choose the variable(s) for clustering. You can assess clustering using all 
variables, a single variable, or a user defined variable set. 

7. Click on the "Advanced" tab of the clustering dialog to choose the 
dissimilarity metric. 

8. The rest of the "Advanced" tab will be grayed out, as it is not appropriate 
to goodness-of-fit calculations. 

9. Hit OK to perform the analysis. BoundarySeer will calculate goodness of 
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fit at each cluster number and then produce a scatterplot of goodness-of-fit 
over the range of cluster numbers. Choose cluster numbers for the target 
that maximize goodness-of-fit. 
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How to find boundaries using clusteringHow to find boundaries using clustering  

Prior to clustering, you need to import a vector or raster data set. For point data, 
you should check the spatial network and edit it if necessary. If you want to do 
clustering on classified data, create fuzzy classes from the original data set. Now 
you are ready to delineate clusters: 

1. In the BoundarySeer window, go to the "Boundary" menu and choose 
"Detect Boundary," and then "Constrained Clustering." 

2. The constrained clustering dialog consists of two tabs, "General" and 
"Advanced" settings. 

3. "General" tab 
a. Select the data set that you wish to analyze, and select a name for the 

output boundary file. 
b. In the box marked "Number of clusters", enter an integer value for 

how many clusters you want the program to identify. You may wish 
to first perform a goodness of fit analysis to find the optimal cluster 
number for the data set. As the target cluster number sets the 
outcome, the choice is influential. 

c. Choose which variables to analyze from the data set. The default is to 
use all variables and to give them all equal weights. If you want to use 
only one variable, you can fill in the dot next to "Variable" (rather 
than "Variable set") and select it. You may also select a subset of 
the variables and/or weight them. 

d. If you have more than one variable in your data set, you will have the 
option to standardize your data. If you plan to use the Steinhaus 
metric, you should not standardize. 

4. "Advanced" tab 
a. Choose a dissimilarity metric from the pull-down list. For categorical 

data, the mismatch metric is the only option. 
b. Next, choose a method for agglomerative clustering. 

i If you choose linkage clustering, choose which linkage method to 
use through setting the connectedness parameter. Connectedness 
values can range between 0 and 1, but they cannot equal 0 or 1. 

ii If you are doing linkage clustering with a large number of 
locations (e.g., a large raster data set) and want to subsample your 
clusters, enter your subsampling criteria. 

c. If you want to "cluster with k-means refinement," check the 
appropriate box. 

5. Click "OK" at the bottom of the dialog. If you checked the standardization 
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box, the standardization dialog box will appear. Here you should choose a 
standardization method, and decide where to store the modified data set. 

6. BoundarySeer will ask if you wish to display the boundaries in the map. 
You can show the boundary in an existing map or create a new one. You 
can also view and manipulate the results as a table. 
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Interpreting clustering outputInterpreting clustering output  

When you use spatially constrained clustering to delineate areal boundaries, 
BoundarySeer produces a new data set of cluster assignments. The cluster data set 
is essentially a categorical data set, where the categories are clusters, with the same 
spatial locations as the original set. BoundarySeer also creates descriptive statistics 
about the clusters, and boundaries around them. 

Understanding the maps of cluster outputUnderstanding the maps of cluster output  

Constrained clustering produces two new map layers: a Clusters data layer and a 
Boundary layer. The data layer displays the clusters data—the set with the same 
spatial locations but all other data replaced by cluster assignments. Querying this 
layer gives the cluster assignment as well as the spatial coordinates. The Boundary 
layer shows the cluster boundaries in green. Cluster boundaries are polygons, 
regardless of the source data type. 

Hint: Hint: You may wish to compare boundaries generated with different settings in the 
same map using different color schemes. You can color the boundaries with 
different colors. Turn off the other map layers and play with the layer order (see 
map layers for details). Then, boundaries that differ will be easy to see. 

Understanding the tables of cluster outputUnderstanding the tables of cluster output  

The constrained clustering method produces two types of cluster data tables—one 
of just the spatial locations and their cluster assignments (type "Data"), and a 
second that provides information by cluster on the values of the data from 
locations within each cluster (type "Cluster Statistics"). The descriptive 
statistics file contains information on each cluster, such as the number of elements 
in each cluster and the cluster's mean and variance for each variable. 

Data are generally standardized prior to clustering. If you chose to standardize the 
data prior to clustering, the Clusters data set will display the standardized data. If 
you wish to review the standardization method, consult the project log. 

To view these tables, go to the "Project menu" and choose "Table." Scroll down 
until you see the tables you require. Alternatively, right-click on the Clusters file 
in the Data tab of the Project Window. Choose "View Table" and then choose 
to view either "Data" or "Descriptive Statistics." 

See also:  See also:  Merging clusters, Removing clusters 
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Clustering methods: centroid versus linkageClustering methods: centroid versus linkage  

BoundarySeer includes two different methods for conducting spatially 
agglomerative clustering. 

With the centroidcentroid method, the similarity between clusters is assessed through 
comparing average values for the clusters. That is, variables for all locations 
already in the cluster are averaged. A dissimilarity value is calculated for each of 
these "centroid" calculations, and the two clusters with the lowest dissimilarity 
values (i.e., the most similar) are merged in that iteration of the agglomerative 
clustering. 

In linkage linkage clustering, each location within a cluster is compared to each member of 
every other adjacent cluster. The choice of which clusters to merge can be made in 
many different ways. For example, you may choose single linkagesingle linkage clustering--
agglomeration based on the minimum distance (minimum dissimilarity) calculated 
between any two units within two clusters. You may choose complete linkage complete linkage 
clustering--basing the assessment of dissimilarity on the largest dissimilarity 
between 2 units in two clusters. Single linkage and complete linkage are the classic 
clustering options. Since the advent of faster computers, flexible linkage methods 
are now possible. Flexible linkageFlexible linkage allows any choice in between the extremes, with 
a default of using the median dissimilarity (connectedness = 0.5) for comparison. 

Setting the connectedness parameter for linkage clustering:Setting the connectedness parameter for linkage clustering:   

The connectedness parameter sets the linkage method used in spatially constrained 
clustering. Connectedness can be between but not include 0 and 1. BoundarySeer 
calculates the dissimilarity metric for all the locations in each of the two compared 
clusters and then sorts the list for each cluster. The connectedness parameter tells 
BoundarySeer where on the list of dissimilarity metrics to compare values.  
 
Connectedness valueConnectedness value  Dissimilarity rankDissimilarity rank  Linkage methodLinkage method  
close to zero low single linkage 
mid-range mid-range, includes the 

median (0.5) 
flexible linkage 

close to 1 high complete linkage 
 

See Also: See Also: Choosing cluster number, Subsampling during linkage clustering 
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Subsampling during linkage clusteringSubsampling during linkage clustering  

This option allows you to speed up the clustering process during linkage clustering 
by reducing the number of calculations that the program performs when 
determining which clusters to merge. Recall that in linkage clustering dissimilarity 
values are calculated for each possible pair of members in the two sets of cluster 
elements being evaluated. This process can be time consuming, especially for raster 
data sets. 

In the "Advanced" page of the Constrained Clustering dialog, you have the 
opportunity to enter values that will define the subsampling process. Define what 
fraction of the locations to sample and the minimum number of samples (i.e., this 
overrides the fraction chosen if taking a fraction leaves too small a sample). 
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Merging clustersMerging clusters  

The "Merge clusters" option allows you to merge two clusters into a single 
cluster, and then recalculate and draw the new cluster boundaries. If the two 
clusters are not adjacent, the boundaries will not be merged, but the clusters will 
appear the same (i.e., have the same color) on maps, will be assigned the same 
cluster number, and will be treated together in cluster statistics. 

To merge two clusters:To merge two clusters:  

1. First, you must have generated clusters. 

2. Then, go to the "Data" menu, choose "Merge clusters." 
3. Identify the clusters you want to combine. You may wish to group clusters 

with similar values. To view the cluster statistics, go to the "Project" 
Menu, then choose "Table." Choose to view the "Cluster Statistics" 
for the data set. In this data set, the means and variances of all the 
variables are listed so that you can identify clusters with similar values. In 
addition, the number of elements in each cluster is listed, so you can 
identify "singleton" clusters that you may want to try to merge with other 
clusters. For more information on how to manipulate data in tables see 
Working with tables. 

4. Once you have chosen the clusters to combine, enter their cluster numbers 
on the pull-down list in the dialog. 

5. Select how you want to record the new clusters. After "Store revised 
clusters in" you have two choices: to overwrite the old clusters and 
boundaries by storing the new clusters in the "Existing data set and 
boundary" or to keep both files and create a "New data set" and "New 
boundaries." You can name the data set and boundaries or keep the 
default names BoundarySeer chooses. 

6. You can repeat this process to winnow the clusters to the desired number. 
 

See also: See also: Removing clusters 
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Removing clustersRemoving clusters  

BoundarySeer allows you to remove clusters that were found during spatially 
constrained clustering, either by specifying a particular cluster to remove, or by 
setting a minimum cluster size. For example, you may wish to remove all 
singleton clusters if you are only interested in clusters spanning a larger area. Or, 
you may wish to create a data set that consists only of clusters of a particular type 
(i.e. removing the others); this may be appropriate, for example, as you refine your 
thinking during boundary overlap analysis or if you wish to customize a map. 

How to remove clustersHow to remove clusters  

1. First, you must have created clusters. 

2. Then, go to the "Data" menu, choose "Remove clusters." 
3. You may remove clusters by number or you may remove all clusters 

below a threshold size. 
a. To remove clusters by number, use the pull-down list of available 

clusters. To choose the cluster to remove, you may wish to query the 
map to find cluster numbers or view the clustering statistics in a table. 
To view the cluster statistics, go to the "Project" Menu, then choose 
"Table." The data set that you want to view will be listed as type 
"Cluster". 

b. You can also remove clusters below a threshold number of members, 
the default is 2 members, which removes singleton clusters. 

4. Select how you want to record the new clusters. After "Store revised 
clusters in" you have two choices: to overwrite the old clusters and 
boundaries by storing the new clusters in the "Existing data set and 
boundary" or to keep both data sets and create a "New data set" and 
"New boundaries." You can name the data set and boundaries or keep 
the default names BoundarySeer chooses. 

 
See also:  See also:  Merging clusters 
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CCHAPTER HAPTER 77——WWOMBLINGOMBLING  

Wombling methods delineate difference boundaries for many types of data.  
Womble (1951) quantified the spatial rate of change for numeric raster data by 
estimating surface gradients.  Other researchers have developed techniques to 
apply Womble’s methods to other data types, such as point data, polygon data, 
and categorical data of all formats.  Wombling can be used to create either crisp or 
fuzzy difference boundaries.    

This chapter describes wombling methods in BoundarySeer, how to delineate 
difference boundaries using wombling, and how to interpret wombled boundaries, 
maps, and tables. 
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About womblingAbout wombling  

Methods for delineating difference boundaries are called wombling techniques, 
after Womble (1951). Womble quantified the spatial rate of change by estimating 
surface gradients in a raster structure. Differences among wombling methods are 
mostly related to data format (vector, raster, or transect), data type (numeric or 
categorical), and boundary type (crisp or fuzzy). 

Boundary Likelihood Values (BLVs) measure the spatial rate of change. Locations 
where variable values change rapidly are more likely to be part of a boundary; 
these locations have higher BLVs. For numeric data in point or raster format, 
BoundarySeer calculates BLVs from gradient magnitudes for the suite of variables. 
BoundarySeer uses dissimilarity metrics for categorical and polygon data. 

Location of Boundary Likelihood Values, and determination of Boundary Location of Boundary Likelihood Values, and determination of Boundary 
ElementsElements  

The locations that have the highest BLV values are Boundary Elements (BEs), 
considered part of the boundary. The location of candidate BEs depends on the 
specific boundary delineation technique employed (see figure 7.1). 

Candidate BEs become part of the boundary when their BLVs exceed established 
thresholds. In crisp wombling, those BLVs with values above the threshold are 
assigned a Boundary Membership Value (BMV) of 1 (non-BEs have BMV = 0). In 
fuzzy wombling, BMVs can range between 0 and 1 and indicate partial 
membership in the boundary. Determining BMVs for fuzzy boundaries is 
described in Crisp vs. fuzzy wombled boundaries. 

Crisp difference boundaries: Connecting BEs to form subboundariesCrisp difference boundaries: Connecting BEs to form subboundaries   

The next step in delineating crisp difference boundaries is to connect BEs to create 
subboundaries. BoundarySeer evaluates subboundaries between pairs of BEs using 
a few decision rules. First, for all wombling methods, BEs are connected only if 
they are adjacent. With irregular (point) and raster wombling, connection is based 
on the gradient angle of two adjacent BEs (see subboundaries). 

Fuzzy boundaries are not connected to form subboundaries, so determination of 
the Boundary Membership Value for each BLV location is the end of the fuzzy 
wombling process. 
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Figure 7.1.  Sample locations (dots) and the locations of candidate boundary 
elements (cBEs) for different wombling methods. 
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Raster womblingRaster wombling  

Also called lattice wombling, raster wombling operates on numeric raster (i.e., 
lattice or gridded) data.   Boundaries are determined through applying Boundary 
Likelihood Value (BLV) thresholds and subboundary connections are made 
through gradient angle thresholds. 

BLV CalculationBLV Calculation  

In raster wombling, the BLVs are calculated from a 2x2 kernel. Kernel functions 
are like roving windows that expose pixels of a raster. This method assumes that 
pixel size is the same in the X and Y directions. Each set of four locations {A, B, 
C, D} form a unit square (see figure 7.1). 

Coordinates are transformed so that A is at an artificial origin. A surface is fitted to 
the square (equation 11 below). The gradient for the surface is estimated for each 
BE (point q in equation 22, where ii and jj are unit vectors in the x and y directions). 
Then, the gradient magnitude for each variable is estimated ("m" in equation 33). 
BoundarySeer averages each variable's gradient magnitude for the BLV. 
BoundarySeer also calculates the gradient angle for use in constructing 
subboundaries (equation 44). 
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Examples of raster wombExamples of raster womblingling  

Barbujani et al. (1990) used lattice wombling on eight unlinked polymorphic red 
blood cell markers to identify genetic boundaries in Eurasian human populations. 
The boundaries were explained by different processes restricting gene flow; some 
boundaries corresponded to physical barriers such as mountains, while others 
overlay linguistic barriers between cultures that restrict exogamy. Bocquet-Appel 
and Bacro (1994) applied the multivariate approach to simulated surfaces 
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describing correlated and uncorrelated variables corresponding to genetic, 
morphometric and physiologic characteristics, and found that it correctly detected 
the locations of simulated transition zones. Fortin (1997) delineated boundaries 
with this approach for three data sets, tree and shrub density, percent coverage, 
and species presence-absence, all of which are related to specific vegetation zones. 

Irregular (point) womblingIrregular (point) wombling  

For point data that are numeric but not regularly spaced like raster data, 
BoundarySeer uses a method called irregular wombling (also called triangulation 
wombling in the literature). In this method, the points are first triangulated using a 
nearest-neighbor network (BoundarySeer uses the Delaunay triangulation), and 
then surface gradients are estimated at the center of triangles (see figure 7.1) 

Using the Delaunay triangles as an approximate surface, a plane is fitted to the 
values of each variable at the vertices of each triangle (equation below). The 
gradient magnitude and angle are estimated at the triangle's centroid using the 
same method as with raster wombling (see equations 2-4 on that page). Boundaries 
are determined through applying BLV thresholds and subboundary connections 
are made through gradient angle thresholds. 
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Applications of irregular (point) womblingApplications of irregular (point) wombling  

Applications include the use of irregular wombling to detect ecotones in forests 
(Fortin 1994) and the edges of distinct soil zones. Fortin and Drapeau (1995) 
found that it correctly detects boundaries in both simulated and real environmental 
data. 
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Categorical wombCategorical womblingling  

Surface gradients cannot be defined for categorical data, so wombling procedures 
developed for numeric data do not apply. For this situation, Oden et al. (1993) 
developed categorical wombling. 

MethodMethod  

Categorical wombling uses dissimilarity metrics for Boundary Likelihood Values 
(BLVs), calculated between pairs of adjacent sampling locations. The dissimilarity 
values are used to evaluate candidate Boundary Elements (cBEs). For categorical 
wombling on raster and point data, candidate Boundary Elements (cBEs) are the 
lines equidistant from the sample locations (see figure 7.1). For categorical polygon 
data, the cBEs are the edges of the original polygons (see polygon wombling). 
cBEs only become boundaries when the BLVs are above the user threshold. 
BoundarySeer connects Boundary Elements (BEs) into subboundaries if they are 
adjacent. 

Categorical dissimilarity metrics include taxonomic, genetic and mismatch 
distances (Johnson and Wichern 1982), and in practice are selected to reflect the 
nature of the variables in the analysis. BoundarySeer currently includes only 
mismatch distance, but future versions will include other metrics, as well as an 
editor that will allow users to input their own custom metrics. 

Fuzzy categorical womblingFuzzy categorical wombling  

Fuzzy categorical wombling is meaningful only on data sets with more than one 
variable.  Mismatch values for individual variables are binary (two values are the 
same or they are mismatched).  Therefore, even if you specify a fuzzy boundary, 
the BLVs will be either 0 or 1 for univariate data sets.  Thus, you will not detect 
any intermediate BLVs, and intermediate values are necessary for a gradation in 
boundary membership.  For multivariate data sets, BLVs will be the average of 
mismatch values for each individual variable, so a range of BLVs (and therefore 
fuzzy BMVs) is more possible.   

ExamplesExamples  

Barbujani et al. (1990) supplemented their findings from lattice (here called raster) 
wombling by applying a form of categorical wombling to their Eurasian genetic 
data. They calculated the genetic distance between samples, and then scaled this 
distance by the geographic distance between the locations. Oden et al. (1993) used 
a mismatch metric and multivariate linguistic data to quantify language boundaries 
in Europe. These boundaries identified contact zones between areas where 
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different languages were spoken, and confirmed the large-scale dialectical 
groupings generally accepted by linguists. Fortin and Drapeau (1995) used a metric 
defined as 1 minus the match coefficient (Legendre and Legendre 1983) and tree 
presence/absence data to identify boundaries in species turnover in a Quebec 
hardwood forest. 

Polygon womblingPolygon wombling  

In polygon wombling, the spatial unit is a polygon, rather than a point or a raster. 
Polygon wombling is similar to categorical wombling, in that dissimilarity metrics, 

rather than surface gradient magnitudes, 
are used to quantify Boundary 
Likelihood Values (BLVs). A 
dissimilarity value is calculated for each 
pair of adjacent polygons, adjacency is 
defined as sharing a border. Candidate 
Boundary Elements are the lines that 
separate the compared polygons, even 
for complex shared borders (see figure 
7.2 below). 

In polygon wombling, the variables have 
uniform values across the surface of the 
polygon. If the location of the polygon 
boundaries is uncertain, or you feel the 
values of the variables are not uniform 
over the polygon's surface, you might 
consider performing a wombling analysis 
with location uncertainty (See What is 
location uncertainty? for more 
information). 

 

 

Figure 7.2.  The location of 
candidate boundary elements 
(cBEs) for polygon wombling.  The 
cBE for the two gray polygons is 
outlined in black.  The cBE between 
the light gray and the white polygon 
is outlined in dark gray. 
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Crisp vs. fuzzy wombled boundariesCrisp vs. fuzzy wombled boundaries  

Boundaries may be precise or imprecise. BoundarySeer allows you to choose how 
you represent the boundaries in your data set by offering both precise (crisp) and 
imprecise (fuzzy) boundary options when you use the various wombling 
techniques. Crisp boundaries can be thought of as distinct zones of change - they 
are often represented by distinct lines that separate various regions of the data. 
Fuzzy boundaries are represented as broader regions of change, with some areas 
appearing more important in determining the boundary than others (see figure 7.3 
below). 

How boundary How boundary 
elements are elements are 
determineddetermined  

For crisp boundaries, the 
Boundary Elements are 
determined by finding 
which locations have 
Boundary Likelihood 
Values (BLVs) above 
some pre-set threshold, 
such as the top 30%. 
Those BLV locations with 
values above the threshold 
are assigned a Boundary 
Membership Value (BMV) 
of "1", and appear as 

boundary elements in boundary data sets. Those BLV locations that fall below the 
threshold are assigned a BMV of "0", and are not an element of the boundary data 
set (see figure below - the value "mt" is the user-set threshold). 

Fuzzy boundaries are determined by a slightly different process. BoundarySeer sets 
a range of BMVs using BLV thresholds for the boundary (mm tt) and boundary core 
(mmcc; see Figure 7.4). Locations with BLVs below the boundary cutoff are not part 
of the boundary (BMV = 0).  Locations with BLVs above the boundary threshold 
but below the core threshold are part of the fuzzy boundary ( 0 < BMV < 1).  
Locations with BLVs above the core threshold are the core of the boundary (BMV 
= 1). 

Representing boundary locations as setsRepresenting boundary locations as sets  

Crisp boundaries may be represented as an ordinary set by enumeration, written B 

 

 

Figure 7.3 An example of a fuzzy boundary 
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{(x1, y1),...(xNB, yNB)}. The members of the set are the boundary elements, or BEs. 
Here NB is the number of locations in the boundary. The underscore notation 
indicates that B is an ordinary set, in that a given location (xi, yi) is either a 
member of the set or it is not, and membership in the set is said to be certain. Such 
ordinary boundaries can be written either by enumeration or as a function that 
defines a mapping (f) from X,Y to the values 0 or 1 (Zadeh 1965, Leung 1987), 
using a characteristic function f(x,y) that defines the degree of membership of (x,y) 
in B (see equation below). 

{ },1,0)Y,X(:f →  ),y,x(fy,x B→  




∉
∈

=
B)y,x(if,0

B)y,x(if,1
)y,x(fB  

 
Imprecision can cause membership in boundaries to be uncertain, and this 
uncertainty may be represented using fuzzy subsets. A fuzzy boundary (written B, 
no underscore) is a set of ordered pairs [(xi,yi), µB(xi,yi)] where all x,y are elements 
of the universe of discourse X, Y, and µB(xi,yi) is the degree of membership of 
location (x,y) in the fuzzy boundary B. 'Fuzzy' means that µB(xi,yi) lies on the 
interval (0,1). Notice the universe of discourse is the real numbers and is precise. B 
is called a fuzzy boundary because it is membership in B that is fuzzy. 

Crisp boundaries Fuzzy boundaries 
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Figure 7.4.  Determination of Boundary Membership Values (BMVs) from 
Boundary Likelihood Values (BLVs). 
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ThresholdsThresholds  

Delineation of difference boundaries occurs through separation of some spatial 
locations from others. In BoundarySeer, spatial locations are categorized as 
boundary or not (for crisp boundaries) based on Boundary Likelihood Values 
(BLVs). For fuzzy boundaries, boundary membership is not an all or nothing 
thing. 

As described in About wombling, a Boundary Element (BE) is a location with a 
"large" amount of change over space. The cutoff for a "large enough" BLV is 
somewhat arbitrary; most researchers declare locations with values in the upper 
5th or 10th percentile to be BEs in crisp boundary delineation (Barbujani et al. 
1989, Barbujani et al. 1990, Fortin and Drapeau 1995, Jacquez 1995). Within 
BoundarySeer, you can set BLV thresholds two ways, through a priori cutoffs, set 
in the wombling dialog, or using a BLV histogram.  You may also set gradient 
angle thresholds for wombling on numeric raster and point data.   

Numeric thresholdsNumeric thresholds  

With numeric data, the threshold is given as a percentage, which tells 
BoundarySeer the number of BEs to select. For example, if you define the 
threshold as 10%, BoundarySeer selects those candidate BEs (cBEs) possessing the 
highest 10% of BLVs. 

The realized threshold may be slightly different from the stated threshold. 
BoundarySeer uses the percentage threshold to calculate the number of BEs, 
disregarding any fractional part in determining this number. For example, if your 
data set contains 85 cBEs and you select a 10% threshold, BoundarySeer will 
assign 8 locations to the set of BEs (giving a realized threshold of (8/85)x100% = 
9.4%). 

Furthermore, BoundarySeer will not distinguish among locations that have tied 
BLVs. That is, if in the above example the 8th highest BLV is also tied with the 9th 
and 10th highest values, BoundarySeer assigns all three locations to the set of BEs. 
In this case, the realized threshold is ( 10/85 ) x100% = 11.8%. You may find it 
useful to create several sets of BEs using different thresholds for comparison. 

Selecting a threshold from tSelecting a threshold from the distribution of boundary likelihood valueshe distribution of boundary likelihood values  

You may choose a threshold from the distribution of BLVs in the data. This 
method allows less arbitrary cutoffs, as you can place cutoffs in breaks in the 
distribution. For more information, see Defining thresholds using histograms. 
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Problems with using thresholds for boundary detectionProblems with using thresholds for boundary detection  

Using thresholds to identify BEs has been criticized as subjective, in that, for a 
given threshold, a fixed number of BEs are always found, whether or not their 
rates of change are statistically unusual. Jacquez and Maruca (1998) have begun 
work on an alternative. Their approach involves a local and global statistic to 
determine (a) where statistically significant BEs are, and (b) whether the 
boundaries for the entire surface are statistically unusual or easily explained by 
chance. The local statistic, calculated for each pair of adjacent cBEs, is maximized 
when both standardized gradient magnitudes are large, and gradient angles are 
similar and perpendicular to the line connecting their locations. They proposed 
several null hypotheses, including complete spatial randomness and spatial 
autocorrelation without boundaries.  They also began to develop power analyses 
for both crisp and fuzzy boundaries.  These methods will be implemented in future 
versions of BoundarySeer. 

See also:  See also:  Subboundaries:  gradient angle thresholds, Imposing new thresholds 



 117 

SubboundariesSubboundaries  

BoundarySeer connects Boundary Elements (BEs) into subboundaries only if 
connections meet certain criteria. For all types of data, BEs must be adjacent to 
form a subboundary. For numeric raster and point data, gradient angle thresholds 
are used to evaluate connections further. 

Gradient angle thresholdsGradient angle thresholds  

Remember that BoundarySeer uses gradient magnitude, the amount of change 
between samples, for numeric point and raster Boundary Likelihood Values 
(BLVs). Another crucial component is the direction of that change, its angle, theta, 
measured between the gradient vector and the X axis. 

BoundarySeer evaluates two angles:  (1) between the pair of BEs and (2) between 
the gradient angle and the connection. Threshold values for these comparisons can 
be entered in the "Other" tab in the Wombling dialog box. You can access this 
dialog from the "Data" menu, by first clicking on "Detect Boundary," then 
"Wombling." 

Gradient angle 
thresholds are applied 
separately to every 
variable used in detecting 
the boundary.  Then, 
BoundarySeer compares 
the average gradient 
angle to the threshold.  If 
the average is higher than 
the threshold, the two 
BEs being compared will 
not be connected. 

Angles of adjacent Angles of adjacent 
vectorsvectors  

If two gradients have 
equal magnitude but 
opposite directions, they 
do not delineate a 

consistent area. In figure 7.5, the gradient at one BE is increasing towards the top 
of the page, for the other it is increasing towards the bottom. Although these two 
BEs have similar gradient magnitude, the direction of change is opposite. To 
prevent connecting BEs with different directions of change, BoundarySeer 

 

gradient 

BE 
connection 

gradient angle 

 

X axis 

Figure 7.5.  An illustration of the calculation of 
gradient angles (shown in gray). 
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compares the two gradient angles. If the angles for the BEs differ by more than a 
user-set threshold, adjacent BEs are not connected. Figure 7.5 illustrates two 
gradients, one with an angle of 90º, the other with an angle of 270º. Their 
difference is 180º, the maximum possible.  

Angle between vector aAngle between vector and connectionnd connection  

The second gradient angle threshold compares the angle between the gradient and 
the connection. The gradient angle and the connection angle are measured from 
the X axis (see figure 7.6). BoundarySeer calculates the difference between the two 
angles. 

The rationale for calculating this 
difference is to verify the subboundary.  
Difference boundaries separate 
dissimilar areas. Thus, connections 
between BEs should be made across 
rather than along the direction of 
change. 

Imagine topographic contours. The 
contours describe areas of similar 
elevation above sea level. The direction 
of topographic change is perpendicular 
to the contour lines: rain travels down 
the landscape across contour lines. 
Even if the hill rises at a steady incline 
(a uniform magnitude of change or 

BLV), you would not want to draw a topographic boundary up the surface of a 
hill. In connecting points up a hill, the boundary would connect BEs of similar 
gradient magnitude but different elevations. To avoid connecting along a thick 

gradient, 
BoundarySeer 
compares the angles 
of the gradient with 
the connection 
angle. 

If the connection is 
along the gradient 
(as shown in figure 
7.7), then similar 
areas will be on 
either side of the 
boundary. In 

essence, the connection links parts of one thick gradient comprising both BEs.  In 

 gradient angle  

 
connection angle  

Figure 7.6.  An illustration of the 
calculation of connection angles 
(shown in gray). 

 
X axis 

Figure 7.7.  A case where the gradient and the 
connection angles are equal. 
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this case, the two angles are the same and the difference is zero. The default value 
for this threshold is 30º, and this value can be reset in the box labeled "Minimum 
angle between vector and connecting line." 

ChooChoosing angle thresholds for boundary connectionsing angle thresholds for boundary connection  

Default threshold values are set at 90º for the maximum angle between gradient 
vectors and 30º for the minimum angle between the vector and the boundary. To 
examine the influence of these values on your boundaries, you might consider 
testing a range of values and comparing the results. If you would like to set the 
values so that all adjacent BEs will be connected, choose the values 180º 
(maximum angle between adjacent gradient vectors) and 0º (minimum angle 
between vector and connecting line). 

Thresholds from the literatureThresholds from the literature  

Barbujani et al. (1990) connected only those BEs that (1) are adjacent to other BEs 
and (2) have angles that, for each variable, differ by less than 30° from adjacent 
boundary elements. They reasoned that if the angles for two adjacent BEs differ by 
more than 30°, there is a substantial probability that they are not part of the same 
contiguous boundary. 

See also:  See also:  Thresholds, Imposing new thresholds 
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How to find boundaries using womblingHow to find boundaries using wombling  

Prior to wombling, you need to import a vector or raster data set, and for point 
data, check the spatial network and edit the network if necessary.  If you wish to 
womble on classified data, see How to detect boundaries on fuzzy classes (p. 138). 

1. Go to the "Data" menu and choose "Detect Boundary", and then 
"Wombling." Alternatively, choose "Detect Boundaries" from the 
pop-up menu that appears when you right-click a data set in the project 
window. 

2. Proceed through the settings on the three tabs: General, Thresholds, 
and Other. 

3. "General" tab 
a. Select the data set and a name for the new boundary. 
b. Choose your variables. The default is to use all variables equally 

weighted. 
i. If you want to use only one variable, fill in the dot next to 

"Variable" (rather than Variable set) and select your variable. 
ii. If you want to select a subset of variables, or if you want to 

weight the variables, choose the "Edit variable sets" button. 
c. If you would like to standardize the data prior to boundary 

delineation, click on the box at the bottom of the page. (If your data 
includes only one variable, this box will not appear). 

4. "Thresholds" tab.  You may set thresholds by entering a priori cutoff 
values or using the data set itself. 
a. Using a priori cutoffs 

i. Choose to set thresholds using "Information provided 
below." 

ii. First, you need to decide what kind of boundary you want—crisp 
or fuzzy. 

iii. Enter a percent of BLVs to use as boundary elements. 
� For crisp boundaries, choose the BLV threshold (default is 

30%). Then, click on the "Other" tab of the dialog. 
� For fuzzy boundaries, choose threshold values for the overall 

boundary, and for the boundary core (default is 15%). If you 
are using polygon data, click on the "Other" tab of the 
dialog. Otherwise, skip to step 6. 

b. Using the distribution of BLVs (see Defining thresholds using 
histograms) 
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5. "Other" tab 
a. Specify the gradient angle thresholds you would like to use for 

connection. 
b. For polygon data only: Choose a dissimilarity metric from the pull 

down menu. 

6. Click "OK" at the bottom of the dialog. If you checked the data 
standardization box, the next dialog will ask for a standardization 
method. Other sections describe the rationale and methods for 
standardizing data. 

7. Next, a histogram (a BoundarySeer chart) of the BLVs for your data set 
will appear, and a dialog will ask you if you would like to view the 
boundary. You may view the boundary in a new or an existing map. 

If you want to re-draw the boundaries or subboundaries using different 
thresholds, see Imposing New Thresholds.  
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Defining thresholds using histogramsDefining thresholds using histograms  

Within BoundarySeer, you may set wombling thresholds based on a priori cutoffs 
(say the upper 5% or 10% of all Boundary Likelihood Values), or you may choose 
thresholds based on the distribution of BLVs in the data set itself, using a 
histogram. To define thresholds using the histogram of BLVs, follow these steps. 

StepsSteps  

1. Begin detecting a boundary by wombling according to the general 
instructions. (See How to womble) 

2. On the "Thresholds" tab, choose to set thresholds using "a histogram 
of boundary likelihood values." Click "OK." 

3. If you checked the standardize data box on the "General" tab, you will be 
prompted to standardize your data and you may save the standardized 
data set under a new name. 

4. The "define threshold using histogram" dialog will begin, and a 
histogram of the BLVs for your data set will appear. 

5. Choose the type of boundary:  crisp or fuzzy. 
a. For crisp boundary delineation: 

i. Choose the cutoff for Boundary Elements (BEs). BoundarySeer 
will display a histogram of BLVs, with a default cutoff value 
chosen (see illustration for fuzzy example below). The chosen 
value will appear in the dialog box and the value will appear as a 
red line on the histogram. You can accept the cutoff value or 
change it based on viewing the histogram. 

ii. To change the threshold, enter a new BLV cutoff in the white 
box. 

iii. Hit "Apply" at the bottom of the tab to see the new cutoff on the 
histogram. BoundarySeer will display the equivalent percentage 
threshold in the gray box below the BLV threshold. 

iv. Hit the "Gradient Angle Thresholds" button to change the 
default settings. Gradient angle thresholds only apply to numeric 
raster and point data. The button will be grayed out for other data 
types. 

v. Once you are satisfied with the cutoffs, click "OK" to accept 
them. 

b. For fuzzy boundary delineation, you need to choose the value for the 
boundary and the boundary core. The boundary core cutoff appears 
in black, while the boundary cutoff appears in red. 
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i. To change either threshold, enter a new cutoff BLV value. 
ii. Hit "Apply" to view the changes on the histogram, and then 

"OK" to accept them. 
6. A dialog will ask you if you would like to view the boundary. You may 

choose to view the boundary in a new or an existing map. 
 

Next Step: Next Step: Interpreting wombling tables, Interpreting wombling maps 
See also: See also: Subboundaries, Imposing new thresholds 
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Figure 7.8.  A histogram of BLVs (gray bars) for comparison with the boundary 
and boundary core cutoffs for a fuzzy boundary (thick black lines).  For a crisp 
boundary, there would be no boundary core cutoff to display. 
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Imposing new thresholdsImposing new thresholds  

Once you have found boundaries, you can easily re-draw boundaries or 
subboundaries using different thresholds. 

1. First, choose "Impose New Thresholds" from the "Boundary" menu 
or the pop-up menu you get by right-clicking on the boundary of interest 
in the project window. 

2. When the "Impose New Threshold' dialog appears, you can change 
the threshold values and create a new boundary and/or subboundary 
layer. 

3. Choose the boundary you wish to change from the pull-down list of all 
boundaries in the project. 

4. Enter a name for the new boundary, or accept the default name. 
5. As before, choose between crisp and fuzzy boundary types and the new 

thresholds. 
6. As before, you can choose to see the histogram of BLVs, but this will be 

the same as it was when the original histogram was generated during the 
delineation of the original boundary. 

7. Click "OK", and a dialog will ask if you would like to view the new 
boundary in a map. Choose the map from the pull-down menu. You may 
select "New Map" to create an additional one. 

 
Hint: Hint: You may wish to compare boundaries in the same map using different color 
schemes. As the map layers obscure those layers beneath them, you will want to 
place the layer holding the most restrictive boundary (e.g., highest BE thresholds, 
most stringent gradient angle thresholds) on top. Then, the additional points and 
connections that occur with the less-strict rules will be easy to see. 

You can change map layer order by dragging layers around in the map layer pane. 
You can change the properties of individual map layers by selecting them in the 
map layer pane, right clicking on the map, and choosing "Properties." 

Next Steps: Next Steps: Interpreting wombling tables, Interpreting wombling maps 
See also:  See also:  Subboundaries, Thresholds 
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Interpreting wombling tablesInterpreting wombling tables  

You may view and manipulate the boundary table by choosing "Table" from the 
"Project" Menu or from the pop-up menu from the project window Boundary tab. 

For boundaries on vector data, boundary tables list the x and y coordinates of the 
candidate Boundary Elements (cBEs), the Boundary Membership Value for each 
cBE, the Boundary Likelihood Value (BLV) for the combined variables, and then 
the BLV and gradient angle for each individual variable. 

Raster data files are often too large and complex for viewing easily in a table. For 
this reason, we have restricted raster data visualization to maps and map queries. 
Thus, for raster data, you may view tables of the queried coordinates, the cBE 
location ("pixel center"), BMVs, average BLV, and gradient magnitudes and 
gradient angles for individual variables by querying the boundary layer in the map. 

Interpreting wombling maps: polygon dataInterpreting wombling maps: polygon data  

The layer types that appear are listed below; the name of each layer includes its 
boundary name (e.g. "Boundary 1: B.L.V."), though a few types have no suffix 
(e.g. "Boundary 1"). 

You can view, reformat, and query these maps as you would any other map in 
BoundarySeer. 

Map layersMap layers  

1. "Boundary" for crisp boundaries: shows all polygon edges with 
Boundary Membership Values (BMV) = 1. For fuzzy boundaries: shows 
all polygon edges that are in the fuzzy boundary, with color changing to 
reflect different BMVs. 

2. "Boundary: B.L.V.": shows all Boundary Likelihood Values for all 
candidate Boundary Elements (all shared polygon edges). 

 

See also: See also: Imposing new thresholds 
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Interpreting wombling maps: point dataInterpreting wombling maps: point data  

The layer types that appear are listed below; the name of each layer includes its 
boundary name (e.g. "Boundary 1: points"), though a few types have no suffix 
(e.g. "Boundary 1"). As the locations of candidate Boundary Elements vary 
between numeric and categorical point data sets, each type of boundary has some 
specific map layers. 

You can view, reformat, and query these maps as you would any other map in 
BoundarySeer. 

Map layersMap layers  

numeric datanumeric data  

1. "Boundary: points" is a point layer showing the locations of Boundary 
Elements (BEs, locations where Boundary Membership Value (BMV) = 
1). 

2. "Boundary: triangles" is a polygon layer showing the Delaunay 
triangulation.  For crisp boundaries, Delaunay triangles with BMV = 1 
appear in color. For fuzzy boundaries, this layer displays the "core 
boundary" triangles (in black), and the other locations that are in the 
boundary but not in the core (gray). 

3. "Boundary: boundary links" is a line layer showing the subboundary 
connections between centroids of boundary elements. 

categorical datacategorical data  

4. "Boundary" is a line layer showing the BEs.  For categorical data, BMVs 
are determined at the Voronoi edges. When you delineate crisp 
boundaries, the layer shows the edges with BMV = 1 (see categorical 
wombling). If you do fuzzy categorical wombling, the edges that comprise 
boundaries are shown in different colors according to BMV. 

all data typesall data types  

5. "Boundary: B.L.V." is a layer showing the BLVs of all candidate BEs.  
For numeric data, it is a polygon layer similar to "Boundary: triangles" 
but illustrating BLV rather than BMV.  For categorical data, it is a line 
layer. 

 
See also:  See also:  Imposing new thresholds. 
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Interpreting wombling maps: rasteInterpreting wombling maps: raster datar data  

The layer types that appear are listed below; the name of each layer includes its 
boundary name (e.g. "Boundary 1: boundary links"), though a few types have 
no suffix (e.g. "Boundary 1"). As the locations of candidate Boundary Elements 
vary between numeric and categorical rasters, each type of raster has some specific 
map layers. 

You can view, reformat, and query these maps as you would any other map in 
BoundarySeer. 

Map layersMap layers  

numeric datanumeric data  

1. "Boundary" is a raster layer showing Boundary Likelihood Values 
(BLVs) for boundary pixels.  Boundary pixels are centered on the 
candidate Boundary Elements (cBEs).  

•  Alternatively, you may choose to display the Boundary Membership 
Values (BMVs) in this map layer. To do so, select the "Boundary" 
layer, view its properties, and change the variable displayed to 
"B.M.V.s" from "B.L.V.s."  For crisp boundaries, this layer shows all 
of the pixels with BMV = 1. For fuzzy data, this layer shows all pixels 
shaded in a way that reflects the range of BMVs.  

2. "Boundary: boundary links" is a line layer showing the subboundary 
connections for the boundary.  

3. "Boundary: boundary points" is a point layer that shows Boundary 
Elements as points along the edges of the data pixels.  

categorical datacategorical data  

4. "Boundary" is a raster layer showing BLVs for boundary pixels.  
Boundary pixels are centered on the cBEs.   
• Alternatively, you may choose to display the BMVs in this map layer.  

To do so, select the "Boundary" layer, view its properties, and 
change the variable displayed to "B.M.V.s" from "B.L.V.s."  For 
crisp boundaries, this layer shows all of the pixels with BMV = 1. For 
crisp data, BMVs are binary (0 or 1).  A range of BMVs are possible 
for fuzzy boundaries.    

 
See also:  See also:  Imposing new thresholds 
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CCHAPTER HAPTER 88——LLOCATION OCATION UUNCERTAINTYNCERTAINTY  

Accounting for location uncertainty in statistical analyses improves spatial pattern 
detection and interpretation (Jacquez and Jacquez 1999). To this end, 
BoundarySeer can use spatial randomization models to propagate the location 
uncertainty in wombling boundaries. 

This chapter describes wombling with location uncertainty in BoundarySeer, how 
to propagate location uncertainty in boundary detection, and how to interpret 
wombled boundaries and  maps.   

About location uncertainty ..................................................................129 

a problem for boundary detection .............................................................. 129 

About wombling with location uncertainty...........................................130 

Description of the Method......................................................................... 130 

How to womble with location uncertainty............................................132 

Location models .................................................................................133 

Interpreting location uncertainty rasters ...............................................134 
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About location uncertaintyAbout location uncertainty  

Location uncertainty occurs whenever the exact spatial coordinates of the data are 
not known. This lack of information is common, such as when the locations are 
censored for confidentiality reasons, in aggregate data, and in exposure 
assessment. 

In aggregate data, rates or summary values are calculated from individual events. 
In aggregate, the individual data records are abstracted from their original spatial 
locations. Examples of aggregate data include census data, where summary 
information is recorded at the level of individual political units; species abundance 
calculated for forest plots; rates of disease calculated for counties or townships; and 
incidence of certain events recorded by a central location, such as a hospital or 
police station. 

In addition, people move so their spatial location is not a fixed point but instead an 
activity space. Thus, for exposure analysis in particular, but including other types 
of analyses, spatial coordinates such as a person's address may be overly precise. 

a problem for boundary detectiona problem for boundary detection  

A common, although inappropriate approach for dealing with location uncertainty 
is to assign the data to the centroid of a polygon. The polygon may represent the 
census tract, the zip code, or the area sampled. In this method, the polygon's 
centroid, or geographic center, becomes the data's spatial coordinates. Yet, as 
Jacquez and Waller (1998) found, the results of spatial statistical tests differ for raw 
data and aggregate data represented by a centroid. In short, the p-values for cluster 
statistics for raw data and for centroids were very different, with analyses using 
centroid data having decreased statistical power and increased type II error (or the 
likelihood of false negatives). Thus, location uncertainty arising from the use of 
centroid locations can distort the detection and interpretation of true spatial 
pattern. 
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About wombling with location uncertaintyAbout wombling with location uncertainty  

Accounting for location uncertainty in statistical analyses improves spatial pattern 
detection and interpretation (Jacquez and Jacquez 1999). To this end, 
BoundarySeer can use spatial randomization models to propagate the location 
uncertainty in wombling boundaries. This occurs through a process of repeatedly 
randomizing the spatial locations of the data within a user-set location model, 
recalculating the boundaries for each randomization, and then producing a raster 
displaying the relative boundary memberships for individual pixels in the raster. 

DescDescription of the Methodription of the Method  

1. The user specifies the data sets for the analysis: 1) a polygon data set 
or 2) a point data set with an associated polygon data set. For the 
point set, the polygons bound the area within which BoundarySeer 
randomizes the points.  This procedure requires non-overlapping 
polygons.  (If polygons overlap, a point may belong to two or more 
polygons, which invalidates the method.)   

2. BoundarySeer creates a sampling grid or raster that covers the data 
set. The dimensions of the raster can be set in the "Location 
uncertainty" dialog box (# columns in resulting raster). 

3. BoundarySeer randomly chooses a point within the polygon and 
assigns the data to that point. Currently, BoundarySeer chooses from 
a uniform distribution within the polygon. In future versions, 
BoundarySeer will allow more complex location models. 

4. BoundarySeer follows the steps of crisp irregular (point) wombling: 
first drawing the Delaunay triangulation (in red below) between 
nearest neighbor points, then calculating boundary likelihood values 
(BLVs) and boundary membership values (BMVs). The BMVs are 
associated with the triangles (as shown in the "Boundary: 
triangles" layer in point wombling maps). In Figure 8.1 a & b, 
triangles with BMV = 1 are black. 

5. BoundarySeer repeats steps 3 and 4, keeping track of the number of 
times a pixel in the raster includes a boundary triangle (i.e. one with 
BMV = 1). 

6. From a number of iterations of crisp wombling on different 
randomizations of the data locations, BoundarySeer creates a fuzzy 
summary raster (Figure 8.1 c). Essentially, the BMV for each pixel is 
the number of times the pixel was part of a boundary triangle, divided 
by the total number of iterations. Compare the output with two 
sample iterations.  
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Figure 8.1.  The process of wombling with location uncertainty.   

In a & b, the irregular gray lines are polygon boundaries, the black points are 
point locations, and the straight black lines are the spatial network connecting 
the points.     

First, boundaries are calculated for the original point locations (a).  Delaunay 
triangles with BMV = 1 are filled in gray.  Then, the points are moved to 
random locations within the polygon and boundaries are recalculated.  This 
occurs as many times as you specify.  C shows the outcome of the iterations.  

aa  bb  cc  
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How to womble with location uncertaiHow to womble with location uncertaintynty  

If you wish to use classified data, first create fuzzy classes from the original data 
set.   

1. Go to the "Data" menu (found at the top of the application window or by 
right-clicking in the BoundarySeer project window). Choose "Detect 
Boundary" and then "Location Uncertainty."  

2. "General" tab: 
a. Choose the data set from the pull-down list of available data in the 

project. 
b. Select a name for the new boundary, or you can take the default name 

at "Name:" 
c. Choose the number of iterations for the randomization of the location 

of the data (default = 100) and the columns in the resulting raster 
(default = 50). Lowering the number of iterations will decrease the 
calculation time, though it will also decrease the number of 
randomization runs, and therefore the power of the analysis. 

d. You can choose to detect the boundary with all variables, weighting 
variables using a variable set, or with a single variable. 

e. To standardize the data set before analysis, check the box at the 
bottom of the tab. 

3. "Methods" tab: 
a. Choose the location model, which sets how the data will be 

randomized. 
i. If you choose a completely randomized model, click on polygon 

model and then choose the data set that contains the polygons 
within which BoundarySeer will randomize the coordinates.  If 
the data is a set of polygons, that data will already be chosen and 
that box grayed out. 

ii. <not yet available> If you choose a population model, specify the 
file that contains the population information. 

b. Choose the boundary detection method from the pull-down list: either 
crisp or fuzzy wombling. 

c. Choose the thresholds for boundaries. 
i. For crisp or fuzzy wombling, the default is BLVs in the top 30%. 
ii. For fuzzy wombling only, define the proportion of BLVs in the 

boundary core. The default value is 15%. 
4. Hit "OK" to start the analysis. 
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Location modelsLocation models  

Location models can be used to propagate location uncertainty in boundary 
detection (Jacquez and Jacquez 1999). BoundarySeer can randomize the spatial 
location of the data to assess how the location uncertainty affects the boundaries 
and to provide a more accurate analysis. Randomization is a broad term, and it 
includes many different procedures. The nature of the randomization process can 
affect the outcome of the analysis. Thus, choosing how to randomize the data is an 
important step in data preparation and analysis. 

Location models provide the basis for spatial randomization. A location model is a 
probability density function (pdf) probability density function (pdf) that describes the likelihood of each location 
being sampled during randomization. BoundarySeer chooses spatial coordinates 
for a new sample location based on the location model specified. 

The simplest location model is the polygonpolygon model, where all possible locations 
within a specified area have equal probability of being sampled. Population modelsPopulation models 
are more complex, they vary the pdf by population density, with more populous 
areas having higher sampling probability. This makes sense for data that describe 
an incidence rate in areas where people are not uniformly distributed. Currently, 
only the polygon model is available within BoundarySeer. 
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Interpreting location uncertainty rastersInterpreting location uncertainty rasters  

BoundarySeer produces a monochrome raster image of the boundaries accounting 
for location uncertainty (see Figure 8.2). The boundary will appear fuzzy or 
graded, which illustrates the location uncertainty in the data and therefore in the 
resulting boundary. 

You may change the settings on the raster (see 
formatting rasters), but the default settings are that 
dark areas represent raster pixels with higher 
boundary membership values (BMVs). See the 
method description for more detail. The resolution of 
the raster depends on the value entered in the dialog 
box (# of columns in the resulting raster). 

Raster data files are often too large and complex for 
viewing easily in a table. For this reason, we have 
restricted raster data visualization to maps and map 
queries. For location uncertainty rasters, you may 
view a table of the queried coordinates, the row and 
column you've queried from the raster, the 
coordinates of the pixel center, the BMV, BLV, and 
the number of "hits" (times the area was part of a 
boundary triangle).   

Figure 8.2.  A raster 
indicating boundaries 

with location 
uncertainty.
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CCHAPTER HAPTER 99——BBOUNDARIES FOR FUZZY OUNDARIES FOR FUZZY CLASSESCLASSES  

You may wish to detect boundaries on classified data, rather than your original 
data set.  To do this, classify your data (Chapter 4).  Then, you are ready to detect 
boundaries on the classes.   

You can detect boundaries on fuzzy classes with any BoundarySeer method, plus 
two specific to fuzzy classes, classification entropy and confusion index.  

This chapter defines classification entropy and the confusion index, how 
BoundarySeer uses them to define boundaries, and how to interpret maps of 
boundaries on fuzzy classes.   

To use any other method in BoundarySeer, classify your data using the methods in 
Chapter 4 and then follow the directions for the individual methods contained in 
other chapters.   

Detecting boundaries on fuzzy classes..................................................136 

Confusion Index........................................................................................136 

Classification entropy ................................................................................136 

How to detect boundaries on fuzzy classes ...........................................138 

Interpreting fuzzy classification output.................................................139 
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Detecting boundaries on fuzzy classesDetecting boundaries on fuzzy classes  

Fuzzy classification produces a new multivariate data set with the same spatial 
support as the original data set. In this new data set, the locations are associated 
with new variables:  fuzzy membership values for each of the classes. 
BoundarySeer can find boundaries for this new data set in many ways. 

Boundary Membership Values (BMVs) can be derived from (1) wombling on the 
fuzzy classes, (2) wombling with location uncertainty on the classes, (3) spatially 
constrained clustering, (4) the confusion index, or (5) the classification entropy 
index. 

You may find boundaries using wombling, confusion index, and classification 
entropy directly from the fuzzy classification dialog. For location uncertainty and 
spatially constrained clustering, first create fuzzy classes, then perform the 
boundary detection procedure. 

Confusion IndexConfusion Index  

The confusion indexconfusion index is simply the ratio of the second highest class membership 
value to the highest. If the two values are similar, the confusion index returns a 
value close to one, indicating high confusion about class membership. If the two 
values are very different, then the confusion index is closer to zero, indicating less 
confusion about class membership. 

BoundarySeer uses the confusion index as a Boundary Likelihood Value (BLV). 
BoundarySeer calculates the confusion index for each spatial location, then all the 
confusion indices for the data set are used to create BMVs. The confusion index 
values are scaled to between 0-1, with the lowest confusion index set to 0 and the 
highest to 1.0. Locations with high confusion index are most transitional between 
classes and therefore, most boundary-like. 

Classification entropyClassification entropy  

Classification entropyClassification entropy at location i, h(i), is (from Brown 1998): 
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where k is the number of classes, and m ic is the fuzzy membership value for 
location i in class c. Entropy results parallel those of the confusion index, with 
entropy values close to one when membership is spread among the classes, and 
closer to zero when membership is primarily in one class. 

BoundarySeer uses entropy as a BLV. BoundarySeer calculates the entropy for 
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each spatial location, then it scales all entropy values for the entire data set to 
make BMVs. Entropy values are scaled to between 0-1, with the lowest value set to 
0 and the highest to 1.0. Locations with high classification entropy are most 
transitional between classes and therefore, most boundary-like. 

See also:  See also:  About fuzzy classification, The fuzzy classification process 
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How tHow to detect boundaries on fuzzy classeso detect boundaries on fuzzy classes  

Go to "Detect Boundary" on the "Data" menu, or right click on the data set 
you wish to analyze in the project window and choose "Detect Boundary." 
Select "Fuzzy classification." 

The fuzzy classification dialog consists of four tabs, "General," "Method," 
"Thresholds," and "Other." "Thresholds" and "Other" only apply to 
Wombling on fuzzy class boundaries. 

1. "General" tab 
a. Select the data set to classify from the pull down list of all data 

imported into the project. 
b. BoundarySeer will produce a new data set of the spatial locations with 

their fuzzy class memberships. You can name the data set or accept 
the default, note that the default name contains the word "Class". 

c. Type in a name for the new boundary, or accept the default. 
d. Select the number of classes (k). 
e. Select whether to perform the analysis on one variable, the entire data 

set, or another variable set. 
f. The default is to standardize the variables before analysis. Unselect 

this option if you decide not to standardize. 
2. "Method" tab 

a. Select a fuzziness exponent (phi or ϕ). 

b. Select a stopping criterion (epsilon or ε). 
c. Choose how to calculate the fuzzy boundary membership values. 

i. Wombling 
ii. Classification entropy (CE) 
iii. Confusion index (CI) 

d. If you chose CE or CI, the other two tabs disappear and you are done 
with the Fuzzy Classification dialog. 
i. If you chose to standardize your data, the standardization dialog 

will appear. 
ii. Then, BoundarySeer will ask you if you wish to display the 

boundary in a map. Select the map from the pull down list. 
iii. If you choose to display the boundary, BoundarySeer will add 

two new layers to the map, the data set containing the class 
membership, and a boundary layer depicting the BMVs and 
BLVs. 
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e. If you chose Wombling, you will need to complete the next two tabs, 
which parallel those on regular Wombling dialogs. Proceed to the 
wombling explanation, step 4. 

See also: See also: About fuzzy classification, Data sets created in BoundarySeer 

Interpreting fuzzy classification outputInterpreting fuzzy classification output  

The interpretation of fuzzy classification output varies with the method used. 
Interpreting fuzzy classification wombling output is similar to interpreting 
wombling tables and maps for any other data set. 

Confusion indexConfusion index (CI) and classification entropyclassification entropy (CE) output are similar to each 
other. Remember that the confusion index and classification entropy represent the 
degree of fuzziness in the data (as explained in Detecting boundaries on fuzzy 
classes). Locations with CI or CE values close to one have membership dispersed 
between classes, while those with lower CI or CE values have more distinct class 
membership. 

After fuzzy classification using the CI or CE method, BoundarySeer produces two 
new map layers, a representation of the newly-created fuzzy class data set and a 
boundary layer illustrating the CI or CE values. 

For polygon and raster data, the boundary layer is the same type as the data. For 
point data, however, the boundary layer is a set of polygons: the Voronoi 
polygons. Voronoi polygons describe proximity relationships. The edges of 
Voronoi polygons are equidistant between neighboring points, they delimit areas 
closer to the enclosed point than any other point in the data set. 

These polygons are colored by the CI or CE value, with darker polygons indicating 
higher CI or CE values, that is, more fuzziness in the data. Darker locations are 
more transitional, less distinct, and therefore more boundary-like than lighter areas 
with lower CI or CE values. 

Next stepNext step: You may wish to repeat the fuzzy classification with different 
parameters (k, epsilon, and phi) to see the effect of these parameters on the 
outcome. 

See also:  See also:  Querying maps, Boundary properties, Exporting boundaries 



 140 

CCHAPTER HAPTER 1010——AANALYZING NALYZING BBOUNDARIESOUNDARIES  

BoundarySeer delineates boundaries using wombling and spatially constrained 
clustering techniques. After boundary detection, you may wish to evaluate whether 
boundary patterns are statistically unusual, i.e. more than would be expected by 
chance.  To do so, you can use Boundary Seer to analyze those boundaries with 
subboundary and overlap analysis.  

This chapter begins with an overview of statistical methods to provide a 
framework for discussing overlap and subboundary statistics.  Then, the two  
methods are described in turn, along with instructions for how to specify analyses 
in BoundarySeer.  Both methods use Monte Carlo randomizations, and the final 
section of this chapter details this powerful technique.   

Components of statistical methods.......................................................142 

OOVERLAP VERLAP AANALYSISNALYSIS  
About overlap statistics .......................................................................143 

Hypotheses............................................................................................... 143 

How many data sets to randomize?............................................................ 143 

Overlap test statistics...........................................................................144 

Calculating overlap statistics...................................................................... 144 

How to conduct an overlap analysis.....................................................145 

Examples of overlap analysis...............................................................146 

Exposure analysis ..................................................................................... 146 

Vegetation boundaries............................................................................... 146 

Overlap results....................................................................................147 

Histograms............................................................................................... 147 

Tables ...................................................................................................... 147 

Interpreting overlap statistics ...............................................................148 

Note ........................................................................................................ 148 

SSUBBOUNDARY UBBOUNDARY AANALYSISNALYSIS  
About subboundary statistics ...............................................................149 
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Subboundary test statistics...................................................................150 
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How to calculate subboundary statistics ...............................................151 

Subboundary results............................................................................152 

Table ........................................................................................................152  

Histograms ...............................................................................................152 

Interpreting subboundary statistics .......................................................153 
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Components of sComponents of statistical methodstatistical methods  

It is not possible to prove something conclusively, instead, we can only disprove 
hypotheses (Popper 1959).  Statistical tests begin with a null hypothesis of no effect 
(no boundary contiguity or no association between boundaries).  Then, the pattern 
of the data is used to evaluate this null hypothesis.   

Essential features of these methods (adapted from Waller and Jacquez 1995): 

• The null spatial modelThe null spatial model describes the spatial distribution of the 
boundaries/boundary elements in the absence of boundary-generating 
processes.    

• The null hypothesisThe null hypothesis is a statement about the boundaries used for testing 
described in terms of the null spatial model.  It describes the pattern of 
data in the absence of strong boundaries (for subboundary analysis) or 
boundary overlap (for overlap analysis).    

• The alternative hypothesisThe alternative hypothesis may be an omnibus alternative to the null 
hypothesis, such as "not the null hypothesis" or a specific prediction about 
patterns in the data.  For example, an alternative hypothesis can define 
what the data would look like when a boundary-generating process is at 
work.  

• The test statisticThe test statistic summarizes an aspect of the data, such as boundary 
branchiness or minimum length between boundaries.  It is used to 
evaluate the null hypothesis.  

• The null distributionThe null distribution of the test statistic can be derived empirically 
through repeated Monte Carlo randomizations of the original data set and 
recalculation of the test statistic.  The randomization procedure is defined 
by the null spatial model.  

Probability values (p-values) for the observed test statistics can be obtained by 
comparing them to their null distributions.  This comparison gives a quantitative 
estimate of how unlikely the observed value is compared to the expected null 
distribution.  If the patterns in the data are different enough from the prediction of 
the null hypothesis, then the null hypothesis can be rejected.  "Enough" is a 
difficult concept, see p values for more explanation.  

See also: See also: Boundary analysis guidelines, Monte Carlo procedures, Types of 
randomization 



 143 

OOVERLAP VERLAP AANALYSISNALYSIS  

About overlap statisticsAbout overlap statistics  

Overlap statistics examine whether boundaries for two or more variables coincide, 
or overlap, to a significant extent. BoundarySeer implements methods developed 
for difference boundaries by Jacquez (1995).  

The exact form of the null hypothesis (HoHo) depends on the null spatial model.  
You choose the null spatial model when you specify the randomization procedure.  
There are two null hypotheses (CSR and SA), and three alternative hypotheses 
(HaHa). 

HypothesesHypotheses  

HHoo--CSRCSR Boundaries are distributed according to complete spatial randomness. 
Boundary overlap will occur randomly.   

HHoo--SASA The values of observations at nearby boundary elements are correlated.  
Boundary overlap may occur on a local scale, but not on a large scale.  
Boundary overlap statistics will be intermediate. 

HHa1a1 The two sets of boundaries coincide.  There is large scale overlap between 
boundaries.   

HHa2a2 Overlap is directional:  one set of boundaries depends on another set of 
boundaries.   

HHa3a3 The boundaries avoid each other, boundaries will overlap less than expected 
by chance. 

How many data sets to randomize?How many data sets to randomize?  

Your alternative hypothesis will determine how you randomize the data set.  If 
you think that one set of boundaries depends on another, randomize the data set of 
the boundary you think may be dependent.  For example, if you are testing the 
hypothesis that the distribution of a plant ecotone is a response to boundaries in 
soil types, randomize the plant boundaries set when you do an overlap analysis. If 
you think that two boundaries are associated with each other, randomize both. 
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Overlap test statisticsOverlap test statistics  

BoundarySeer offers four overlap statistics for crisp boundaries.  While they were 
developed for difference boundaries, overlap statistics can be applied to areal 
boundaries, though overlap between two areal boundaries will be better quantified 
by areal overlap statistics that will come in the next version of BoundarySeer. 

Overlap statistics are based on mean nearest neighbor distances (Jacquez 1995).  
For ease of reference, we will term one set of boundaries boundary G and the other 
Boundary H. 

OOSS the count of the number of Boundary Elements (BEs) that are included in 
both sets of boundaries 

OOGG the mean distance from BEs in G to the nearest BE in H 

OOHH the mean distance from BEs in H to the nearest BE in G 

OOGHGH the mean distance from a BE in either boundary to the nearest BE in the 
other 

Calculating overlap statisticsCalculating overlap statistics  

Following Jacquez (1995), BoundarySeer calculates overlap statistics using the 
following formulae: 
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Where BG is the set of BEs for boundary G, and BH is the set for boundary H.  D 
is a distance matrix of dimension NG by NH, whose elements, dij, are the 
geographic distances between location i in BG and location j in BH. The minimum 
distance from the ith BE in BG to any location in BH is min(d•j ); the equivalent 
minimum distance for elements of BH is min( di• ).  

Next step: Next step: How to conduct an overlap analysis 
See also: See also: Boundary analysis guidelines, Examples of overlap analysis 
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How to conduct an oHow to conduct an overlap analysisverlap analysis  

You may analyze the overlap between two boundaries delineated within 
BoundarySeer, or between data sets imported from other applications. The 
"Overlap Analysis" menu item will not be active until two data sets, or one data 
set and a boundary are in the BoundarySeer project. Jacquez (1995) developed 
overlap statistics for difference boundaries.  While they can be used for areal 
boundaries, overlap between two areal boundaries will be better quantified by areal 
overlap statistics that will come in the next version of BoundarySeer. 

1. Select "Overlap Analysis" from the "Boundary" menu.  Alternatively, 
right click on any boundary in the project window and choose "Overlap 
Analysis" from the pop-up menu. 

2. Overlap Analysis Monte Carlo Settings 
a. Select the names of the two boundaries or data sets from the two pull-

down menus. The one that you enter on the left side of the dialog will 
be considered layer 1 or "G", and the one you enter on the right side 
will be considered layer 2 or "H." 

b. Note that the randomization box is checked by default for both 
boundary data sets. If you do not want to randomize both sets, 
remove the check from one box by clicking on it. See Alternative 
hypotheses in overlap analysis for help with this decision. 

c. Choose the null spatial model by specifying the randomization 
procedure. 

d. If you have chosen to use a data set (rather than a boundary), and if 
this file has more than one variable, you will be asked to choose one 
of the variables from the file. BoundarySeer will use this variable as a 
boundary membership value in the analysis. 

e. Choose the number of randomizations. 

f. Click "OK" 
3. Overlap Analysis Output Settings 

a. Choose a title for the results or accept the default 
b. Choose whether you want to standardize the results.  BoundarySeer 

will use the Z-score method. 
c. Choose whether you want to view the histograms for each overlap 

statistic. 
d. Click "OK." 

Next step:Next step: 
¡ Interpreting overlap statistics 
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Examples of overlap analysisExamples of overlap analysis  

Exposure anaExposure analysislysis  

Jacquez (1995) explored the overlap of respiratory illness and environmental 
ozone in southern Ontario. Exposure to high ozone can cause acute respiratory 
distress leading to pulmonary edema or even emphysema. Jacquez asked whether 
zones of rapid change in environmental ozone induced concomitant zones of rapid 
change in respiratory health. Ozone boundaries appeared to coincide with 
boundaries in hospital respiratory admissions; however, the overlap statistics were 
not significant. Most likely other factors were involved that may have obscured the 
relationship between ozone and respiratory health. 

Vegetation boundariesVegetation boundaries  

Fortin et al. (1996) used boundary overlap to assess the relationships between 
edaphic factors (soil types and moisture) and vegetation boundaries. They found 
that vegetation boundaries based on species stem density and species 
presence/absence overlapped boundaries in edaphic factors, but vegetation 
boundaries based on species diversity and richness did not. This pattern suggests a 
hierarchy of effects, with edaphic factors predicting species presence but not plant 
community structure. 

To determine how much the variable examined influences boundary delineation, 
Fortin (1997) evaluated overlap among vegetation boundaries calculated from 
different data sets. She found that density, percent coverage, and presence/absence 
for trees, shrubs, and trees and shrubs together significantly overlapped. While 
most variables concurred, the tree-only and the shrub-only data did not. Thus, 
overlap analysis can be used to identify variables that covary and those that do not. 
Determining the degree of overlap between boundaries of interest would be useful 
for study design and ground truthing remotely sensed boundaries. 

Hall and Maruca (in preparation) compared two sets of boundaries:  areal 
vegetation boundaries with bird abundance difference boundaries. They found that 
bird abundance boundaries were significantly associated with vegetation 
boundaries, but not vice versa. Upon investigating the composition of the 8 
vegetation clusters, they found that the variable most likely driving the boundaries 
was the density of coniferous trees, a potentially important factor influencing the 
selection of nesting and foraging areas. The authors suggest that this approach may 
aid in the development of monitoring and recovery plans for threatened bird 
species that use mosaic landscapes, such as the four songbird species of 
conservation concern included in this study. 
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Overlap resultsOverlap results  

Overlap statistics measure boundary spatial association. You can evaluate whether 
the association is statistically unusual through comparison with Monte Carlo 
randomizations of the boundary locations. Overlap results consist of histograms 
for each statistic and a summary table. 

HistogramsHistograms  

Boundary overlap analysis creates a set of histograms and a table of boundary 
overlap statistics. You can choose not to view the histograms when you perform 
the analysis (clear the "show histograms after overlap" box). If you accept the 
default output, you will see a histogram for OG, OH, OGH and OS. The 
histograms show the values for these statistics from Monte Carlo randomizations 
of the boundaries. The observed overlap values are shown as a red bar on the 
histogram. Viewing the histograms allows you to visually assess how unusual the 
observed values are compared to the randomizations. 

TableTable  

The table displays the observed value for each of the four statistics, the Z-score for 
the observed value, the mean and standard deviation of the distribution and the 
upper and lower p-values. Below the statistics is a list of the values in each of the 
randomizations.   

If you chose to standardize the output, BoundarySeer will display the Z-score for 
each statistic in each randomization.  The Z-score standardizes by dividing by the 
standard deviation.  For those statistics that have no variance, the standard 
deviation is zero and the Z-score cannot be calculated.  In this instance, 
BoundarySeer will display "DIV/0" in the table and the histogram of that statistic 
will not be produced.  
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Interpreting overlap statisticsInterpreting overlap statistics  

There are two alternative hypotheses in overlap statistics, either boundary 
association or boundary avoidance.  For two sets of boundaries, G and H, 
boundaries that overlap would have high values of OS and low values of OG, OH, 
and OGH.  Low values of OS and high values of OG, OH, and OGH indicate 
boundary avoidance.  

The table below provides a quick reference: 

StatisticStatistic MeaningMeaning OverlOverlapap  

((HHa1a1&&HHa2a2)) 

AvoidanceAvoidance  

((HHa3a3)) 

OOSS the number of Boundary Elements (BEs) in both 
sets of boundaries 

high low 

OOGG directional overlap, association with G to H low high 

OOHH directional overlap, association with H to G low high 

OOGHGH simultaneous overlap, association between the 
boundaries 

low high 

 

You can use Monte Carlo randomization to determine whether the observed value 
of a test statistic is either significantly high or significantly low.  BoundarySeer will 
present the p-values for the upper and lower tails of the Monte Carlo distribution.  
Use the table above to determine which tail to evaluate for which alternative 
hypothesis.  To evaluate whether a test statistic is unusually low, examine the 
lower tail p-value (from the lower end of the distribution).  To evaluate whether a 
test statistic is unusually high, examine the upper tail p-value (from the upper end 
of the distribution).  (See also: Calculating Monte Carlo p-values) 

Simulation studies (Jacquez 1995) demonstrated that the significance of OS is 
related to the presence of large-scale boundaries (boundaries whose lengths are on 
the same scale as sampling), even when H is dependent on G. OG is significant 
when boundaries for G are nearer to boundaries for H than expected, and a similar 
interpretation follows for OH. OGH measures the simultaneous fit between the 
two boundary sets.  

NoteNote  

BE CAREFUL interpreting OS, because there are many situations where the 
spatial support for the two boundaries preclude any direct overlap. If this happens, 
OS will always be zero, and it should not be included in the analysis. 
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About subboundary statisticsAbout subboundary statistics  

Subboundary statistics evaluate subboundary contiguity for difference boundaries.  
The fundamental question is whether the connections between boundary elements 
are statistically unusual, or whether their strength could be explained by chance.   
The statistics themselves are drawn from planar graph theory, where each 
subboundary is a graph, boundary element (BE) locations are nodes, and the 
subboundary connections are links. 

This method analyzes subboundaries to determine whether they possess significant 
characteristics, such as length, branchiness, and diameter.  Whether the statistics 
are unusual is evaluated with Monte Carlo procedures. 

The exact form of the null hypothesis (Ho) depends on the null spatial model.  
You choose the null spatial model when you specify the randomization procedure.  
There are two null hypotheses (CSR and SA), and two alternative hypotheses 
(Ha).   

HypothesesHypotheses  

HHoo--CSRCSR Boundaries occur by chance; the values of observations at nearby candidate 
boundary elements are distributed according to complete spatial 
randomness. Boundaries are not particularly contiguous, with intermediate 
values of the test statistics. 

HHoo--SASA Boundaries occur because of spatial autocorrelation; the values of 
observations at nearby boundary elements are correlated.  Thus, 
subboundary connections are short, with intermediate values of the test 
statistics. 

HHa1a1 Large-scale boundaries exist, the values of the test statistics will show high 
boundary contiguity. 

HHa2a2 Boundaries are fragmented, the values of the test statistics will show lower 
contiguity than expected by chance. 
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Subboundary test statisticsSubboundary test statistics  

Subboundary statistics evaluate the contiguity of difference boundaries. A 
subboundary is a set of connected Boundary Elements (BEs). 

NNSS number of subboundaries found 

NN11 number of singleton BEs 

LLmaxmax maximum subboundary length (number of linked BEs) 

LLmeanmean mean subboundary length  

DDmaxmax maximum subboundary diameter  

DDmeanmean mean subboundary diameter  

D/LD/L mean diameter-to-length ratio (indicates branchiness) 

  
Subboundary diameterSubboundary diameter is the shortest path length between each pair of BEs in a 
subboundary.   
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How to calculate subboundary statisticsHow to calculate subboundary statistics  

To calculate subboundary statistics, you must first have generated crisp difference 
boundaries. Once you have the correct type of boundary, follow these steps to 
analyze your subboundary segments and singletons. 

1. From the "Boundary" menu, choose "Subboundary Analysis." 

2. Choose the number of Monte Carlo randomizations.  

3. Choose your null spatial model by specifying which randomization type.   
4. Choose a name for your output, and decide if you would like to see the 

results in standardized form. The default is to standardize the data. 
Standardized data will be presented as a Z-score, which is calculated as (V 
- mean of V)/s, where "s" is the standard deviation and "V" is the value of 
the variable. Standardization facilitates the comparison of different 
boundary data sets. 

5. Decide whether you wish to view histograms for each subboundary 
statistic. The default is yes. Clear the check box if you would not like to 
see the distribution of the randomized data for each of the subboundary 
statistics. 

6. Click "OK". BoundarySeer will generate a table with each of the 
subboundary statistics as columns, and rows that show the observed and 
standardized observed values, means, standard deviations, and upper and 
lower p-values. BoundarySeer also presents a histogram of the 
randomized distribution of each statistic, along with a red line that 
represents the observed value. 

See also: See also: Subboundary results, Interpreting subboundary statistics. 
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Subboundary resultsSubboundary results  

Subboundary statistics measure boundary contiguity. You can evaluate whether 
the subboundary is statistically unusual through comparison with Monte Carlo 
randomizations of the boundary. Subboundary output consists of histograms for 
each subboundary statistic and a summary table. 

TableTable  

The table displays the observed value for each of the seven statistics, the 
standardized value, if you chose to standardize the output, and the mean and 
standard deviation of the distribution.  Following all this is and the upper and 
lower p-values.  See Interpreting subboundary statistics for more details.  Below 
the statistics is a list of the values in each of the randomizations.   

HistogramsHistograms  

Subboundary analysis creates a set of histograms and a table of subboundary 
statistics. You can choose not to view the histograms when you perform the 
analysis (clear the "show histograms after analysis" box). If you accept the default 
output, you will see a histogram for Ns, N1, Lmean, Lmax, Dmean, and Dmax. 
The histograms show the values for these statistics from Monte Carlo 
randomizations of the boundaries. The observed values are shown as a red bar on 
the histogram. Viewing the histograms allows you to visually assess how unusual 
the observed values are compared to the randomizations.  
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Interpreting subboundary statisticsInterpreting subboundary statistics  

There are two alternative hypotheses in subboundary statistics, either large-scale 
boundaries or boundary fragmentation.  A subboundary is a set of connected 
Boundary Elements (BEs).  The set of subboundaries found for a data set or data 
sets make up the boundary.   

Under a boundary-generating process, we would expect a contiguous boundary 
with few subboundaries (NsNs), few singletons (N1N1), high subboundary length (LL, 
both mean and max), high subboundary diameter (DD, both mean and max), and 
low subboundary branchiness (diameter to length ratio, D/LD/L).   

Under boundary fragmentation, we would expect lots of singleton subboundaries 
(high NsNs and N1N1), low subboundary length, low diameter, and high branchiness.  

The following table summarizes the predictions of each alternative hypothesis. 

StatisticStatistic MeaningMeaning Boundaries Boundaries 

((HHa1a1)) 

Fragmentation Fragmentation 

((HHa2a2)) 

NNSS number of subboundaries  low high 

NN11 number of singleton Boundary 
Elements 

low high 

LLmaxmax maximum subboundary length 
(number of linked BEs) 

high low 

LLmeanmean mean subboundary length  high low 

DDmaxmax maximum subboundary diameter high low 

DDmeanmean mean subboundary diameter high low 

D/LD/L mean diameter-to-length ratio 
(indicates branchiness) 

low high 

 
You can use Monte Carlo randomization to determine whether the observed value 
of a test statistic is either significantly high or significantly low.  BoundarySeer will 
present the p-values for the upper and lower tails of the Monte Carlo distribution.  
Use the table above to determine which tail to evaluate for which alternative 
hypothesis.  To evaluate whether a test statistic is unusually low, examine the 
lower tail p-value (from the lower end of the distribution).  To evaluate whether a 
test statistic is unusually high, examine the upper tail p-value (from the upper end 
of the distribution).   

See also: See also: p-values, Calculating Monte Carlo p-values. 
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Monte Carlo proceduresMonte Carlo procedures  

Statistical significance of the subboundary and overlap statistics is evaluated using 
Monte Carlo procedures, which involve repeatedly recalculating the statistics from 
randomized data sets. Different randomization methods can be applied, each 
corresponding to a distinct spatial null model (see Types of randomization). 

In general, Monte Carlo Randomization (MCR) procedures follow this sequence: 

1. Following the calculation of statistics from the original data set, 
observations are randomized according to the chosen null hypothesis. 

2. Boundaries are reestablished for the randomized data, and, if desired, 
subboundaries are constructed. 

3. Statistics (subboundary or overlap) are recalculated for the new 
randomized boundaries. 

4. Steps 1-3 are repeated a given number of times, amassing distributions 
that will be used to calculate p-values for the observed statistics. 

5. The statistics (observed and randomized) are standardized by converting 
them to Z-scores. 

6. P-values are calculated by comparing the observed statistic to the 
reference distribution. 
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Dmean 

 

Figure 10.1.  A histogram of Dmean (gray bars) from randomizations of the data set 
for comparison with the observed value (the thick black line).  The black line on the 
graph shows the observed value for Dmean, and the gray bars show the reference 
distribution created from 200 randomizations. In this case, the observed value is not 
statistically unusual, being neither remarkably large nor remarkably small. 
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Types of randomizationTypes of randomization  

BoundarySeer includes two methods for randomizing spatial data during Monte 
Carlo procedures: full randomization (also known as complete spatial randomness 
or CSR), and restricted permutations based on spatial proximity or similarity. 
These methods are for randomizing the observations among the data's original 
spatial locations. See Location models for a discussion of randomizing the spatial 
coordinates of the data set (used for data with location uncertainty). 

Method 1: Complete spatial randomness (CSR)Method 1: Complete spatial randomness (CSR)  

Reference distributions are obtained by repeatedly and randomly reallocating the 
observations over the sampling locations, redefining boundaries, and then 
recalculating the statistics. This method corresponds to a null hypothesis of no 
spatial structure. Although commonly used, CSR is increasingly recognized as an 
untenable null hypothesis, because the complete absence of spatial structure is not 
a reasonable scenario for boundary-less surfaces. In essence, this method assumes 
spatial independence between samples, which is violated in data sets with spatial 
autocorrelation (Fortin and Jacquez 2000). 

Method 2: Restricted permutations based on spatial proximity or similaritMethod 2: Restricted permutations based on spatial proximity or similarityy  

Restricted randomization procedures can provide more realistic randomizations 
and more realistic null hypotheses. We can account for more complex structure 
(spatial and otherwise) by restricting permutations based on distance (or similarity) 
relationships among observations. In practice, this method works like CSR, except 
that the observations are reallocated according to a probability matrix that is either 
defined by the user or calculated by BoundarySeer. This matrix, called a generator 
matrix, gives BoundarySeer instructions for how to randomize the data. 

Spatial autocorrelation can be accounted for when constructing reference 
distributions of boundary statistics, by using measures of spatial autocorrelation to 
construct the generator matrix. This approach also allows attributes other than 
spatial relationships to restrict permutations. 

 



 157 

pp--valuesvalues  

The interpretation of the likelihood of a test statistic must balance the likelihood of 
an error of type 1, rejecting the null hypothesis when it is true, and the likelihood 
of a type 2 error, accepting the null hypothesis when it is false.  The likelihood of a 
type 1 error is the alpha (αα) level.  Comparing the test statistic to the expected 
distribution provides a p-value for the observed value, short for probability value.  
If the p value for the observed value falls below alpha, then the observation is 
termed significant.    

P = 0.05 is the traditional alpha level, which can be interpreted to mean that results 
that or more extreme would occur by chance less than 5% of the time, if the null 
hypothesis were true. When probability of the null hypothesis generating the 
pattern is less than the alpha level, it is customary to reject the null hypothesis and 
accept an alternative hypothesis. 

Figure 10.1 shows a reference distribution created for the mean subboundary 
diameter (Dmean) in a subboundary analysis.  

The probability of a type two error is beta ββ , and the power of a statistical test to 
reject a null hypothesis is 1 -  ββ  
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Calculating Monte Carlo pCalculating Monte Carlo p--valuesvalues  

The upper and lower p-values provide a sense of how extreme the value is 
compared to the distribution.   The histogram in Figure 10.2 below shows a 
distribution of 1000  randomly generated numbers.  The black lines illustrate the 
top and bottom 5% of the distribution.  Thus, they delineate the cutoff values for 
alpha = 0.05.   

BoundarySeer calculates the upper and lower p-values for the observed values of 
the test statistics using the following formulae: 
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where Nruns is the total number of Monte Carlo simulations, NGE is the number of 
simulations for which the statistic was greater than or equal to the observed 
statistic, and NLE is the number of simulations for which the statistic was less than 
or equal to the observed value. One (1) is added to the numerator and denominator 
of each because the observed statistic is included in the reference distribution. 
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Figure 10.2.  A distribution of 1000 random numbers.  The black lines 
delineate the top and bottom 5%.  



 159 

Using a generator matrix for randomizationUsing a generator matrix for randomization  

Within BoundarySeer, statistics can be evaluated under a null hypothesis that 
includes some spatial pattern, such as spatial autocorrelation. Many spatial 
statisticians consider such a null hypothesis to be more tenable than complete 
spatial randomness (Fortin and Jacquez 2000). BoundarySeer accounts for spatial 
autocorrelation (or other spatial or nonspatial patterns) by restricting the 
randomizations during the Monte Carlo process, so that each observation is more 
likely to be 'sampled' at some locations and less likely at others. 

How BoundarySeer Restricts RandomizatHow BoundarySeer Restricts Randomizations: the Generator Matrixions: the Generator Matrix  

To restrict randomizations, BoundarySeer uses a matrix of probabilities called a 
generator matrix. For a data set with N sample locations (and therefore N sets of 
observations), the generator matrix G is an N X N matrix.  The matrix elements, 
gij, give the relative probability of assigning observation vector i to location j, given 
that all locations are available for assignment. The observation vectorobservation vector is the list of 
the values of each variable at a particular location.  During the process of 
randomization, observations are chosen at random and assigned to locations, and 
as these locations then become unavailable, the relative probabilities are 
transformed into actual probabilities that allow further assignments to be made. 

Here is a summary of the process of how BoundarySeer uses a generator matrix to 
randomize data (assuming the matrix has already been calculated): 

1. Select an observation vector at random from those available. 
2. Calculate the actual assignment probabilities from elements of the 

generator matrix. 
3. Select a location at random, according to probabilities calculated in step 3. 
4. Make the assignment and adjust the generator matrix accordingly by 

removing the row and column corresponding the observation vector and 
location (respectively) that have just been assigned. 

5. Repeat steps 1-4 until all observation vectors have been assigned. 
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Calculating the generator matrixCalculating the generator matrix  

You can use two types of generator matrices for randomization, a distance decay 
matrix which BoundarySeer can calculate, or you may define your own generator 
matrix.   

1. Distance DecayDistance Decay. 
a. To account for spatial autocorrelation, observation vectors are likely 

to be assigned to nearby locations. Using this model, the generator 
matrix can be calculated as a function of the proximity matrix, whose 
elements pij are the geographic distances between locations i and j. 

b. BoundarySeer can calculate the proximity matrix and then use a 
distance decay function to calculate a generator matrix according to 
your specifications. To do this, select the 'Restricted: Distance decay' 
option as the randomization type and then enter the distance decay 
constant. BoundarySeer uses the distance decay constant to calculate 
probabilities according to the equation 

ij
ij bp1

1
g

+
=  

2. User DefinedUser Defined. You may also define your own generator matrix for 
BoundarySeer to use during randomization. The matrix must be stored in 
a space- or tab-delimited text file, where each row of the file contains the 
elements for each corresponding row of the matrix. Any user-defined 
matrix is subject to these constraints: 
a. The matrix must be N X N, where N is the number of locations in the 

data set to be randomized. 
b. The order of locations in the matrix should correspond to the order of 

locations in your original input file. If you are unsure of the ordering, 
check your original file, or view a table of the data in BoundarySeer. 

c. The generator matrix file contains only the elements of the matrix and 
appropriate delimiters (space or tab); no header information is 
permitted. 

d. We recommend writing a matrix that contains nonzero elements 
only. However, if there are zeroes, they must be arranged in the 
matrix so that, during the Monte Carlo process, BoundarySeer is 
never asked to assign observation vector Zi to location j if gij = 0. To 
ensure that your matrix fits this description, do the following. 
i. First, make sure the diagonal elements are non-zero. 
ii. Next, count the number of non-zero elements in each row. 
iii. Put these counts into a list. Eliminate any counts of zero 
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(corresponding to rows with only zero elements). Sort the 
remainder of the list. 

iv. Each value must occur in the list the number of times equal to its 
value. For example, a count of '3' (a row with 3 non-zero 
elements) must occur exactly 3 times in the list. A count of '2' 
must occur exactly twice. If there is any deviation from this rule, 
then the matrix is NOT a valid generator matrix. 

v. Repeat steps ii-iv, counting the number of non-zero elements in 
each column. 

To use your own generator matrix during randomization, select the 'Restricted: 
Generator matrix from file' option as the randomization type, and then enter the 
file name that contains the matrix. BoundarySeer will check the matrix and alert 
you if there are violations of any of the above rules. 
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How the Generator Matrix Works: An ExampleHow the Generator Matrix Works: An Example  

Suppose we have a very simple data set consisting of 5 point locations, and 3 
variables. The  vector of observations (the list of the values of each variable) for 
location i is Zi = (zi1, zi2, zi3). We have detected boundaries for this data set, and 
we are in the process of evaluating overlap statistics for these boundaries and a set 
of boundaries from a different data set. 

Assume that the generator matrix has been calculated for this data set from a 
distance decay function, and looks like 























=

5.03.03.01.01.0

3.04.03.03.01.0

2.02.03.02.02.0

1.03.03.04.03.0

1.02.03.03.04.0

G  

 
During a single Monte Carlo randomization, for observation vector Z2, we will 
focus on row 2 of the generator matrix, which gives the relative probabilities for 
assigning Z2 to the 5 locations. We calculate the actual assignment probabilities by 
dividing each element in row 2 by the row sum. These probabilities are: 

[ ]072.0214.0214.0286.0214.0G2 =  

We then select a location at random according to these probabilities. Suppose 
location 3 is chosen. We then assign Z2 to location 3. 

Before proceeding, let's adjust the generator matrix to account for the fact that Z2 
and location 3 are no longer available for assignment. We do this by removing row 
2 and column 3. The adjusted generator matrix is: 























=

5.03.0/1.01.0

3.04.0/3.01.0

1.03.0/4.03.0

/////

1.02.0/3.04.0

'G  

We then proceed as before until all observations are assigned to locations. 
BoundarySeer then detects boundaries for the resulting randomized data set and 
recalculates the test statistic. 
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GlossaryGlossary  

AA  

areal boundaryareal boundary  The edge of an homogenous area, usually a closed boundary 
(compare with difference boundary).  

BB  

BEBE  Short for boundary element, locations with boundary likelihood values above 
the boundary delineation criteria (e.g., top 10%)  

BLVBLV  Short for boundary likelihood value; the amount of change observed in a 
variable or variable set across space.  

BMVBMV  Short for boundary membership value; it indicates whether the location is 
part of a boundary, with 1 = yes, 0 = no, and intermediate values indicating the 
degree of membership for fuzzy boundaries.  

boundaryboundary  Either an edge of an homogeneous area (areal boundary) or a zone of 
rapid change in a spatial variable (difference boundary).  

boundary element (BE)boundary element (BE)  Locations with boundary likelihood values above the 
boundary delineation criteria (e.g., top 10%).  

boundary likelihood value (BLV)boundary likelihood value (BLV)  A metric that describes the amount of change 
observed in a variable or set of variables across space.  

boundary membership value (BMV)boundary membership value (BMV)  This value indicates whether the location is 
part of a boundary, with 1 = yes, 0 = no, and intermediate values indicating the 
degree of membership for fuzzy boundaries.  

boundary overlapboundary overlap  The extent to which two sets of boundaries coincide.  

CC  

candidate Boundary Element (cBE) candidate Boundary Element (cBE)  A potential part of a difference boundary, 
promotion to an actual boundary element depends on the boundary likelihood 
value.  

categorical data categorical data  Also called nominal data, categorical data can be represented by 
integers or other category labels. In BoundarySeer, categories must be expressed as 
integers; however, the mathematical difference between two integers is not 
meaningful. That is, the difference between 4 and 1 is the same as the difference 
between 2 and 1: both pairs are mismatched.  
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categorical womblingcategorical wombling  A method for delineating difference boundaries that 
operates on categorical data.  

cBEcBE  A candidate boundary element, a potential part of a difference boundary, 
promotion to an actual boundary element depends on the boundary likelihood 
value.  

centroid centroid  The geographic center of a polygon.  

centroid clusteringcentroid clustering  A method of spatially constrained clustering that agglomerates 
clusters by comparing their average values; compare to linkage clustering 

click queryclick query  A map query accomplished by clicking on the map using the query 
tool. It brings up information about the location from the active data layer.  

closed boundaryclosed boundary  A boundary that completely encloses an area (compare with 
open boundaries).  

clusteringclustering  A multivariate procedure that partitions a collection of objects into 
mutually exclusive sub-collections. See also spatially constrained clustering.  

complete linkagecomplete linkage  A method in linkage clustering where clusters are agglomerated 
based on their maximum distance (dissimilarity) set using the connectedness 
coefficient; compare to flexible linkage and single linkage 

complete spatial randomnesscomplete spatial randomness  The absence of spatial structure in a variable across 
a spatial field.  

connectednessconnectedness  A parameter used in linkage clustering. Sets the comparison 
method: from single linkage (near zero) to complete linkage (near 1) and values in 
between (flexible linkage).  

contiguitycontiguity  Continuity, or the state of being so near as to be touching. Measures of 
boundary contiguity include branchiness, number of boundary singletons, and 
subboundary length.  

crisp boundarycrisp boundary  A well-defined or 'narrow' boundary (compare with fuzzy 
boundary).  

DD  

data formatdata format  The way in which the spatial information is represented in a data set 
(e.g., raster, points, polygons) and the number of spatial dimensions (e.g., one for 
transect data).  

data typedata type  The format of an observation/variable; within BoundarySeer, data can 
be either numerical or categorical (binary data are considered categorical).  

Delaunay linkDelaunay link  One of the point-to-point connections that comprise a Delaunay 
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network.  

Delaunay networkDelaunay network  Also called a Delaunay triangulationDelaunay triangulation, a nearest-neighbor 
spatial network consisting of interconnected links among sample locations such 
that the plane (spatial field) is divided into triangles.  

difference boundarydifference boundary  Zones of rapid change in the spatial field associated with one 
or more variables; may be open or closed (compare with areal boundaries).  

dissimilarity metricdissimilarity metric  Dissimilarity metrics are measures used to address how close 
two sets of observations are in variable space. In BoundarySeer, they are used to 
provide a means of quantifying the differences in a set of variables measured at 
each of a group of spatial locations.  

EE  

Euclidean distanceEuclidean distance  A dissimilarity metric that represents the straight-line distance 
between observations in variable space.  

FF  

flexible linkageflexible linkage  A method in linkage clustering where clusters are agglomerated 
based on a distance in between the minimum and maximum distances, set using 
the connectedness coefficient; compare to single linkage and complete linkage 

fuzzy boundaryfuzzy boundary  A boundary that occurs when the zone of change in a spatial field 
is relatively wide (compare with crisp boundaries).  

GG  

geographic information systemgeographic information system  A combination of spatial data and software for 
managing, analyzing, and visualizing spatial data.  

GISGIS  see geographic information system 

gradientgradient  Given a surface f (x,y) that is differentiable at point p, then the gradient at 
p is a vector in the direction of the maximum amount of change of f, with 
magnitude equal to the maximum amount of change of f. The gradient is used 
with the raster and irregular wombling to estimate boundary likelihood values and 
gradient angles.  

gradient anglegradient angle  The direction of the maximum amount of change of a gradient, 
measured as an angle from the X axis.  

gradient angle thresholdgradient angle threshold  A cutoff value used in subboundary construction for 
raster and point data. The threshold limits the difference in angle between two 
gradient vectors or between the gradient vector and the connection itself.  
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gradient vectorgradient vector  see gradient  

II  

irregular datairregular data  A data set for which the observations are made at irregular intervals 
(compare to raster data). Point data are considered irregular.  

LL  

levellevel  In spatially constrained clustering, the distance of fusion associated with a 
particular partition.  

linklink  see Delaunay link.  

linkage clusteringlinkage clustering  A method of spatially constrained clustering that agglomerates 
clusters based on values for individual locations within the cluster; compare to 
centroid clustering.  

MM  

Manhattan distanceManhattan distance  A dissimilarity metric that represents a "stair stepping" way to 
measure distance. It can be calculated by taking the sum of the absolute value of 
the differences between values of specified variables.  

MCRMCR  see Monte Carlo randomization.  

mismatch coefficientmismatch coefficient or mismatch valuemismatch value  A dissimilarity metric used to estimate 
amounts of difference between categorical variables measured at different spatial 
locations. When comparing two sample locations, the mismatch value is equal to 
the proportion of variables that are mismatched.  

Monte Carlo randomization (MCR)Monte Carlo randomization (MCR)  A computationally-intense method that 
estimates probability values through resampling the data set. MCR involves 
repeatedly reassigning observations to sample locations in a random way, 
according to a particular null hypothesis, and recalculating the statistic for the sets 
of randomized data.  

NN  

networknetwork  See spatial network or Delaunay network.  

numeric (data type)numeric (data type)  Data that can be expressed as real numbers where the 
magnitude of differences between two numbers is meaningful. Compare with 
categorical.  
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OO  

observation vectorobservation vector  The list of the values of each variable at a particular location.  

open boundaryopen boundary  A boundary that does not fully enclose an area (compare with 
closed boundaries).  

overlapoverlap  See boundary overlap.  

PP  

partitionpartition  In spatially constrained clustering, a particular division of a collection of 
objects.  

point (data format) point (data format)  Data from individual spatial locations (points) that were not 
necessarily sampled at regular intervals across a spatial field. Point data are a type 
of vector data.  

polygon (data format)polygon (data format)  Data from areas rather than points. Polygon data sets are 
often created from GIS representations of political boundaries such as counties. 
Polygon data are a type of vector data.  

pp--valuevalue  The probability that a calculated value of a statistic was drawn from the 
null distribution, or the probability that the null hypothesis is true.  

QQ  

queryquery  A way to get information from maps and tables. You can query maps by 
clicking on them with the query tool. You can query tables using "query" from 
the "Table" menu.  

RR  

raster (data format)raster (data format)  Data corresponding to a regularly sampled spatial field in two 
dimensions, thereby forming a grid. This is the typical format for satellite images 
and many other remotely-sensed data sets.  

SS  

single linkagesingle linkage  A method in linkage clustering where clusters are agglomerated 
based on their minimum distance (dissimilarity) set using the connectedness 
coefficient; compare to flexible linkage and complete linkage 

singletonsingleton  A group, such as a subboundary or a cluster, possessing only one 
member.  

spatial autocorrelationspatial autocorrelation  A spatial pattern that arises when the value of a variable at 
one location is related to its value at nearby locations.  
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spatial networkspatial network  A system of links among sample locations, such as a nearest 
neighbor network. See also Delaunay network.  

spatially constrained clusteringspatially constrained clustering  A method used in the delineation of areal 
boundaries. During the clustering process, smaller clusters are merged to form 
larger clusters based on geographic contiguity and similarity of observations.  

squared Euclidean distancesquared Euclidean distance  A dissimilarity metric used in spatially constrained 
clustering; the absolute distance in variable space between two data units.  

Steinhaus coefficient of similaritySteinhaus coefficient of similarity  A dissimilarity metric that is specifically 
designed for use with count data - it is closely related to the Bray and Curtis 
measure of similarity. This measure is self-normalizing, so data should not be 
standardized prior to its use.  

subboundarysubboundary  With difference boundary delineation, a group of connected 
boundary elements.  

surface gradientsurface gradient  see gradient 

TT  

thresholdthreshold  For difference boundary delineation, a boundary likelihood value 'limit' 
that determines which locations will be designated as boundary elements.  
See also: gradient angle threshold 

transect (data format)transect (data format)  Data associated with a one-dimensional spatial field (i.e., 
data collected along a line).  An example might be data collected along a stream 
where the only spatial information was distance downstream from a starting point)  

VV  

variable typevariable type  The form or type of observations. Within BoundarySeer, variables 
are either numeric or categorical (binary data are considered categorical).  

vector (data format)vector (data format)  Data that were not necessarily sampled at regular intervals 
across a spatial field. Vector data typically consist of points, lines, and polygons. In 
BoundarySeer, a particular vector data file can only contain points or polygons, 
not both together.  

vector (gradient)vector (gradient)  see gradient 

vector of observationsvector of observations  The list of the values of each variable at a particular 
location.  

Voronoi diagramVoronoi diagram  A diagram of proximity relationships. The outlines of Voronoi 
polygons represent lines equidistant from a set of objects or points. Locations 
within the Voronoi polygons are closest to the object within the lines.  
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WW  

womblingwombling  Methods for delineating difference boundaries, after Womble (1951). 
Also called rate of change techniques.  

ZZ  

zz--scorescore  A method of standardization that involves subtracting the expected value 
(i.e., mean) and dividing by the standard deviation. Z-scores can be interpreted as 
the number of standard deviation units from the expected value.  
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TroubleshootingTroubleshooting  

Here are a list of pitfalls you may encounter, and ways to circumvent them. For 
updated troubleshooting information and BoundarySeer FAQs, please visit 
BoundarySeer online: www.biomedware.com/files/documentation/boundaryseer/default.htm. 

ImportingImporting  

BoundarySeer crashes when I trBoundarySeer crashes when I try to analyze my raster file.y to analyze my raster file.  

For import problems, check that the headings and the file type are appropriate (see 
Import formats for raster data).  

If it crashes during analysis, it is possible that if you have a raster too large for 
BoundarySeer to process. This is a problem we are working on. 

I imported one file, but I see two.I imported one file, but I see two.  

BoundarySeer is not yet able to work with variables of different types in the same 
data set. If you import some variables of each type, BoundarySeer will create two 
different data sets, one for the categorical data and one for the numeric data. 
Labels will be included in each file. 

I imported a file, but the detect boundary menu options are not available.I imported a file, but the detect boundary menu options are not available.  

You may have imported an inappropriate file type or chosen not to import 
variables during import. BoundarySeer cannot use lines for boundary detection. 
Nor can it use any files of spatial information without associated variables (such as 
DRG and DEM files) for boundary detection. It imports these files as spatial 
features for help with data visualization only. 

MapsMaps  

I don't recognize the spatial coordinates of my data when I query the map.I don't recognize the spatial coordinates of my data when I query the map.  

BoundarySeer converts geographic (latitude-longitude) data to UTM for 
calculation purposes. If you imported a geographic file, map queries will display 
UTM coordinates. 

The map is outdated.The map is outdated.  

When you standardize your data and save the standardization over the original 
data set, BoundarySeer will not update the maps referencing that data set. Thus, if 
you query a map, it will show the pre-standardized information, which may be 
misleading. To view an updated map delete the old one or the relevant map layer 
and create a new one using the standardized data set. 
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Map layers from different data sets don't register properly.Map layers from different data sets don't register properly.  

Did you import your data in the same projection? BoundarySeer reprojects 
geographic coordinates to UTM, otherwise it treats all other planar projections 
equivalently. Go to the source application and make sure your data sets are in the 
same projection before importing them into BoundarySeer. 

Can't see important layers on the map?Can't see important layers on the map?  

The map layers are drawn sequentially, with layers higher on the list in the layers 
pane obscuring lower layers. Reorder the map layers in the map layers pane by 
dragging layers you wish to view on top. 

Alternatively, you might want to make some layers (like polygon layers) 
transparent (see Formatting maps). 

Can't query a spatial feature after reopening a BoundarySeer project?Can't query a spatial feature after reopening a BoundarySeer project?  

Check that the spatial feature is the active map layer (highlighted). If the query still 
doesn't work, check whether you moved the *.bsr file without the *.pip file or 
deleted the *.pip file. 

BoundarySeer saves all project information except spatial feature files into the 
*.bsr file. It saves spatial feature information into a *.pip file, named for the 
original import file (e.g. "spatialfeature.file.pip"). When you reopen the *.bsr 
file, BoundarySeer requires the *.pip file for querying the spatial feature. 

TablesTables  

Can't view a table?Can't view a table?  

If it is a raster data set or boundary, BoundarySeer does not display tables. You 
can view the data for particular locations through querying the map. 
For vector data, go to "View Table" in the "Project" menu or right click on an 
icon in the project window and choose "view table". 

The table is outdated.The table is outdated.  

When you standardize your data and save the standardization over the original 
data set, BoundarySeer will not update any tables referencing that data set. Thus, if 
you view or query an existing table, it will show the pre-standardized information, 
which may be misleading. To view an updated table close the old one and create a 
new one using the standardized data set. 
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ChartsCharts  

The chart is outdated.The chart is outdated.  

When you standardize your data and save the standardization over the original 
data set, BoundarySeer will not update any charts referencing that data set. Thus, 
existing charts will display the pre-standardized information, which may be 
misleading. To view an updated chart close the old one and create a new one using 
the standardized data set. (See creating a histogram or creating a scatterplot). 

Spatial featuresSpatial features  

Can't query a spatial feature after reopening a BoundarySeer project?Can't query a spatial feature after reopening a BoundarySeer project?  

Check that the spatial feature is the active map layer (highlighted). If the query still 
doesn't work, check whether you moved the *.bsr file without the *.pip file or 
deleted the *.pip file. 

BoundarySeer saves all project information except spatial feature files into the 
*.bsr file. It saves spatial feature information into a similarly named *.pip file. 
When you reopen the *.bsr file, BoundarySeer requires the *.pip file for querying 
the spatial feature. 

I imported a file, but the detect boundary menu options are not available.I imported a file, but the detect boundary menu options are not available.  

You may have imported an inappropriate file type or chosen not to import 
variables during import. BoundarySeer cannot use lines for boundary detection. 
Nor can it use any files of spatial information without associated variables (such as 
DRG and DEM files) for boundary detection. It imports these files as spatial 
features for help with data visualization only. 

Boundary detectionBoundary detection  

I iI imported a file, but the detect boundary menu options are not available.mported a file, but the detect boundary menu options are not available.  

You may have imported an inappropriate file type or chosen not to import 
variables during import.   
Point or polygon files without associated data and line files cannot be used for 
boundary detection. BoundarySeer imports these files as spatial features for help 
with data visualization only.  
You may import spatial information from appropriate file types without importing 
any associated data, but choosing not to import variables when you select the 
variables.  If you selected that option in error, reimport the data set. 
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